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C H A P T E R  1  

Introduction 

This user’s guide describes MVRsimulation’s Scenario Editor version 2.3.  

This VRSG® application extends the drag-and-drop capabilities of adding static culture and 
moving models directly to your 3D terrain. Scenario Editor provides a graphical interface 
with tools and content libraries with which you can build dense 3D scenes with realistic 
visual characteristics. 

Experienced VRSG users and novices alike can work in a flexible manner to increase the 
realism of terrain easily with rich cultural content and optional scripted movements of 
vehicles and characters.  

The 3D terrain that you work with in Scenario Editor is the same 3D terrain you visualize in 
VRSG, and the scenarios you create can be run in both Scenario Editor and VRSG. The tool 
supports terrain in MVRsimulation’s VRSG round-earth (MDS) format. 

This user’s guide assumes you are familiar with using MVRsimulation VRSG.  

The examples shown in this guide are taken from sample scenarios that are delivered with 
VRSG version 7.  

Overview 
Many aspects of Scenario Editor are familiar from VRSG, such as adding static cultural and 
dynamic models, effects, appearances, cultural feature files, manipulating characters with 
weapons and animations, creating and using viewpoints, and content search paths. 

Because Scenario Editor contains a 3D terrain workspace, you see the same terrain and 
cultural features you would see in VRSG. This means you can work with accuracy and 
precision in placing and refining your static culture and in scripting the movements of 
vehicles and characters, all in virtual environments such as dense urban scenes, airfields, and 
forward operating bases. 

Changes you make in Scenario Editor can be put to immediate use in the VRSG simulated 
training environment. With Scenario Editor, you can easily update cultural features on areas 
of interest on the terrain across shared scenarios or just for a specific scenario.  

Scenario Editor is ideal for: 

• Populating virtual terrain with 3D content quickly. 

• Creating and sharing tactical training scenarios with pattern-of-life movement. 

• Avoiding terrain correlation and model overlap problems by using the same terrain and 
3D content in the scenario creation tool as rendered in the image generator. 
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Key features 
Scenario Editor’s key features include: 

• An easy graphical user interface enables quick ramp-up time for new users.

• Position and edit static culture in a scene, in a WYSIWYG manner. Changes are updated
       in the 3D scene in real time and are displayed exactly as they would look in VRSG.

• Navigate the 3D scene with a mouse or 6DOF controller with panning, zooming, and
       orbiting.

• Choose 3D models and effects from feature palettes with a search capability and gallery
       views.

• Set predefined viewing locations (viewpoints).

• Generate culture and scenario files that are compatible with VRSG.

Scenario-building features include:

• A timeline editor to sequence behavior entity movements and animations, appearance
       changes, effects, and camera views.

• Explosions, smoke plumes, and other special effects.
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• Camera view control with viewpoints you can add to the timeline and set their duration.

• Ability to export building footprints as shapefiles for use with MVRsimulation’s Terrain 
Tools or Battlespace Simulations’ Modern Air Combat Environment (MACE®). 
The .shp, .dbf and .shx files are exported in the standard shapefile format.

Installation 
Scenario Editor is installed automatically when you install VRSG (from MVRsimulation’s 
USB drive or Download Server). The installation program places a Scenario Editor icon in 
the Windows Start menu, within the MVRsimulation program group. The installation is 
located in MVRsimulation\Scenario Editor.  

Note that running Scenario Editor requires the Microsoft Windows 10 operating system, on a 
64-bit system.

Using scenarios in VRSG 
In a networked VRSG environment, you can run scenarios created with Scenario Editor by 
visualizing the static culture content (such as buildings and trees) and recorded DIS entities 
in VRSG. In Scenario Editor you can export a scenario’s cultural feature file, PDU log, and 
other associated files of the recorded activities of dynamic entities. Play the scenario in 
VRSG from the Scenarios tab on the VRSG Dashboard. 

Scenario Editor works as a complement to MVRsimulation’s Terrain Tools, which enables 
you to build 3D terrain from imagery, elevation, and shapefile data sources. 

Working with a 
dynamic entity in 
one of the 
Kismayo, Somalia, 
sample scenarios 
delivered with 
VRSG. 
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About the sample scenarios  
VRSG is delivered with sample scenarios that were built in Scenario Editor, which you can 
play back, examine, and modify to become familiar with the application. The scenarios take 
place on MVRsimulation’s terrain datasets of Hajin, Syria; Mischief Reef, South China Sea; 
Kismayo, Somalia; and Khairabad, Afghanistan, and are located in: 

\MVRsimulation\VRSG\Terrain\Afghanistan\ 

\MVRsimulation\VRSG\Terrain\Mischief-Reef\ 

\MVRsimulation\VRSG\Terrain\Somalia\  

\MVRsimulation\VRSG\Terrain\Somalia-EmptyDock\ 

\MVRsimulation\VRSG\Terrain\Syria\ 

In addition, Scenario Editor provides a scenario to use with the tutorial exercises in chapter 3. 

Other ways to become familiar with Scenario Editor include: 

• Watching videos of the example scenarios on MVRsimulation’s website at 
www.mvrsimulation.com. 

• Running the sample scenarios in VRSG. The MVRsimulation items on the Windows 
Start menu include shortcuts that immediately launch the scenarios in VRSG. 

What’s new in this release 
Scenario Editor v2.3 includes the rebranding of the company name to MVRsimulation. This 
version fully supports the new VRSG v7 name convention for cultural feature files, viewpoint 
files, PDUlogs, sensor profiles, microtextures and shapefiles: vrsg.clt, vrsg.viewpoint, 
vrsg.pdulog, vrsg,irm, vrsg.json, vrsg_microtexture_ x_y_z.tex, vrsg.shp, vrsg.shx, and 
vrsg.dbf. Previously created files with the older convention of "metadesic" in the filename are 
respected by Scenario Editor v2.3. 

Scene from a 
scenario created in 
Scenario Editor on 
MVRsimulation’s 
Haji, Syria, 3D 
terrain running in 
VRSG in UAV and 
sensor modes. 
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Previous release 
Version 2.2 (released in February 2021) 
Scenario Editor v2.2 contains the following new features and enhancements: 

• Ability to export just a scenario’s cultural feature file and/or viewpoints file; useful for
saving these files for use outside the scenario location.

• Simplified process for exporting a scenario.

• Example scenarios for the new terrain of Hajin, Syria, and Mischief Reef, South China
Sea, which are delivered with VRSG version 6.5.

• New Atmosphere panel on the Dashboard with options for clouds, sky models, fog, and
haze. These options, coupled with Time of Day/Lighting options, enable you to preview
environmental conditions, such as low-light or foggy conditions for culture placement or
behavior entity activity.

• New Sensor panel on the Dashboard with options for previewing notional and physics-
based sensor views.

• Full support for 3D oceans with waves, wakes, and Beaufort sea states (which can be
customized via the Oceans panel on the Dashboard); useful for previewing vessel activity
in littoral or sea-based scenarios.

• Ability to save environmental settings with the scenario.

• Full support for a model’s attributes listed in an accompanying JSON metadata file.

• Object-on-object dynamic shadowing, which can be customized via the Shadows panel
on the Dashboard.

Note: Version 2.2 was the last version of Scenario Editor that supported Windows 7. 

About MVRsimulation 
MVRsimulation Inc., founded in 1997, is dedicated to providing image generator software 
that runs on commercial off-the-shelf personal computers. MVRsimulation software is 
designed around the Microsoft family of products to maximize both the affordability and 
accessibility of high-speed virtual world creation and visualization software. 

MVRsimulation’s goal is to provide affordable simulation solutions to users who need 
compact, portable, virtual reality software to produce imagery at high throughput rates on 
state-of-the art personal computers. 

For more information about the company and its products, visit the MVRsimulation website 
at www.mvrsimulation.com.  

If you have specific questions about installing or using the VRSG system, or about installing 
or using a MVRsimulation product, you can contact MVRsimulation support services at: 

Email: support@mvrsimulation.com 

Phone: 617-739-2667 

Fax: 617-249-0151 

mailto:support@metavr.com
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If you need technical assistance… 
MVRsimulation is committed to providing you with a high quality product experience. If you 
encounter a problem with this product, first try to determine whether the problem stems from 
an underlying problem with your system, making sure that your machine meets the system 
requirements listed in the MVRsimulation Product Installation Guide.  

If you need further assistance, contact MVRsimulation via email at 
support@mvrsimulation.com with details about the sequence of actions that led to the 
problem and any resulting error messages. Attach any screenshots that help to illustrate the 
problem. In addition, supply the following information: 

• The version numbers of Scenario Editor and VRSG. 

• The operating system and version number. 

• Any special hardware or software configuration that might affect the problem. 

• A .zip file of the Scenario Editor log file directory, which is located in 
\MVRsimulation\Scenario Editor\Logs. 

Most email to MVRsimulation support services is answered within 24 hours, Monday-Friday 
9:00 am to 5:00 pm US Eastern Time. 

For more information about MVRsimulation and its products, visit the MVRsimulation 
website at: www.mvrsimulation.com. 

About this manual 
This manual describes how to install, and use Scenario Editor for creating cultural content 
and scenarios on 3D terrain to visualize in MVRsimulation’s image generator, VRSG.  

All Scenario Editor and VRSG images within this manual are real-time screen captures that 
taken in the two products except where noted, and are unedited except to format for inclusion 
in this manual.  

MVRsimulation values any feedback you have on this manual. Email any comments or 
suggestions to: support@mvrsimulation.com. 

 



 

 

C H A P T E R  2  

Getting Started 

Many aspects of Scenario Editor are familiar from VRSG: 3D scenes, viewpoints, adding 
entities (instances of static cultural and dynamic models), effects, and manipulating characters 
with weapons and animations. Scenario Editor also introduces additional concepts related to 
scenarios not found in VRSG. 

Scenario Editor introduces a type of file called a VRSG project. A VRSG project references 
associated files, or components of a scenario, including: 

• Viewpoints 
• Static cultural feature files 
• Scripted behavior files 

This chapter introduces all these components and the tools in the Scenario Editor workspace 
that are available to you for building up a scenario.  
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Starting Scenario Editor 
Scenario Editor can run on any Windows 10 64-bit machine that has MVRsimulation VRSG 
installed. Make sure the VRSG dongle is inserted in the USB port before you start Scenario 
Editor. 

Start Scenario Editor by either: 

• Clicking the Scenario Editor icon in the Windows Start menu, within the MVRsimulation 
program group. 

• Navigating to the \MVRsimulation\Scenario Editor\Bin installation directory and double-
clicking ScenarioEditor.exe. 

 
You can also have Scenario Editor start from a desktop shortcut and immediately launch a 
scenario, as described in the chapter “Creating and Editing Scenarios.” 

The first time you start Scenario Editor, the MVRsimulation Software License Agreement 
appears; you must accept it in order to run Scenario Editor.  

When you start Scenario Editor, the workspace appears, initially showing a 3D globe of the 
earth in the 3D scene and a list of available VRSG scenario projects in the left panel.  

Highlighted on the globe as colored triangles are VRSG terrain tiles (MDS) that Scenario 
Editor has discovered in its search paths. You use the globe to create a new project, as 
described in the chapter “Creating and Editing Scenarios.” 
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From here you can open an existing project to edit a scenario, create a brand new project, 
save a project, or exit from Scenario Editor. As shown in the example above, the sample 
scenario projects that are delivered with VRSG appear listed in the left panel as available 
projects. 

As described fully later in this chapter, Scenario Editor obtains its list of available scenario 
projects from its search paths, much in the same way VRSG uses content found in its search 
paths.  

To open a scenario project, double-click the project from the list on the left.  

Note: Depending on the size of the project and density of culture, it may take Scenario Editor 
a couple of minutes to fully page in (as in the case of the scenarios delivered with VRSG). 

Workspace 
Scenario Editor’s workspace is where you build up culture on the terrain and create your 
scenarios. It contains the VRSG 3D rendered scene in the center, all information about the 
content in use in projects and scenarios displayed in tables on the left, and palettes of 
available models and effects that you can use in your scenarios on the right.  

  

List of available 
scenario projects. The 
project files must be 
in Scenario Editor’s 
search paths for it to 
be available. Double-
click a project to open 
it. 

File menu – for 
creating, opening 
and saving scenario 
projects, exporting 
projects to VRSG, 
and exiting from 
Scenario Editor. 

Edit menu – for copying, 
pasting and deleting entities.  

Help menu – for displaying this 
user’s guide, online help, and the 
release version of Scenario Editor.  

Search Paths tab, 
which lists the 
directories Scenario 
Editor searches for 
terrain, content, 
textures, and 
scenarios. 

Globe for starting a new 
scenario project from a 
selected terrain tile. 
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Parts of the workspace 
The table that appears on the left side of the workspace displays information about a 
particular aspect of the scenario project that has the current focus, such as a scenario’s entities 
or viewpoints. Some information in these tables is editable. Cells that are white are editable, 
cells that are colored grey are not editable.   

The Playback tab has controls for playing scenarios, and the timeline where you schedule and 
control the entity and effects activities taking place in the scenario.  

The feature palettes on the right side of the workspace are where you select models and 
effects to add to the 3D scene as you build up your scenario. You drag a model from either 
the behavior or culture feature palette and drop it onto the terrain in the 3D scene to create an 
instance, or entity.  

The feature palettes are searchable, and have a gallery view, that displays thumbnail images 
of the behavior and cultural models and a list of effects. Drag the slider above the palettes to 
enlarge or shrink the size of the thumbnail images. Behavior entities in Scenario Editor are 
scripted entities of vehicles and characters which perform some time-based activity. Cultural 
entities are static models such as buildings and other structures, signage, and trees and other 
vegetation. 

The project navigation bar, (sometimes referred to as breadcrumbs) at the top of the 
workspace shows the context of where you are. You can navigate easily between various 

Navigation bar, which shows 
context and enables you to 
move quickly among the 
components of the scenario 
project. 

3D scene, where you 
build up and 
manipulate content 
and actions for your 
scenario. 

One of the model palettes which 
show available models and effects 
that you can drag and drop onto 
the 3D scene. 

Table of editable 
data of the selected 
component in the 
project (viewpoints, 
culture, behavior 
entities, and events). 

Playback controls for 
playing scenarios. 

Playback tab contains the scenario timeline 
in which you control the entity activity, 
duration, speed, and appearance. 

Tools for interacting 
within the 3D display: 
Selection / Duplicate 
mode, Random/Retained  
orientation.  

Slider to increase or 
decrease the size of 
model thumbnail images. 

Slider to increase or 
decrease the size of the 
entity editing tools. 
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parts of a scenario project, such as between the viewpoints view and cultural entities view, by 
clicking in the navigation bar or by clicking the heading of interest in the left panel. 

 
Use the options on the menus at the top of the workspace to: 

• Open, create, and save projects and export them to VRSG (File menu).  
• Set coordinate display system and display a compass rose (Options menu).  
• Copy, paste, and delete entities and effects in the 3D scene (Edit menu). 
• Configure network information in the 3D display for sharing scenarios in VRSG  

(Options menu). 
• Display online help and onscreen overlay of keyboard shortcuts, launch the .pdf file of 

this User’s Guide, and display information about the Scenario Editor release and your 
VRSG license information. 

 
You can resize each of the three main areas of the workspace by dragging the left or right 
edge (splitter) of the 3D display to make an area wider or narrower. The width of the columns 
in the table on the left can be resized by dragging the column splitters. The thumbnail images 
on the palettes can be resized by dragging the slider above the palettes. 

You can hide a workspace panel completely by clicking the small grey arrow button on the 
splitter. Click the arrow button again to display the panel. 
  

Drag the edges to 
make the 
corresponding 
areas wider or 
narrower. 

Change the sort 
order of the columns 
in any table that 
appears here by 
clicking on the 
column headings. 

Change the order in 
which the columns 
appear, by clicking 
on the column 
heading and 
dragging it to the 
left or right. 
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Below the 3D scene are controls for scenario playback and tabs for managing search paths, 
information about Scenario Editor status, the scenario timeline, and a Dashboard with 
environmental and network settings.  

If the timeline is collapsed vertically when you open a scenario, you can expand it by 
dragging it vertically to expand it as shown in these next two examples:  

 
 

 
Clicking the cells in the timeline displays editors for a behavior entity’s speed, animations, 
appearances, and for firing a weapon. 

Projects and scenarios 
A scenario project is made up of files and scenarios which in turn references additional files. 
A project contains elements that will be used in one scenario or will be shared among several 
scenarios, such as terrain, some static culture (clusters of buildings, trees), viewpoints, and so 
on. Each scenario can have its own static culture and viewpoints, as well. 

Opening and saving scenario projects 
To open an existing project, do one of the following: 

• In Scenario Editor, select the scenario project from the projects list on the left side of the 
workspace. Projects listed in the workspace are ones that Scenario Editor finds in its 
search path, such as the example scenario projects that are delivered with Scenario 
Editor. 

Click the grey arrow control to toggle 
hiding and displaying the panel 
adjacent to the 3D scene. 

Timeline 
vertically 
expanded. 

Timeline 
vertically 
collapsed. 
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• In Scenario Editor, choose File > Open and browse for a project of interest that is not 
listed in the workspace.  

• In Scenario Editor, choose File > Recent VRSG Projects and then click on one of the 
recently opened projects that are listed. Scenario Editor lists the last several projects that 
were opened. 

 
Note that in all cases, the directories for terrain, content, textures, and scenarios must be the 
listed on the Search Paths tab, as described in the next section. One scenario project at a time 
can be open in Scenario Editor. To open a project while you have a project already open, 
simply open the second project from the File menu. Before opening the second project, 
Scenario Editor will prompt you to save changes to the project you want to close.  

Note: When you open a complex scenario project, it might take a few minutes for the project 
to fully load. Scenario Editor displays progress messages and a green circular load-progress 
icon in the upper right corner of the 3D scene as it loads the project. The project is fully 
loaded into Scenario Editor when the icon disappears, at which time you can begin work on 
the scenario. 

Saving a scenario project 
To save changes to a project, choose File > Save. Choose File > Save As to save an existing 
project and its associated files under a new name.  

Creating a new scenario project 
There are multiple ways to create a new scenario project. The simplest way is to double-click 
on a terrain tile that is highlighted on the globe when you start Scenario Editor. (Zoom in to 
see the tiles up close by using the mouse scroll wheel or right-click and drag.) When you do 
so, Scenario Editor creates a new project using the selected tile and you can immediately start 
building up content. For more information about creating a new project and scenario, see the 
chapter, “Creating and Editing Scenarios.” 

Deleting a scenario project 
To delete a scenario project, right click the project in the list of projects on the left panel, and 
choose Delete.   

Navigating parts of a scenario project 
You can switch between the parts of a scenario project by clicking elements in the project 
navigation bar at the top of the workspace, by selecting items in the context menu, or by 
clicking one of the folders listed on the panel on the left. 
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Adding and editing search paths 
The notion of a search path in Scenario Editor is similar to a VRSG search path. Scenario 
Editor searches the specified directory paths to find the elements that you want to use in your 
scenarios. Such elements include VRSG terrain tiles (.mds), models (.hpy or .hpx), 
viewpoints (vrsg.viewpoint), cultural feature files (vrsg.clt), and other scenarios.  

Scenario Editor is delivered with search paths for all the model and terrain directories 
installed with VRSG. When you first start Scenario Editor after installation, the following 
search paths (and therefore the scenarios in those search paths) will be available for you to 
choose from: 

 
You can add directories to the search path when you create a new scenario project or at a later 
time, for example to access an additional collection of models located elsewhere. 

Also similar to VRSG, you must add one or more directories to the search path when you first 
start a Scenario Editor session but only before you load a scenario project. In order for 
anything to be available for use in Scenario Editor outside its installation directory (terrain, 
models, viewpoints, cultural feature files, and so on) the directory paths to these files must be 
specified.  

When you add or remove directories to the search path list, the terrain tile coverage display in 
the globe that appears when you start Scenario Editor will update accordingly. 

If your scenario loads without any terrain, it will display with water. This indicates that the 
directory in which the terrain is located is missing from the search path. 

 

Click here to 
access a 
scenario 
component. 

List of directories 
that Scenario 
Editor will search 
(in descending 
order) to locate 
terrain tiles, 
models, cultural 
feature files, and 
viewpoints. 

The plus sign (+) next to a 
directory path indicates that it is 
a high-level, or parent, 
directory with one or more 
subdirectories. Click the plus 
sign (+) to display the 
subdirectories. 

List of scenarios 
that Scenario 
Editor has found in 
the directories in 
the search path. 
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To add a directory to the search path: 

• On the Search Paths tab, located below the 3D scene, click the browse button (…) and 
locate the first directory path you want to add to Scenario Editor. To add more directory 
paths, browse to each path you want to add and then click the plus-sign (+) button. This 
action adds the path to the top of the search list. 
 
As in VRSG, the order in which the directories in the search path are listed is the order in 
which Scenario Editor will search for content, starting with the path listed at the top. The 
search order becomes very important in cases where you have several files, each with the 
same name, in the different directories. Scenario Editor will use the file listed in the first 
directory path it encounters (the top of the list). 

• To change the order in which a directory is listed, select the directory of interest, and then 
click the up-arrow or down-arrow button to move its position higher or lower in the list.  

• To remove a directory from the list, select the path, and then click the Delete button (X). 

 
In the Search Paths list, a higher-level, or parent, directory is indicated by a plus sign (+) to 
the left of a directory entry and is shown collapsed by default. You can expand it by clicking 
the plus sign to view the subdirectories that Scenario Editor will search. (Note: Examining 
expanded directories in the search path is available while you can edit the search paths, prior 
to loading a project. Once you load a project, the search path list is read-only.)  

Because directories for terrain tiles can be complex (residing on multiple drives, using 
multiple cultural feature files, microtextures, and so on) you can list a high-level directory in 
the Search Paths list, and then directly in that directory provide a list of the subdirectories you 
want Scenario Editor to search in a text file, called VRSGTerrainSearchPath.txt. Scenario 
Editor operates on VRSGTerrainSearchPath.txt files exactly the same way VRSG does. See 
the chapter “Playing Scenarios in VRSG” for more information about search paths and the 
VRSGTerrainSearchPath.txt file. 

Again, you cannot add a directory to a search path to a Scenario Editor session once you have 
opened a VRSG project. You can add search paths just after you start Scenario Editor but 
before you have loaded a project. 

3D scene 
The 3D scene is the VRSG rendered scene where you build your scenario. You interact 
directly in the scene to navigate, drag content to the scene, manipulate content, add and adjust 
waypoints, and so on. Your updates to the scene are rendered in real-time.  

Move the position of a selected directory in the list 
to reorder the search priority of the path. 

Delete a selected directory from the list. 

Add a new directory to the search path list by entering 
text or pasting a directory into the text field. 

Add a new directory to the list by browsing for it. 
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Navigating the scene with a mouse or 6DOF controller 
To move around in the 3D scene you use a mouse, or optionally, a 6DOF game controller 
such as the 3Dconnexion SpaceMouse Pro or SpaceMouse Compact. 

Moving around the 3D scene with a mouse is similar to moving around in Google Earth. To 
navigate the 3D scene with the mouse, you click in the 3D scene to create target point. 
Dragging the scene changes the eyepoint centered on the target point.  

Intent Action 

Pan Click and drag. 

Orbit Alt-click and drag, or press the mouse scroll wheel. 

Zoom Right-click and drag. 

You can also zoom with the mouse scroll wheel. Zooming with the scroll wheel is a form of 
targeted flying. Click on a terrain target point in the scene. The eyepoint will turn toward the 
target as you zoom in or out by moving the wheel. Stop scroll-wheel zooming by either 
moving the wheel in the opposite direction or clicking the left mouse button. 

Optionally you can navigate the 3D scene with a 3Dconnexion 6DOF game controller: 

Intent Action 

Pan Tilt the cap. 

Orbit Twist the cap. 

Zoom Push and pull the cap. 

 

Other display features 
Many display features from VRSG are available in Scenario Editor’s 3D scene, such as:  

• Displaying the scene in wireframe mode, by pressing the I key on the keyboard. 
• Displaying the scene in sensor modes, by pressing the O key.  
• Displaying a compass rose in the upper-right corner of the scene by pressing the R key. 
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• Displaying behavior entity ID information as a 2D overlay by pressing F12. Pressing Ctrl 
F12 displays the IDs of static cultural entities. 
 

 
 

• Displaying onscreen Help about the display (by pressing the F1 key or choosing Help > 
Show Onscreen Help). F1 also cycles the display of the current scenario time and frame 
rate. 
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Pressing F1 a second time shows the current scenario time and frames-per-second rate. 

 
Change the displayed coordinate system by choosing Options > Select Coordinate System 
and selecting one of the coordinate settings as shown: 

 
This setting is for display purposes only and controls any place in Scenario Editor where 
location, positions of entities, viewpoints, and so on are displayed both on the 3D terrain and 

Press F1 to 
display/hide onscreen 
Help for keyboard 
functions and to 
toggle the current 
scenario time. 
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in any tables on the left panel. The default display coordinate system is Decimal 
Latitude/Longitude. 

Positioning entities on the 3D scene 
In Scenario Editor you work with cultural and behavior entities. As described fully in the 
chapter “Creating and Manipulating Entities,” you create cultural entities by adding static 
models of trees, buildings, fences, and so on, to the 3D scene. You position them on the 3D 
terrain with tools that refine their orientation and altitude or ground clamping. Similarly, you 
create behavior entities with moving models of vehicles or characters. But you position them 
on the terrain with tools that add and refine waypoints along a path of movement, control 
their speed, their appearance, and in case of characters, animations and weapon fire.  

The following examples show a vehicle model from MVRsimulation’s 3D content libraries 
illustrating the difference between the two kinds of entities. On the left the car model is 
shown instantiated as a cultural entity; on the right the model is instantiated as a behavior 
entity.  

 

 

 

     
 

The scenarios that are delivered with VRSG contain many examples of vehicles and 
characters that are culture (parked vehicles, stationary characters) and behavior (moving, 
scripted) entities.  

Example of a vehicle model 
instantiated as a cultural entity, 
shown with an orientation tool 

Example of a vehicle model instantiated  
as a behavior entity, shown with a path 
and waypoints. 
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To add an entity to your scenario, drag an entity from the culture or behavior feature palette 
and drop in the 3D scene. The entity remains selected until you press the Esc key.  

 
An instance of the model, called an entity, appears on the 3D scene where you dragged it. In 
the example above, a static cultural entity was created on the scene, by dragging a picnic table 
model from the culture model palette and dropping onto the 3D scene. The new picnic table 
entity is surrounded by a yellow hoop called the orientation tool. Press the Esc key to 
unselect the entity. 

To select anything in the 3D scene, you double-click it. To unselect it, press the Esc key on 
the keyboard or select another entity. 

Waypoint of the 
selected entity’s 
path. 

Selected entity’s 
path of travel. The 
green color of the 
path indicates the 
speed. 
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When you double-click the entity to select it in the 3D scene, it becomes highlighted in a 
bright teal green color. An entry for the selected entity appears in the corresponding entity 
table on the left panel of the workspace; the table switches to match the context of what is 
selected. The row in the table corresponding to the selected entity in the scene is also selected.  

Double-click an entity in the scene to move it (by dragging it), manipulate it, or edit its 
characteristics. Again, press Esc to unselect it or select another entity if you are making edits 
to multiple entities. 

Entities are ground-clamped by default, which means the entity will slide along the ground as 
you drag it, unless you unlock the ground clamping to raise it. Depending on the type of 
entity, various tools are available in the 3D scene for manipulating entity placement. These 
tools enable you to perform a particular kind of edit on a selected entity as described in the 
chapter “Creating and Manipulating Entities.” 

 
There is no physics-simulated collision during entity placement. This means that entities will 
overlap if you place them that way. Entities that are unintentionally overlapping can be 
visually distracting to viewers but you can easily adjust entity positions to minimize overlap. 

Undoing edits to a scene 
You can undo and redo your edits to behavior and cultural entities, waypoints, and effects. As 
in other applications, the Undo action reverts the last edit you performed on an entity, 
waypoint, or effect.  

To undo the last edit, choose Edit Undo or type Ctrl-Z. You can also redo the last edit you 
reverted with Undo by choosing Edit > Redo or typing Ctrl-Y. Scenario Editor stores the edit 
history in memory so you can undo all the way back to the start of an edit session.  

Undo is operational for edits within a scenario; it is not in effect when you add or delete 
search paths on the Search Paths tab before opening a project. 

 

 



2−16    MVRsimulation Scenario Editor User’s Guide 

Keyboard commands 
Scenario Editor provides the following keyboard commands that operate in the 3D scene:  

Key Action 

F1 Display onscreen Help. 

F12 Cycle entity overlay display.  

I Display the scene in wireframe mode. 

O Display the scene in sensor mode. 

V Cycle to the next viewpoint. 

Shift-V Cycle to the previous viewpoint.  

C Capture the scene and save it to the Clipboard or to an image file. 

R Displays a compass rose on the scene. 

S Save a viewpoint at the current eyepoint location in the scene. 

Y Enable nudge mode for controller gain. 

Spacebar Toggle scenario playback on/off. 

Ctrl-C Copy the selected entity to the Clipboard. 

Ctrl-X Cut the selected entity and copy it to the Clipboard. 

Ctrl-V Paste an entity from the Clipboard to the scene at the cursor location. 

Ctrl-Z Undo in-scene edit. 

Ctrl-Y Redo an undone in-scene edit. 

~ (tilde) Toggle 3D oceans rendering on/off. 

Feature palettes 
The feature palettes display cultural and behavior models and effects that you can add to a 
scenario. You can rapidly build up content in your scene by dragging models from the 
palettes and dropping them onto the 3D scene to create entities. A given palette can be filtered 
and sorted so you can narrow the list of items displayed in the palette to only relevant items.  
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The models displayed in the feature palettes are from the model directories Scenario Editor 
finds in its search path. The default models are from the 3D model libraries installed with 
VRSG. The libraries contain over 8,500 models. The effects palette contains over 400 effects 
installed with VRSG. 

An easy way to see the breadth of the model libraries, categorized, is on the MVRsimulation 
website at www.mvrsimulation.com/3DContent/ModelsHome.shtml. 

You can also add your own models and effects to the feature palettes. Any models in FBX or 
FLT format can be converted to MVRsimulation’s model format using the model conversion 
utilities that are delivered with VRSG and installed in \MVRsimulation\Common\Util.  

Click the gallery view button on the feature palettes to view models or effects with only their 
thumbnail image, without any text. Move the slider to the left of the gallery view button to 
increase or decrease the size of the models’ thumbnail images. Hover the cursor over a 
thumbnail image to see the directory in which the model of interest is located. 

Filter the list of models or effects displayed in the feature palettes by typing a model name or 
a partial name into the search box located above the palettes by typing into the search box 

Enter a search 
term (such as 
part of a word) 
in the search 
field to narrow 
the list of 
available models. 

Click to switch between displaying model 
thumbnails in a list view (shown on the left) 
and in gallery view (shown below).  

Move the slider to increase or 
decrease the size of the model 
thumbnail images. 
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located above the palettes. Like searching for items in other applications, as you type a letter 
or a partial word, result models that match what you typed are displayed in the palette: 

 
The search performs a case insensitive match on the name of the model. A space in the search 
text is treated as a wildcard. Because the feature palettes are quite large, the search box 
becomes useful for filtering the selection and locating a set of models or just one model. For 
example, all human character models begin with the prefix “human”. Therefore, to search for 
human characters you would type “human” in the feature palette in which you are searching 
to display only the human character models. Similarly, you could search for all effects that 
contain “flame” in the name. The military vehicle models are named with their military 
designation. If you know at least the first part of the military designation of the model you are 
looking for, such as “RQ” or “M977”, you can type it in the search box and the feature palette 
will display all models that have that part in the name. 

To add your own custom models (in MVRsimulation’s model format) to the feature palettes 
so you can use them in Scenario Editor, add the applicable model directories to the Scenario 
Editor search path.  

Effects 
Scenario Editor offers several types of effects for a scenario, such as smoke plumes, dust 
puffs and trails, flames, explosions, and three levels of damage states. In addition, dust trails, 
exhaust plumes, contrails, wakes, flames, and track impressions can be added to behavior 
entities to augment their appearance. 

To add an effect to the 3D scene, drag an effect from the Effects feature palette to the 
intended location in the scene. The effect will start playing at the current scenario time by 
default. You can edit the effect’s start time in the events table. 

When the scenario is not playing, the effect is displayed as a yellow striped dome on the 
terrain. Select and drag the effect dome to refine its location. When you play back the 
scenario, the effect becomes activated, as shown: 

Models with names that match what 
you type into the search box appear in 
the palette as you type. 
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Three levels of damage effect set to go off at a specific time. The resulting damage effect during scenario playback. 

Depending on the nature of the effect, an effect may be carried out as a momentary event; 
others linger in action for a longer duration. 

As with other features, double-click an effect (yellow dome) in the scene to select it. Press the 
Esc key to unselect it. To delete an effect, select it in the 3D scene or in the effect table and 
press the Delete key. Alternatively, select the effect in the 3D scene, right click the effect to 
display its context menu and choose Delete Effect.  

Some effects take the form of a DIS appearance bit, as in the case below of a burning 
smoking vehicle.  

 
Effects that extend the appearance of a behavior entity, such as dust trails, exhaust plumes, 
contrails, wakes, and track/wheel/footprint impressions are described in the chapter “Creating 
and Editing Scenarios.”  

Dashboard  
The Dashboard is where you set visual display settings during a Scenario Editor session. The 
settings on the Scenario Editor dashboard are only used for visualizing details like time of day 
and environment settings along with session controls like controller gain and screen capture 
preferences. The Scenario Editor Dashboard tab, which becomes activated after you load a 
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scenario, has several panels that match many of the features also found on the VRSG 
Dashboard.  

The Scenario Editor Dashboard features pertain to only the current Scenario Editor session 
and are not exported with the VRSG Project for playback in VRSG. When a scenario is 
played in VRSG, the settings from the VRSG Dashboard or from an external sim host or 
CIGI application will be what is rendered in the VRSG visualization window. 

As in other Windows applications, click a plus-sign (+) next to each panel heading to expand 
the panel settings. 

 
 

 

Atmosphere settings  
The settings on the Atmosphere panel control various sky, fog, haze, and cloud characteristics 
of the 3D scene. 
 
 
 
 

 
The options in the Sky Model drop-down list specify the type of sky to use for the scene, such 
as Dawn, Dusk, High Cirrus, Cloudy, Night, and so on. The sky blends with the selected 
Ground Fog Color near the horizon. The None sky model option displays the entire sky as the 
ground fog color.  

Sky, clouds, fog, and 
haze. 
 

Search box for finding a 
particular option or setting on 
the Dashboard. 

Lighting conditions for a day or 
night scene. 

Settings for shadows 
cast by clouds and 
entities. 

Characteristics  
of the 3D ocean 
surface. Characteristics of the sensor 

mode / IR display. 

Settings for capturing a still 
image of the 3D scene. 

Shading effect that enhances 
3D perception of models. 

Exporting options.  

Altitude of the bottom 
of the cloud layer. 

Type of sky 
model to use. 

Distance at which the 
terrain completely fades 
into the haze color. 

Haze color 
used when the 
view is not 
aligned with the 
sun. 

Height of the ground 
fog layer. 

Density of cloud 
coverage from sparse 
to fully overcast. 

Haze color used 
when the view is 
aligned with the 
sun. 

Controller Gain 
settings. 
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To view your 3D scene as a night scene, select the None sky model, adjust the Haze color, 
and on the Time of Day/Lighting Conditions panel, the Moon light source direction, the 
Ambient and Diffuse colors, and optionally the moon phase.  

• The Cloud Coverage options range in density from sparse cloud cover to solid overcast. 
Layer Bottom is the cloud layer’s altitude. These options display the volumetric ray-
traced cloud system. The Enable Legacy Clouds checkbox disables these options and 
displays the older style volumetric clouds instead.  

• The Haze slider indicates the range at which the terrain completely fades into the haze 
color. 

• Haze Color is the primary haze color used when the view is not aligned with the sun. 
Color In Sun is the color of haze used when the view is aligned with the sun. The actual 
haze color used for a pixel is a blend between the primary haze color and the Color In 
Sun haze color. The angle between the line-of-sight vector to the object and to the sun 
determines the ratio between these two colors. 

• The Vertical Scale slider changes the rate of visibility improvement as a function of 
altitude, when Ground Fog is not turned on. 

• Ground Fog Ceiling is the height of the ground fog layer close to the ground. 
• Visibility Range is the range of the ground fog layer close to the ground. 

DIS Settings 
Use the options on the DIS panel to control the broadcast Exercise ID, Site, and Host settings 
for Playback. These settings only apply to PDU logs that are played using MVRsimulation’s 
Playback.exe. It is not common for most Scenario Editor users to work with Playback.exe in 
this way. MVRsimulation recommends leaving these settings as default: Exercise ID: 1, Site: 
1, Host: 2. 

3D oceans settings 
Use the options on the Oceans panel to specify various characteristics of the ocean and sea 
vessel motion on the ocean surface. To see the visual effects of the settings in the Oceans 
panel, you must press play on the Playback tab. Entities with the DIS enumeration in the 
surface domain (domain 3) will properly clamp to the ocean surface and will generate wakes 
automatically.  

Enable Oceans option toggles rendering 3D ocean sea states and legacy 2D water. When this 
option is enabled, the other options on the panel become available.  
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• Beaufort Scale defines the level of impact of wind force on the sea conditions. Specify a 

sea state based on the Beaufort wind force scale, ranging from 0 (calm seas) to 12 (rolling 
waves of hurricane conditions).  

• Ocean Quality (Good, Better, Best) sets the resolution level (triangle density) of the 
ocean surface. The Best option renders the highest level of detail, while the Good option 
has the least impact on VRSG performance. 

• Shoreline Awareness (Smooth, None), when set to Smooth, enables a higher-fidelity 
smooth transition of shallow wave shape and water transparency near the shore, 
especially when shoreline terrain contains bathymetry data.  

• Sea Level sets the MSL height of the ocean surface in meters. 
• Boat Dynamics Scale controls the buoyancy or realistic motion of vessels, using simple 

boat dynamics. The smaller the value, the greater the dampening of the motion. 
• Show Ocean Spray renders spray particles from breaking waves in choppy sea 

conditions. 
• Advanced Depth Bias calculates where a vessel is in relation to the ocean; by default it is 

turned on. Unselect the checkbox to turn off this feature when using narrow fields of 
view, like those used by UAV sensors. Turning off the feature applies a much larger 
depth bias, thus avoiding potential z-fighting or other visual artifacts. 

• Enable Wakes toggles rendering 3D ship wake waves, including bow wave (optionally 
with spray), stern wave, and prop wash. When this option is enabled, you can also set 
whether to render the wake spray particle effect and the length of the wakes from 50 to 
600 meters. 

• Prop Culling Distance controls the distance from the eyepoint at which VRSG stops 
rendering a given vessel’s engine propeller wash.  

• Ocean Color modifies the color of the ocean by adding the color you specify in the color 
palette to the default ocean color. Click the ocean color patch, and when the Windows 
color palette appears, select a color and click OK. (Note the default ocean color appears 
as black in the color palette, but does not color the water black.) The color you choose is 
mixed with the default ocean color; it does not completely replace the ocean color. 

• Legacy Sea State – the 2D legacy water texture to render if 3D Oceans is not turned on in 
VRSG when the scenario is played. 

Turns on 3D ocean 
simulation and 
enables the options 
on this panel. 

Sets sea state based on the Beaufort 
wind force scale (0 to 12).  

Sets the resolution (level of detail) of 
the ocean surface.  

Sets a higher-fidelity 
smooth transition of 
shallow wave shape 
and water with 
transparency near the 
shore.  

Controls the buoyancy 
or realistic motion of 
vessels. The smaller the 
value, the greater the 
dampening of the 
motion.  

Controls the distance 
from the eyepoint at 
which VRSG stops 
rendering a given 
vessel’s engine  
propeller wash.  
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Preferences settings 
On the Preferences tab, set the Controller Gain to control the sensitivity of a 6DOF controller. 
You can also select the Nudge Mode option or press the Y key to reduce the gain on the 
controller 

 

Screen Space Ambient Occlusion settings 
Screen Space Ambient Occlusion (SSAO) is a shading effect that enhances the 3D perception 
of the shape of all models (static and dynamic) rendered in a scene. SSAO simulates the 
shadowing caused by the blocking of ambient light. By adding darkness to corners, crevices, 
and other angular transitions, SSAO decreases the ambient lighting that occurs at the 
intersection of planes on the surface of a 3D model or at the intersection of models and the 
terrain. 

 
• Enable – Click the checkbox to toggle Ambient Occlusion on and off. 
• Gaussian Blur – An extra effect to smooth darkened pixels. 
• Resolution – Controls the size of the framebuffer to render (how much SSAO detail 

VRSG should render). The default resolution is 50%. A higher resolution might introduce 
a lower frame rate. 

• Distance from eyepoint – Controls the distance from the eyepoint at which the SSAO 
effect should be rendered. The further the distance, the more graphically realistic the 
effect appears, but at a higher the cost in frame rate. 

Sensor settings 
On the Sensor panel, you specify characteristics of the sensor mode display, such as the 
amount of noise or blur, the level of intensity of the terrain or vehicles, and whether to display 
simulated A/C banding.  

Set desired 
Controller Gain. 

Select to enter Nudge 
Mode to reduce 
Controller Gain. 
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The post-processing effects for the VRSG scene in all sensor modes are listed on the left: 

• Noise – Adjusts the amount of artificial noise. 
• Focus – Adjusts the intensity of optical focus (blur). 
• Level – Adjusts the brightness. 
• Gain – Adjusts the contrast. 
• Digital Zoom – Performs a pixel magnification to zoom the image.   
• Motion Blur – Adjusts the simulated blurred or smeared appearance of objects along the 

direction of relative motion. A small degree of blur is recommended, as it makes the 
scene appear less crisp and more characteristic of an IR sensor. 

• Heat Refraction – Adjusts the amount of simulated light bending as it passes through 
different temperatures of air. This creates the effect of shimmering especially noticeable 
over hot surfaces like roads. 

• Additional Sensor options are listed on the right: 
• A/C Banding – Displays the scrolling horizontal stripe that simulates the banding 

produced by power supplies that have frequencies dissimilar to the vertical retrace period 
of the monitor. When you select this option, also select the sensor view on which you 
want the banding to appear. 

• Automatic Gain Control – Selects the radiance minimum and maximum range to which 
the display dynamic range is mapped; based on the selected IR configuration file. 

• Display IR Green – Displays infrared light as green like in night vision devices when 
selected. If not selected scenes are displayed in white hot or black hot. 

• Spectrum – Select the spectrum of sensor mode you want to visualize 
• IR Configuration – Select the IR configurations stored in JSON file. The Default.json file 

will be selected. To create custom IR configuration JSON files, send an email to 
support@mvrsimulation.com and request the IRSetup Utility. 
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Shadows settings 
Clouds, and static and dynamic models can cast shadows in the 3D scene. All models cast 
realistic shadows onto terrain, water, and everything around them, including self-shadowing. 
Shadows are rendered based on the sun position. To activate shadows for clouds and/or 
models, move the slider from the left (shadows disabled) to the right to control the intensity 
of the cast shadows. 

 
• Cloud – Control how much the clouds block directional light. (Set the cloud layer on the 

Sky panel.) 
• Object – Control the intensity of the shadows cast by models/entities. 
• Quality/Performance –Select one of the two options to optimize for quality (best for 

ground level scenarios) versus performance (best for flight simulation). 

Snapshot settings 
Like VRSG, you can take a screen captures or “snapshots” of the 3D scene. The screen 
capture can be saved either to a file in one of several popular image formats or captured to the 
Windows Clipboard.  

 
Scenario Editor creates a screen capture solely of the 3D scene; it does not include the table, 
content palettes or timeline. The dimensions of the capture are the exact dimensions of the 3D 
scene as it is displayed on the monitor. (This means that if you want a large capture of the 3D 
scene, ensure Scenario Editor is in Windows full-screen display mode before you take the 
capture.) 

To specify how screen captures should be handled: 

• Specify whether to save a screen capture to the Windows Clipboard or to a file.  

Controls the 
display of shadows 
cast by clouds on 
the ground. 

Controls the 
display of shadows 
cast by all entities 
in the scene. 
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• If you specify to have the captures saved to a file, specify the filename prefix and the file 
format. Each capture will be named with your specified prefix with an appended counter 
(000, 001, and so on). 

To take a screen capture: 

1. In the 3D scene, navigate to the area of which you want to capture a still image. 
2. Press the C key on the keyboard. A still image of the 3D scene is copied to either the 

Windows Clipboard or to a file, depending on the settings on the Snapshot panel.  
3. If your image is saved to the Clipboard, paste the image from the Clipboard into the 

target application.  

Time of day and lighting conditions settings 
The Time of Day/Lighting Conditions options enable you to create lighting conditions for a 
day or night scene for simulating the light cast from the sun or moon for shading purposes. 
Simulated lighting conditions are automatically calculated from date, time, and geographic 
location. 

 
Scenario Editor uses the specified time of day, date and current camera location latitude and 
longitude to compute accurate celestial bodies’ position. The computed location of the sun is 
used to generate accurate shadow angles for that time, date and location. 

You can set specific custom lighting conditions manually, overriding the computed celestial 
bodies angles by expanding the Set Lighting Manually options: 
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• Sun and Moon options set the position of the light source (sun or moon). This 
illumination is independent of any 3D graphic of a celestial body that may be a part of the 
sky model texture. 

• The Azimuth slider specifies the horizontal angle of the sun or moon light source relative 
to the horizon. 

• The Elevation slider specifies the vertical angle of the sun or moon light source upward 
from the horizon.  

• “Ambient” applies general illumination to the scene and does not cast shadows. Click the 
Select Ambient color square to display a color palette from which you can select a color 
for the illumination. 

• “Diffuse” light illuminates the scene from the direction of the sun (or the moon at night).  
Diffuse light can cause shadows to be cast. Click the Select Diffuse color square to 
display a color palette from which you can select a color for the diffuse light source.  

Searching for a setting 
To quickly locate a particular setting on the Dashboard, type the setting name or a portion of 
the setting name in the search box. As you type, the Dashboard expands to highlight settings 
in all the panels that have matching text, as shown in the following example: 

 
In the example above, the Atmosphere and Shadows panels expand to display the settings that 
begin with the text “clou.” 

Adding and editing viewpoints  
As in VRSG, viewpoints are saved views of an absolute terrain position in the 3D scene. You 
can set up static viewpoints just as you would in VRSG, to easily return to a specific location 
on the terrain. But in a scenario, viewpoints take on an additional role when you add them to 
the timeline; they become time-based scripted views, or in motion-capture terms, they 
become frames recorded by a video or film camera. During the scenario, they display the 
exact view you want the viewer to see in the 3D scene for a specific period of time. (The 
sample scenarios that delivered with VRSG were made with extensive use of time-based 
viewpoints.) 

To go to a viewpoint location in the scene, click the appropriate viewpoint row in the 
viewpoints table. (You can click anywhere in the row of the viewpoint.) 

To add a viewpoint: 
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1. Navigate to the location of interest in the 3D scene. 
2. Position the eyepoint to exactly where you want to set the viewpoint, and then press the S 

key on the keyboard.  

The new viewpoint is added to the scenario’s viewpoints table and given an automatically 
generated name of “Viewpoint n” where “n” reflects the sequential number of the new 
viewpoint. The viewpoint is immediately listed in the viewpoints table where you can rename 
it to something meaningful right away. 

You can also add a viewpoint from the scenario’s viewpoints table, by positioning the 
eyepoint to where you want to set the viewpoint, and then navigate to the scenario’s 
viewpoints table.  

Access the viewpoints table by double-clicking Viewpoints either on the navigation bar or on 
the list of viewpoints on the panel to the left of the 3D scene as shown: 
 

 
Then, do one of the following: 

• Click the leftmost button located above the viewpoints table.  
 

 
 

• Right-click anywhere in the viewpoints table, and from the context menu, choose Add 
New Viewpoint. 

The new viewpoint is given an automatically generated name of “Viewpoint n” where “n” 
reflects the sequential number of the new viewpoint.  

All three ways of adding a viewpoint add a new row to the table for the new viewpoint of the 
current view in the 3D scene. (You can also add a new viewpoint directly in the table as 
shown in the example below.)  

In the viewpoints table, you can change the default name of the viewpoint to something more 
meaningful, edit other characteristics of the viewpoint, or delete the viewpoint. Options for 
renaming, changing the location of, and deleting (removing) viewpoints are available from 
the context (right-click) menu as shown in the following example:  

Buttons for adding 
new viewpoints. 
Click the leftmost 
button to add a 
new viewpoint of 
the current view. 

Click here to 
access a 
scenario’s 
viewpoints. 

Click here to 
access a scenario’s 
viewpoints. 
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The three buttons above the viewpoints table enable you to save a viewpoint relative to an 
entity to which you are attached, or to move the eyepoint to a location (teleport) at 
coordinates you specify so you can add a viewpoint with precision. 

 
Click the plus sign (+) next to the viewpoint entry in the table to display and edit details about 
the viewpoint. To delete a viewpoint, highlight the viewpoint in the viewpoints table and 
press the Delete key.  

To set a viewpoint at a precise set of coordinates, click the Viewpoint Teleport button (the 
rightmost of the three viewpoint buttons). When the following dialog box appears, set the 
coordinate system latitude/longitude of the intended location and click OK.  

Editable details 
about a viewpoint. 

Right-click menu for 
editing or deleting a 
viewpoint or adding 
a new viewpoint 
entry. 

Table of viewpoints 
that have been set 
(Or imported from 
a viewpoints file) 
for a project or 
scenario. 
 

Adds a new 
viewpoint of the 
current view. 
 

Teleports to the location of 
coordinates that you specify. 

Adds a new viewpoint 
relative to an entity 
you have selected. 
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In the Coordinate System drop-down menu, select an input coordinate system. Supported 
coordinate systems include standard inputs in Lat/Long, UTM, MGRS, or Geodetic 
coordinates. The Internal Database option enables you to enter a location in Geocentric 
coordinates (VRSG round-earth terrain format).   

You can also move the eyepoint to the center of a VRSG terrain tile. Select MDS Tile as the 
Coordinate System, and then in the Location field enter the name of the terrain tile (.MDS 
file); the tile must be located in a directory listed in the Scenario Editor’s Search Path tab. 

 
When you click OK, the view of the 3D scene changes to display the center of the terrain tile 
you specified. 

Note: An easy way to obtain the coordinates, especially if you just need to obtain the 
elevation coordinate, is from Google Earth. 

Like VRSG, Scenario Editor displays a water texture in areas for which it cannot find terrain 
coverage. If the coordinates you enter in the Teleport dialog box result in the water texture 
appearing instead of the terrain you expected, check that the coordinates you entered are 
valid. Also check whether the directory paths of the terrain tiles you expect to appear are 
listed in Scenario Editor’s search path.   

To help identify a particular location of interest, click that area in the startup globe. The 
coordinates of the area you clicked will appear in the text field above the globe. The globe 
only displays tiles that Scenario Editor finds in its search paths.   

Playback controls 
The Playback tab, below the 3D scene, controls the playback of a scenario and displays a 
timeline for defining the activities of each behavior entity in a scenario. 

 Plays and pauses the 
scenario at normal speed. 

Select the 
coordinate system 
and then enter the 
exact coordinates, 
including elevation, 
for the new 
viewpoint. 

Select the VRSG 
(MDS) Tile option 
and then enter the 
name of the .mds 
file of the terrain 
tile, you want 
displayed in the 
3D scene. 
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Using the blue playback buttons, you can:  

• Play / Pause the scenario. 
• Play the scenario in slow-motion.  
• Fast-forward play the scenario. 

Repeatedly clicking the slow or fast playback buttons accumulates slower or faster playback. 
Clicking the play button returns the playback to normal speed.  

While the scenario plays, the current time slider advances to the right as time increments in 
the scenario. Click and drag the slider backward and forward to rewind or advance the current 
playback time. The entities in the scenario will move to the new time index accordingly. You 
can also just click anywhere on the time bar; the scenario’s current time shifts to that point. 

A quick way to turn on and off scenario playback is to press the spacebar on the keyboard. 
This shortcut for toggling playback is particularly useful when you display a scenario in full-
screen mode, where you cannot access the playback control buttons.  

The two controls in the top right area of the Playback tab above the timeline display the 
current scenario time and the total scenario duration. Both fields are editable. Editing the 
current time sets the scenario time to a new time position. Editing the total duration changes 
how long the scenario will run prior to ending and restarting. 

  

Slow motion 
control, which 
reduces the rate of 
scenario playback 
speed to 80% of 
current speed each 
time you click it. 

Fast forward control, which 
accelerates the rate of 
scenario playback to 125% of 
current speed. 
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Timeline for entities and viewpoints 
The timeline is where you schedule time-based viewpoints and the activities of behavior 
entities and effects in a scenario. Whether viewpoints or behavior entities are displayed in the 
timeline depends on the scenario component (behavior entity, effect, or viewpoint) that is 
selected in the workspace.  

For the currently selected behavior entity, the timeline displays its activities in time segments 
of speed (velocity of the entity’s action for a given period of time), BVH animations 
performed by a character entity for a given period of time, and appearance (typical DIS 
appearance options and custom appearance options). 

 
If the viewpoints table is displayed, the timeline will display the viewpoints, as shown in the 
above example.  

The rightmost control above the timeline (checkbox) is a toggle for turning on and off playing 
the scenario’s time-based viewpoints. This control is useful for turning off the viewpoints 
while you are editing a scenario, so that the view you are working with remains static while 
you iteratively edit and play back a scenario. 

Current time slider at the current time 
position of the scenario; drag to the left 
or right on the time bar to change the 
current playback time in the scenario. 

Total duration of 
the scenario. 

Current elapsed time 
of scenario playback. 

If a behavior entity is 
selected, the behavior 
entity table is 
displayed (on the left) 
and the timeline of 
the selected behavior 
entity will also be 
displayed (below). 

For turning on/off 
the viewpoints 
script. 
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Status 
The status tab below the 3D scene provides text feedback. This feedback includes reporting 
on normal operations and any problems that Scenario Editor encounters. 

 
The Status tab, which is not normally displayed as the frontmost tab, is displayed in front 
automatically whenever Scenario Editor encounters a problem. This way you are alerted 
immediately to any issue that requires your attention.  

Status is also reported in a more detailed manner in the log files located in 
\MVRsimulation\Scenario Editor\logs. In particular, the error.log captures any issue 
encountered during the playback of a scenario.  

For example, like VRSG, if Scenario Editor cannot find a model file for an entity in the 
search path, it displays a rainbow-colored sphere or “beach ball” model in its place. The error 
text of the missing model will be displayed on the Status tab and in the error log. Missing 
models depicted as beach balls are typically due to the model file not being located in the 
Scenario Editor search path. To resolve the missing model, restart Scenario Editor and add the 
directory that contains the model to the Search Path tab so that Scenario Editor can find the 
model. 

 
You can copy text from the status area or the .log files and paste the text in other applications, 
such as email. Doing so is useful for troubleshooting, and for reporting an issue in an email to 
MVRsimulation support. When reporting such an issue to MVRsimulation support, attach the 
Scenario Editor .log files to your email message.   

Multi-colored sphere 
or “beach ball” 
model, which 
indicates a model 
that Scenario Editor 
cannot find for an 
entity in its search 
path. 
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Saving a scenario 
To save a new scenario or your edits to an existing scenario, choose File > Save. 

This saves all edits you have made to the scenario project. 

To save the scenario project under a different name, choose File > Save As and provide the 
new scenario name. 

During an editing session Scenario Editor automatically saves changes to a backup file 
(bkup_ <project-name>); it auto-saves most changes once a minute during active editing. The 
backup file is deleted once you save the scenario project and exit from Scenario Editor.  

Use this backup file in the event you experience some sort of system or application failure. 
You can recover most of your recent work by opening the bkup_<project-name> project and 
then saving the project under a different name, using File > Save As.  



 

 

C H A P T E R  3  

Tutorial 

This tutorial shows how to get started in VRSG Scenario Editor to create a scenario. Using 
the Kismayo, Somalia, terrain that is delivered with VRSG, this self-paced tutorial covers the 
basic activities to get you productive quickly. Details on the activities described in this 
tutorial are explained fully in other parts of this user’s guide. 

In this tutorial, you will work with the Kismayo Tutorial scenario project that is delivered 
with VRSG. (A description of how to create a brand new project can be found in the next 
chapter “Creating and Editing Scenarios.”)  

This tutorial assumes you will be working through the steps on a system that has both 
Scenario Editor version 2.3 and VRSG version 7 installed. 

Getting started 
To start the tutorial. 

1. Start Scenario Editor by clicking the Scenario Editor icon in the Windows Start menu. 

2. In the left panel of the Scenario Editor workspace, double-click the Kismayo Tutorial 
project to open it.  

 

List of available 
scenario 
projects.Click the 
Kismayo Tutorial 
project. 

List of the 
directory of 
terrain and 
models for the 
scenario projects 
above. 
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It will take a couple of minutes to load this scenario project, which has a great deal of content. 
Once it has loaded, the scenario appears in the workspace. 

Accessing parts of a scenario project 
A VRSG scenario project is comprised of different elements or parts, such as viewpoints, and 
cultural and behavior entities. You can access these elements by clicking on the navigational 
bar, or breadcrumbs, at the top of the Scenario Editor workspace. Click an element closer to 
the project (far left) to go up a level in the project. Select an element further to the right to 
navigate down in the level. You can also navigate by clicking an item on the list to the left of 
the 3D scene.  

Moving around the 3D scene 
You can move around the 3D scene by dragging the scene with the cursor. 

Information about 
the current context 
displayed in the 3D 
scene, in this case 
behavior entities. 

Feature palettes. Timeline. 

3D scene, scenario 
playback. 

Scenario playback 
buttons. 

Click to go to one 
of these scenario 
elements. 

Draggable 
boundaries between 
(all) workspace 
elements to 
increase/decrease 
viewable area. 

Splitter. 
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1. Right-click and drag the cursor forward and backward or roll the mouse scroll wheel
(also called the “middle mouse button”) to zoom in and out of the scene.

2. Click and drag in the 3D scene to pan the scene. Alt-click and drag to tilt or orbit.

Like VRSG, you can display the 3D scene in wireframe mode and cycle the scene’s sensor 
modes. 

• Press the “I” key on the keyboard to display the scene in wireframe mode. (Press “I”
again to restore the normal textured view.)

• Press the “O” key on the keyboard to cycle through the sensor modes.

Also, like VRSG, you can display onscreen help for keyboard shortcuts. Press F1 to display 
onscreen help about the keyboard shortcuts you can use in Scenario Editor. 

Using the search function and gallery view in feature 
palettes 

By default, the Scenario Editor feature palettes contain all the models from MVRsimulation’s 
substantial 3D model libraries and over 300 effects, all of which can be accessed through the 
feature palettes. You can filter the list of models or effects displayed in the feature palettes by 
typing a model name or a partial name into the search box above the palettes. 
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1. Click the Behavior tab to make it the active tab. Type “human” in the search box. A list
of models is filtered to contain only models with names that contain “human.”

2. Now that you have a list of human character models, move the slider to increase or
decrease the size of the thumbnail images in the list.

3. Switch from the view with small images and model name to gallery view by clicking the
gallery view button, and again move the slider to increase or decrease the size of the
thumbnail images. Gallery view shows only the thumbnail images. Hover the cursor over
a thumbnail image to display a tooltip that shows the model’s location.

Search field; type a 
word or partial 
word to filter the 
models that are 
displayed in the 
palette. 

Slider to increase / 
decrease the size of 
model thumbnail 
images. 

Gallery view button. 

Tabs of the three feature 
palettes. 

Gallery view button. 

Be sure to clear the Search text 
box when you are finished with 
the search results, to redisplay 
the entire palette of available 
models. 
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An easy way to see all the models in MVRsimulation’s model libraries is on the company 
website at: www.mvrsimulation.com/3DContent/ModelsHome.shtml 

Adding static culture to the scene 
The primary way to add a cultural entity to the 3D scene is by dragging a building model 
from the culture palette and dropping it on the terrain. 

1. Click the Culture tab to display the cultural features palette. (Optionally search for
“kismayo” in the Culture tab to display just Kismayo buildings.) Click and drag a model,
such as a building model, from the palette and drop it somewhere on the 3D scene. This
action creates a cultural entity.

2. Unselect the entity, by pressing the Esc key on the keyboard.

3. Double-click the entity to select it again. Drag the entity to move it.

4. Drag on the entity’s orientation tool (the yellow hoop) to rotate it.
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5. Notice the culture table on the left displays information about the selected entity. (Drag
the splitter to make more of the table visible.)

The table to the left of the 3D scene displays information about the entities in the scene. The 
table highlights the selected item if one is selected. Edits you make to an entity in the 3D 
scene, such as moving it, updates the table. The reverse is also true. If you edit a field in the 
table, such as changing the scale of an entity or assigning a weapon to a character entity, 
those changes will be reflected in the 3D scene. 

1. Click the small plus-sign (+) at the beginning of the row to display more information
about the entity, in this case kismayo-building-0211.

2. Change the value in the table’s Scale column to .5 to reduce the size of the building
entity, and then press the Enter key. Notice the change in the size of the entity.

3. Restore the entity to its original scale, by pressing Ctrl-Z on the keyboard (or choose
Edit > Undo). Unselect the entity by pressing the Esc key.

Sometimes you might want to raise an entity off the ground, for stacking, placement on a 
roof, or another placement requirement. 

Click the plus 
sign (+) to 
expand the 
information 
displayed about 
a selected 
entity. 

Change the scale 
of the entity. 

Drag the splitter to the 
right to display more 
of the table. 
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To raise an entity off the ground: 

2. On the context menu, change the default Height: Ground option to Height: Elevation.

3. When the vertical blue arrow appears thru the model, drag the blue arrow to raise the
building off the ground.

4. Press Ctrl-Z to restore the model’s position on the ground.

5. Right-click and restore the context menu option Height: Ground setting. (Note that Ctrl-Z
does not restore options set on the context menu.)

6. Unselect the model by pressing the Esc key.

1. Select the entity you just created and right-click on it to display the context menu.



3−8    MVRsimulation Scenario Editor User’s Guide 

Creating dense culture rapidly 
You can duplicate a single cultural entity or a selection of multiple cultural entities by using 
by copying and pasting them, as in the following steps, or by using Duplicate mode. 
(Duplicate mode is described in the chapter “Creating and Manipulating Entities.”)  

2. While this grouping is selected, press Ctrl-C to copy them.

4. Repeat step 3 one or two more times to create additional duplicates. As you did earlier,
click the hoop to rotate a grouping or drag the group to refine its location. If you change
your mind about a paste action, press Ctrl-Z to undo the paste, or just press the Delete
key to delete the currently selected grouping.

5. When you are finished, press Esc to unselect the last copy you placed.

1. Select a few adjacent cultural entities, by pressing and holding down the Shift key
and dragging the  cursor across the adjacent items. Making multiple selections like
this works best if you are looking at a top-down view of the scene..

3. Click on the terrain where there is an open space on which to paste the grouped
entities, and then press Ctrl-V to paste them. Notice that the pasted duplicate becomes
the selected grouping with the yellow bounding box and tools.

The selection becomes highlighted with a yellow wireframe bounding box surrounded 
by an orientation hoop with a blue elevation arrow in the center.
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Adding behavior entities to the scene 
Scenarios typically have moving vehicles and characters (behavior entities) doing one or 
more activities of some kind. These scripted activities take place along the behavior entity’s 
path of travel, and this path is made up of two or more waypoints joined by a ribbon.  

1. Click the Behaviors tab on the feature palettes to make the Behaviors palette active, and
then click and drag a character model into the scene. As soon as you drop the behavior
model onto the scene, it becomes an entity, with a waypoint in front of it to start its path.

2. A message appears immediately, with the DIS entry for this entity that will be added to
your scenario’s ModelMap.ini file. Ensure the DIS kind and domain are appropriate for
the entity. (In this case, Lifeform and Land are appropriate for a character.)

3. Click OK to accept the default ModelMap entry for the entity. Notice the character’s
built-in waypoint path (blue ribbon) formed by two waypoints. If the model you dragged
to the scene faces away from the direction you want it to face, grab the waypoint in front
of the character and drag/rotate it to the direction you want the character to face.

4. Drag the end waypoint some distance away from the character and stop.

5. Add a few more waypoints to the path in between the character and that farthest
waypoint. Add a waypoint by clicking and holding on the path or right-clicking on the
path to display the context menu, and then choosing Insert Position Waypoint.
Generally, waypoints handle any change in the path, a shift or change in travel direction,
a change in entity elevation or orientation, and other changes.

Always make sure 
the Kind and 
Domain are 
appropriate for 
the entity you are 
placing. 
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6. Click and drag a waypoint to move it.

7. Deselect the character.

Notice that anywhere your cursor hovers on the path, an orange marker appears, along with 
pop-up information about the entity when it crosses that location (scenario time, travel speed, 
and orientation). 

By default, the path of a behavior entity is an open linear path. You can make the path a 
closed-loop to have a vehicle or character circle around a city block, a building, or travel in 
some other repetitive path. 

1. Select the character entity you just worked with, and zoom out to a bird’s eye view of the
scene so you can see the whole path.

2. Right-click on the last (end) waypoint of the path, and then from the menu choose Toggle
Loop.

Right-click the end 
waypoint to display 
the context menu, 
and then choose 
Toggle Loop.  
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The path now extends beyond the end waypoint and snaps to join the position of the first 
waypoint, creating a closed loop. 

3. The loop might not be useful at first; add waypoints and drag them to have the looped
path encircle something meaningful. If necessary, move up close to the path as you refine
the loop and drag it away from any structure or object it might be going through.

Attaching a weapon to a character 
Character entities can hold weapons and other items. All items in the feature palettes that 
characters can hold have model names that are prefixed with “weapon-”.  
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1. Identify a character you want to hold a weapon: a character entity already in the Kismayo
Tutorial scenario, or a character entity you create by dragging a character model from the
behavior feature palette to the 3D terrain.

2. Locate a weapon model in the behavior feature palette. Click and drag a weapon model
from the palette to the 3D scene, and drop it on the character entity.

The weapon snaps to the character. When you play it back it will assume the default deployed 
position, as shown in the next image.  

Alternatively, you can attach a weapon to a character or change a character’s weapon by 
selecting the weapon from the weapon column of the behavior table, in the row of the 
selected character. 
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Again, the character won’t hold the weapon in a deployed position until you play it back for a 
few seconds. 

As described in the chapter “Creating and Editing Scenarios” you can script the character’s 
appearance to have the weapon stowed, deployed, or firing. And you can set the character’s 
pose appearance to control whether it is walking, kneeling, or prone. 

Attaching a character to a vehicle entity 
You can attach one or more characters to a vehicle such that they are seated in the vehicle as a 
driver, passenger, and in some cases, a gunner. Only some vehicles, those which have 
associated character animations in this release of Scenario Editor accept attached characters.  

1. Drag the vehicle model Technical-005.DHSK.OPFOR from the Behavior feature palette
and drop it somewhere on the terrain. (In the feature palette, type the search term, type
the search term “technical” or just “tech” in the search area to locate the model easily.)

4. Next, click and drag a character model from the behavior feature palette to the scene and
drop it onto the vehicle. (In the feature palette, type the search term “human” or just
“hum” in the search area to locate the model easily.) When you drop the character on the
vehicle, the character automatically assumes the driver position inside the vehicle.

2. Once again the ModelMap Editor dialog box will appear, this time with the DIS Kind
field showing as “Platform” and the Domain Field as “Land” to denote a ground vehicle.
Click OK.

3. When the vehicle entity appears on the terrain, optionally adjust its location if necessary.
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5. Drag two more characters to the vehicle. The characters will automatically assume
positions as passenger and gunner. (As this entity is a technical vehicle, it automatically
places the third dragged character in the gunner position.)

Adding an effect to the scene 
Scenario Editor offers several types of effects that you can add to a scenario: smoke plumes, 
dust puffs and trails, flames, and so on. 

1. Click the Effects tab on the feature palette.

2. Click and drag an explosion effect onto the 3D scene where you want the explosion to go
off. The yellow dome represents the effect while a scenario playback is paused.

3. In the entry for this effect in the Effects table, enter 5 seconds in the Time column for this
effect (the first column) to have this explosion go off 5 seconds into the scenario.
The explosion effect will be activated 5 seconds into the scenario playback.

Enter the start 
time for the 
explosion event. 
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4. Save your edits to the scenario by choosing File > Save As and give the scenario a
different name, such as MyKismayoTutorial. This action saves the scenario files in \
MVRsimulation \Scenario Editor\Scenarios.

Editors in the timeline 
The scenario timeline, which is located on the Playback tab under the 3D scene, displays the 
activities of the currently selected entity in time segments of: 

• Speed (velocity of the entity’s action for a given period of time).

• BVH animations performed by a character entity for a given period of time.

• Appearance (typical DIS appearance options and custom appearance options).

Editing an entity’s speed 
You can control the speed at which a character or vehicle moves along its path by setting 
speed segments in the Speed Editor. Because behavior entities can carry out activities at 
different speeds during a scenario, the speed of each activity is controlled by a different entry 
in the Speed Editor and in different speed segments in the timeline.  

1. Either select a character entity you already added to the scenario or drag a character
model from the behavior feature palette and drop it somewhere on the terrain.

2. If you have created a new character entity: drag the waypoint away from the character
some distance to create enough of a path to work with some walking/running speed. (The
example in these steps uses the character that walked in a loop earlier in the tutorial.)

3. With the character entity selected, double-click any cell in the Speed row of the timeline
to display the Speed Editor. Notice the Speed Editor already has a row; it contains the
default walking speed of the character.

Drag the splitter upward to see 
more of the timeline. 
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4. Click Add Row.

To create a change in the speed of the character, you add a new row with the start time of the 
new speed (in full seconds or fraction) and speed. Edit the new row, highlighted in blue, by 
deleting the placeholder value in that row and replace it with a Start Time of 8 seconds and a 
Speed of 3 (meters per second). 

5. Add a few more rows in the Speed Editor, and have the character speed up so that he jogs
for a few seconds, and then slows down.

In the Speed 
Editor, enter the 
start time(s) and 
the speed you 
want the entity to 
travel. 

Click a segment in 
the timeline to display 
the Speed Editor. 

During a transition for increased or decreased speed, the entity’s speed changes incrementally 
to accelerate or decelerate. As you accelerate this character’s speed his default walking state 
will transition into a quicker pace and then into a jog.
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6. Playback the scenario so you can see the character’s movement. Notice when the
character’s speed increases, the path color changes, denoting the increase and the later
decrease in speed.

7. Optionally, do one of the following:

- Add a pair of time entries with zeroes for start time and end time to have the entity
stand stationary for that time period. For example, you could have the character stand
stationary upon completing traveling the loop.

- Make the character’s walking loop repeat throughout the scenario, by right-clicking on a
waypoint and choosing Toggle Time Loop (it might already be selected by default).

Editing an entity’s appearance 
An entity’s appearance can be a pose, weapon deployment, or a state (such as a destroyed 
state). Certain vehicle and character entities have their own custom appearance bits that 
control a specific appearance.  

You set up the appearance changes for a vehicle or character in the Appearance Editor. Like 
the Speed Editor, each row in the Appearance Editor starts playing the entity’s appearance at 
a particular time in the scenario.  

Information 
displayed about the 
current position 
(orange marker) 
where the pointer is 
located along the 
entity’s path. 
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1. From the Behaviors feature palette, select the Hilux.ISIS.black vehicle model and drag it
to a location on the 3D terrain.

2. In the timeline for this entity on the Playback tab, double-click any cell in the Appearance
Row to display the Appearance Editor.

3. Select a Door checkbox to change the appearance setting for a vehicle door so that it
opens. (The example selects Driver Door/Bomb Door.) Click Add Row and enter 10
seconds for the Start Time and again select the same Door appearance checkbox.

4. Click OK. Notice the vehicle’s door is now open.

5. Double-click in the Appearance row of the timeline again to redisplay the Appearance
Editor. Click Add Row.

6. Enter 20 seconds as the Start Time, and unselect the Door checkbox. Click OK.

Double-click in the 
Appearance row in 
the time-line to 
display the 
Appearance Editor. 

Select a Door checkbox to change a 
door’s appearance from closed to open. 

Click to add a new row in the 
Appearance Editor for this entity. 
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7. Replay the scenario (for at least those few seconds), which now opens the vehicle’s door
at 10 seconds into the scenario, and then closes it at 20 seconds.

Editing a character entity’s animation 

You specify the animation(s) of a character and the start time in the Animation Editor in a 
manner similar to the other editors you used earlier. 

By default, character behavior entities are animated in Scenario Editor with velocity-
based DIS default animations. These walking, running, and standing still animations 
depend on the speed setting, as you saw earlier in this tutorial. This default animation is 
labeled in a character’s timeline as AUTOMATIC. For most cases you want Scenario 
Editor to automatically animate a character entity using built-in rules that take into 
account the character’s velocity, weapon, and appearance. But if you need a particular 
custom animation, you can assign to the character one or more BVH animations. Scenario 
Editor uses over 1,000 BVH character animations that are delivered with VRSG.
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1. Either select a character entity in the scenario or drag a character model from the
behavior palette and drop it somewhere on the terrain.

2. Double-click any cell in the BVH row in the timeline on the Playback tab.

3. In the Animation Editor, click Add Row and choose a seated animation from the drop-
down menu in the animation column. You can start typing “Seat” to get to the list of
seated animations.

4. Enter a Start Time in seconds (integer or decimal value).

5. Click Add Row again.

6. Enter a Start Time, such as 15 seconds, and choose AUTOMATIC to reinstate the default
walking animation after the character has been seated for a while.

7. Playback the resulting animation sequence.

Adding viewpoints 
You can add viewpoints at any time and then edit them in the viewpoints table.  

Select an animation 
from the drop-down 
menu. (If you hover 
over this cell, the 
down-arrow appears, 
which indicates this 
cell has a menu.) 

Double-click in 
the BVH row to 
display the 
Animation 
Editor. 
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The simplest way to add a viewpoint is to position the eyepoint in the 3D scene to where you 
want to set the viewpoint, and then press the S key on the keyboard.  

1. Navigate to the scenario’s viewpoints table, by double-clicking Viewpoints either on the
navigation bar or on the list of viewpoints on the panel to the left of the 3D scene.

2. In the viewpoints table, add a new viewpoint of the current view in the 3D scene by
clicking the Add Viewpoint button above the viewpoints table, or pressing the S key on
the keyboard.

3. Click in the viewpoint name cell, and rename the viewpoint with a meaningful name,
such as Tutorial-1.

 

By default the view is static and clicking it manually automatically switches the view in the 
3D scene.  

Click here to 
access a 
scenario’s 
viewpoints table. 

Click here to access a 
scenario’s viewpoints 
table. 

Click the leftmost button to add a 
new viewpoint of the current view. 

The new viewpoint, with default name, is added to 
the bottom of the table. 
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To make the viewpoint time-based in the scenario so that the scene switches to that view like 
a camera at a specific time, you add it to the timeline via the Viewpoint Editor:  

1. Open the Viewpoint Editor by double-clicking anywhere in the Cameras row of the
timeline.

 

2. Editing a scenario while viewpoints are playing can be inconvenient since the camera
(eyepoint) will keep shifting. To disable the viewpoints from controlling the current
eyepoint of the 3D scene while you are editing the scenario, unselect the “Play Viewpoint
Script” checkbox above the timeline (on the right).

3. Like the other timeline editors, you used earlier in this tutorial, click the Add Row button,
enter the Start Time (in seconds) and then select the viewpoint you just created from the
drop-down list in the Viewpoint column. This list is taken from the viewpoints table. The
start time sets the time the camera switches from the previous viewpoint to the one you
have set.

4. Click Add Row again and have the scenario switch from your viewpoint to another
viewpoint you choose from the drop-down list several seconds later.

Before you edit a scenario, unselect the Play 
Viewpoint checkbox to prevent the viewpoints script 
from controlling what is currently displayed in the 

  

Double-click anywhere in the 
Cameras row in the timeline to 
display the Viewpoint Editor. 
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5. Click the Play Viewpoint Script checkbox again. Preview the switching to your
viewpoint and then away from it by playing back that segment.

Playing the scenario 
The Playback tab, below the 3D scene, controls the playback of a scenario and displays a 
timeline for viewpoints, effects, and each behavior entity in the scenario. 

1. Click the blue playback buttons to:
• Play / Pause the scenario.

• Play the scenario in slow-motion.

• Fast-forward the scenario playback.

Repeatedly clicking the slow or fast playback buttons results in slower or faster playback. 
Clicking the Play button returns the scenario playback to normal speed. While the scenario 
plays, the current time marker advances to the right. 

 

2. Click and drag the time marker backward and forward to rewind or advance the current
playback time. Notice the entities in the scene move to the new time index accordingly.
You can also turn on and off scenario playback by just pressing the spacebar on the
keyboard.

Elapsed time (in 
seconds). 

Duration of 
the scenario. 

Fast forward 
playback. 

Slow motion 
playback. 

Play/pause. Current time 
marker. 
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The current elapsed time and the duration of the scenario are displayed in two editable fields 
to the right of the playback controls and the time bar.  

Another way of advancing or going back to a specific time in the scenario is to type the 
specific time (in seconds) in the elapsed time field. The duration field is also editable; to 
change the total duration of the scenario, type a new duration (in seconds). 

Setting environment details 
The Dashboard is where you specify display properties, environmental conditions, sensor 
views, screen capture parameters, and network options for broadcasting Scenario Editor on a 
network. The features on the Scenario Editor Dashboard panels match many of the features 
also found on the VRSG Dashboard. These settings can optionally be saved with a scenario to 
take effect when the scenario is played in VRSG. 

Click a plus-sign (+) next to each panel heading to expand the panel settings. 

The Sensor panel lists characteristics of the sensor-mode display, such as the spectrum, 
amount of noise or blur, the level of intensity of the terrain or entities, and zoom level. If you 
save these settings when you export the scenario for VRSG playback, these sensor options 
will take effect for the scenario immediately and in VRSG if the sensor mode is enabled in 
VRSG.  

1. From the Spectrum list, choose IR White Hot or one of the other options. (The Visual
option is the default full color/textured scene.)

2. If the IR Configuration is not set to Kismayo, set it now.
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3. Try out some of the settings that mimic sensors by moving their sliders, such as Focus,
Gain, and Digital Zoom.

4. Choose the Visual spectrum option to restore the normal view of the 3D scene.

Playing back the scenario in VRSG 
You can run scenarios in VRSG in two different ways: 

• Run a scenario as a PDU log in VRSG.

• Have Scenario Editor send scenario data as a live DIS exercise host on the network.

In both cases, you need to first export the scenario from Scenario Editor.

In this tutorial, you will export the scenario, launch VRSG, and playback the scenario’s PDU 
log from the Scenarios tab on the VRSG Dashboard.  

During the export operation, Scenario Editor combines all the PDU logs of the behavior 
entities and effects into one vrsg.pdulog, saves the DIS settings, and bundles them with the 
scenario’s vrsg.clt, viewpoints, and modelmap.ini files into one folder from which VRSG can 
render the scenario during playback.  

1. Choose File > Export > Export PDU Logs to VRSG.

2. When the Browse for Folder dialog box appears, browse for the directory
\MVRsimulation\VRSG\Terrain\Somalia\Kismayo\Scenarios. This directory is where
your scenario will be exported to. (Depending on whether this is your first time exporting
a scenario from Scenario Editor, the Browse dialog box might already be set to export the
scenario to that directory.) Click OK. As the Kismayo scenario is quite large with a lot of
entities, it will take some time to export it.

3. When the Export operation has completed, exit from Scenario Editor. Although you can
export your scenario to any directory you like, when you start VRSG be sure to add the
directory to VRSG’s search path.
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4. Launch VRSG from the Windows Start menu or however you normally start VRSG.  
 

 
 
 
 

5. In the Folders for Terrain, Models, Scenarios, and Other Content section, click Add and 
add the path to the parent directory of the directory in which your exported scenario 
resides. For example, specify C:\MVRsimulation\VRSG\Scenarios if your exported 
scenario is located in C:\MVRsimulation\VRSG\Scenarios\MyKismayoTutorial. 
 

If you do not have the directory for the sample Kismayo terrain that is delivered with 
VRSG in your VRSG search path, add that directory path as well; For example: 
C:\MVRsimulation\VRSG\Terrain\Somalia\Kismayo.  

6. Click the Start VRSG button. Once VRSG has loaded the Kismayo terrain tiles and the 
culture from the vrsg.clt in your scenario’s directory, click the Scenarios tab on the 
VRSG Dashboard. 

7. Locate your scenario in the list of scenarios and click Play. By default, your scenario will 
play through and repeat. Notice that you can launch Scenario Editor directly from this tab 
on the VRSG Dashboard. This shortcut is handy if, during playback in VRSG, you see 
something in your scenario that you want to change immediately. 

 

Add to VRSG’s 
search path the 
parent directory of 
where your scenario 
is located 
(which in this case 
is the \Scenarios 
directory). 

Click here to open the More Startup 
Parameters dialog box. 
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C H A P T E R  4

Creating and Manipulating Entities 

In Scenario Editor you work with culture and behavior entities placed on the 3D terrain. You 
create cultural entities as instances of static models (of trees, buildings, fences, and so on) 
placed on the terrain and use tools to refine their orientation, scale, appearance, and altitude or 
ground clamping. 

Similarly, you create behavior entities with instances of moving models of vehicles or 
characters. You position them on the terrain with tools that add and refine waypoints along a 
path of movement, control their scale, speed, and appearance, and in the case of characters, 
add animations and weapon fire.  

Use the search function in Scenario Editor’s feature palettes to locate the types of culture or 
behavior models you need and switch on the gallery view so you can see large thumbnail 
images of the models you can choose from. An easy way to become familiar with the breadth 
of models in MVRsimulation’s model libraries, sorted by category, is to see them on 
MVRsimulation’s website at www. mvrsimulation.com/3DContent/ModelsHome.shtml. 

There is no physics-simulated collision when you place culture or behavior entities in the 3D 
scene. This means that entities will overlap if you place them that way. Entities that are 
unintentionally overlapped can be easily adjusted. 

Cultural entities 
Cultural entities are static entities positioned on the 3D terrain – such as buildings and other 
structures, trees, signs, street elements. They can also be stationary characters or parked 
vehicles.  

To build up culture on the terrain, you can use models from MVRsimulation’s extensive 3D 
content libraries or your own models that have been converted from FBX or FLT format to 
MVRsimulation’s model format with the conversion utilities that are delivered with VRSG.  

Information about cultural entities is saved in the scenario’s cultural feature file, called 
vrsg.clt. This ASCII text file contains information about the model used for each entity, its 
location and orientation, and other attributes (like its scale or appearance state). For stationary 
characters, the vrsg.clt can specify a stationary animation, like kneeling or sitting. At the time 
of scenario creation, you can import multiple cultural feature files of culture (such as dense 
areas of trees or buildings) shared with other scenarios. You can also copy and paste portions 
of legacy culture feature files to the scenario currently opened in Scenario Editor, as 
described in the chapter “Creating Scenarios.” 

Note: The cultural feature files delivered with the sample scenarios are located in the scenario 
subdirectories in: \MVRsimulation\VRSG\Terrain\*\Scenarios. 
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As you add cultural entities to your 3D scene, you can: 

• Use tools to refine entity placement: orient, scale, and set the elevation or ground clamp.

• Select multiple cultural entities to move, duplicate, or refine orientation at once as a
group.

• Duplicate an entity easily to quickly build up dense areas such as a city block or a forest.

• Control an entity’s appearance, including standard DIS states such as damaged and
destroyed, and model-specific states such as optional armaments and munitions,
headlights, and hatches.

• Add a weapon or accessory (like a shovel) to a static character entity.

You can add, refine the placement of, and remove culture from the scene either directly in the 
3D scene or in the culture table to the left of the 3D scene. (This means that editing cultural 
features listed in the table will update the 3D scene, and vice versa.) For example, you could 
enter the x, y, z coordinates in the table to position a culture item or could select a culture 
model from the content palette and drag the model directly to the scene or move an entity 
within the scene.  

To navigate to a cultural entity in the 3D scene, click anywhere in its entry in the culture 
table. (Setting up viewpoints to quickly navigate to areas on the terrain is discussed later in 
this chapter.) 

Drag a model from the feature 
palette (in this case picnic-
004) to the 3D scene.

Because this table is 
a cultural entity, it 
appears with an 
orientation tool 
(yellow disk). 

The new cultural 
entity appears in the 
culture table.  
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To move an entity or otherwise refine its placement on the terrain, double-click the entity to 
select it, and then drag it to a new location or adjust its position. To unselect the entity, press 
the Esc key on the keyboard (or select another entity). 

To delete an entity, select it in the 3D scene or select its row in the culture table and press the 
Delete key on the keyboard. Alternatively, select the entity in the 3D scene, choose  
Edit > Cut or right-click to display the context menu, and choose Delete Entity.  

As described later in this section, you can select multiple cultural entities at once, to move, 
rotate, duplicate, or delete them as a grouping. 

 

Click the plus sign (+) next to the entry for an entity in the culture table to display more 
details about a given entity. You can edit this information to change details such as its scale or 
appearance. Cells in the culture table (and in other Scenario Editor tables) that are colored 
grey are not editable; white cells are editable.  

Some editable cells contain a drop-down menu of available values. Editing the cell, or 
hovering the cursor over the cell, displays a down-arrow icon, which indicates that a drop-
down menu for that cell is available, as shown in this next example: 

Editable details 
about the selected 
entity, such as its 
scale factor or an 
assigned animation 
file. 
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You can swap out the model that is assigned to a cultural entity. For example, you can change 
a building to another building model, or a building to a tree model. The entity type must be a 
cultural entity; if you change a tree to a truck, the truck will still be a cultural entity.  

In VRSG the model appearance is set with a hex bitmask. In Scenario Editor, the bitmask is 
set in the appearance. As shown in the culture table above, Flames, Smoking, and Destroyed 
are typical appearance options. These options are described in the chapter “Creating and 
Editing Scenarios.” 

To locate an entity and select it in the scene, click the entity in the culture table. In the table, 
right-click an entity to display its context menu. This menu has several orientation and 
elevation options. 

Drop-down menu of 
available animations 
for this static 
character entity. 

A character can be either a static or 
behavior entity. In this example, the 
character is a static entity, which can 
accept a weapon or accessory and a 
stationary animation. 

Other options, 
including 
appearance options, 
available for static 
entities. 
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Refining the orientation of cultural entities 
To refine the orientation of a selected cultural entity, click and drag the yellow disk-shaped 
orientation tool that surrounds the entity.  

To move an entity freely along two axes, right-click on the entity, and from the context menu, 
choose Orientation: Free, as shown in the next example: 

Click in this cell to 
go to this cultural 
entity in the scene. 

The table’s default 
sort order is the order 
in which the entities 
were added to the 
scenario. All tables in 
Scenario Editor can 
be sorted  
alphabetically or 
numerically by 
clicking the heading 
of the column you 
want to sort by. Details about the 

selected entity 
(chair-011). 

Orientation and 
elevation tools, two  
of several tools for 
manipulating culture 
(static) entities on the 
terrain. 
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In the example above, the Height: Elevation is also chosen to display the blue arrow to raise 
the model off the ground a bit to refine its placement. After you finish editing an entity, 
unselect the entity by pressing the Esc key (or select another entity to edit). 

If you are zoomed out to see a bird’s eye of a scene but need to edit the orientation of an 
entity that might be hard to see or move, move the Tool Scale slider at the top of the 
workspace to increase the scale of the tool. Tool Scale does not enlarge the entity itself, just 
the tool in use. 

The tool is also helpful while you are zoomed in and refining the placement of small culture 
on the ground. 

Elevating cultural entities 
You can unlock the default ground-clamping of entities in order to raise them above the 
ground. For cultural entities, this is useful for placing entities in stacks, or on a rooftop, 
watchtower, deck of a sea vessel, or any other kind of above-ground location. 

Drag the slider 
to increase the 
size of the tool 
(in this case, 
waypoints of an 
aircraft entity’s 
flight path. 
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To turn off the cultural entity’s ground-clamping: right-click on the entity to display its 
context menu, and then choose Height: Elevation (AGL). Turning off the entity’s ground-
clamp displays a vertical blue arrow running through the center of the entity, which you drag 
upward or downward to increase or decrease the entity’s elevation position. 

To raise the cultural entity above the ground, drag the blue arrow upward. Dragging vertically 
(upward or downward) will position the cultural entity with constant height. The entity can 
penetrate the ground, or be raised above the ground for stacking as shown in this next 
example: 

After editing the position of the entity, unselect it by pressing Esc. 

Working with ground-clamp turned off is also useful for making small adjustments in culture 
placement, for example, to resolve z-fighting.  

Drag the 
vertical blue 
arrow to raise 
the position of 
the cultural 
entity off the 
ground. 

From the right-
click menu, 
choose Height: 
Elevation (AGL) 
to unlock the 
ground-clamped 
position of the 
cultural entity. 
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Entities added from the feature palette can be placed on elevated structures. 

If you drag a culture model onto an elevated structure, it will first land on the ground. Extend 
its blue arrow upward to place the model on the structure, as shown in this example of placing 
a plastic crate model on a rooftop.  

Manipulating multiple cultural entities as a group 
All the examples described thus far show how to move and edit a single cultural entity. But 
you can perform the same actions on a selection of multiple entities. Scenario Editor will treat 
the selection as a temporary group. Selecting multiple cultural entities is similar to what you 
might be used to in other Windows applications. 

• To select multiple adjacent cultural entities, press and hold the Shift key and drag the
cursor across adjacent items you want to select.

• To select non-adjacent entities, press and hold the Ctrl key and click each entity to add to
the selection.

As shown in the examples below, the selection becomes highlighted with a yellow wireframe 
bounding box surrounded by an orientation hoop with a blue elevation arrow in the center. 

Press and hold the Ctrl key and click each entity to add to the selection. Do the same to 
remove items from the selection. You can make a more refined selection to temporarily 
grouped cultural entities, either adjacent or non-adjacent. 
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Note: Making a 2D selection in a 3D space works best if you position the eyepoint at a fairly 
top-down angle on the scene. 

Once you have made your selection of multiple entities, you can treat the selection as a 
temporary group and change the group’s orientation or elevation, move it, duplicate it, scale 
it, or delete it – manipulating it just as you would a single cultural entity. (Duplication is 
described later in this chapter.) 

To edit certain properties of multiple cultural entities while they are selected: 

1. Select the cultural entities to temporarily group them.

2. Right-click on the group and from the context menu select Edit Group Properties.

3. When the Group Properties Editor dialog box appears, change the grouped entities' scale
and/or z-axis orientation.

Move the sliders to change the scale of the largest, 
smallest or all selected entities. Optionally, 
randomize the scaling for a more natural look. 

Drag the dial to change the 
direction all selected entities face 
by rotating each. Optionally, 
randomize the yaw orientation. 
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To change the scale of the grouped entities: 

• Use the Scale sliders. The Smallest slider will scale the smallest entities. The largest
slider scales the largest entities. The All slider scales all selected entities (it moves all
sliders together). As you use the sliders, the selected entities change in scale. Set the Max
Scale value for the largest allowable scale value of the Largest slider.

• Optionally click Randomize Scale. This prevents all selected entities from scaling the
same percentage and is useful for creating a natural look of groups of trees, rocks, rubble,
and other geotypical culture.

With a grouped selection of cultural entities, you can rotate the grouping about the z-axis by 
dragging the yellow orientation hoop. But you can also rotate each entity in the group 
independently about its own z-axis. 

To change the yaw orientation of each selected entity: 

• Click and drag the Yaw dial to rotate each selected entity clockwise or counterclockwise.

• Optionally click Randomize Yaw to prevent all selected entities from potentially facing
the same direction. This is useful for creating a natural look of groups of trees, rocks,
rubble, and other geotypical culture.

Once you unselect this temporary group (by pressing Esc), the selection no longer exists. 

Entities that have been grouped can be duplicated as a group, as described later in this 
chapter. 

Behavior entities 
Behavior entities are dynamic moving entities that perform a scripted activity over time in a 
scenario. Behavior entities are typically vehicles, munitions, human characters, or animals. 
They are not automated forces or AI entities. The activity in a scenario plays like a movie, 
without responding to real-time events.  
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With behavior entities you can: 

• Create a scripted path of movement for vehicles and characters with waypoints speed and
duration.

• Assign DIS enumerations.

• Animate characters with over 1,000 character animations of common movements, or use
your own custom BVH.

• Assign appearances and weapons to characters.

The behavior entities have DIS enumerations and can perform scripted animations, traverse a 
path of waypoints, and change appearance (such as a vehicle’s damage state or a character 
carrying a weapon). Flames, Smoking, and Destroyed are typical appearance options for 
behavior entities. Other appearance options (such as headlights or open hatches) are specific 
to a given entity. Some entities have appearance states that are unique to an entity and are 
labeled “custom.” The effect of custom appearance bits depends on the particular model.  

Behavior entities do not react to DIS events. For example, they do not react to the DIS 
destroy or collision packet. They simply follow a scripted path of movement, and optionally 
perform some animated activity, for the duration of the scenario. As described later, an 
entity’s appearance can be edited to change at a specific point in time.   

In VRSG terms, behavior entities have corresponding DIS enumerations in the scenario’s 
associated ModelMap.ini file.   

You create a new behavior entity by selecting a model from the behavior model palette and 
dragging it to where you where want it on the 3D scene. The new entity is added to the scene 
and the behavior entity table on the left panel. Press the Esc key to unselect the entity. 

 

As soon as you drop the behavior model onto the scene, it becomes an entity, with a waypoint 
in front of it to start its path. A message appears immediately, with the DIS entry for this  

Drag the model from the behavior palette to the 
3D display and drop it on the terrain, roughly 
where you want to position it. 

A behavior entity is a dynamic model (character, vehicle) that 
performs some activity.  
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entity that will be added to your scenario’s ModelMap.ini file. Click OK to accept the default 
ModelMap entry for the entity, or change a field as needed. 

Recall from VRSG that the ModelMap.ini initialization file contains one mapping entry per 
line. The general syntax of a ModelMap.ini entry is: 
<DIS enumeration> <Model-class> <visual-model> [model load options…] 

The DIS enumeration is a 7 number identifier that collectively identifies a particular type of 
entity. The DIS terminology uses these labels for the 7 fields: 
Kind Domain Country Category Sub-Category Specific Extra 

If you add your own models (converted to MVRsimulation’s model format) to a scenario you 
will need to fill out this information in the Model Map Editor. This information will be stored 
in the file \MVRsimulation\Scenario Editor\Models\UserModelMap.ini. (You can add VRSG 
ModelMap options for an entity in Scenario Editor, as described in the chapter “Creating and 
Editing Scenarios.”) 

In the behaviors table to the left of the 3D scene, you can edit attributes of the entity such as 
its scale, or position coordinates, or appearance. Initially, the table is shown collapsed; click 
the plus-sign (+) to the left of an entity entry to expand the display of the settings of that 
entity. 

Details about the 
selected entity. 
Click the plus 
sign (+) to 
display more 
information about 
the entity. 
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A behavior entity is tracked within Scenario Editor by its marking. A marking is a unique text 
label for a behavior entity. (Think of it as a label for one instance of a model.) Because the 
markings are broadcast through DIS, they are limited to 11 characters in length. Some 
information in the behaviors table is editable: cells that are colored grey are not editable, 
white cells are editable. Some editable cells contain a drop-down menu. A cell with a drop-
down list displays the down-arrow icon as shown in the following example: 

In the 3D scene and timeline, you edit the entity’s path of movement, assign animations and 
appearances, control the entity’s speed, and control the firing of a character’s weapon. 

A waypoint is one 
location in a path 
that defines the 
movement of an 
entity. 

The color of the path 
ribbon denotes the 
speed of the entity’s 
movement. The black 
arrows on the path 
ribbon denote the 
direction of travel. 

Hovering the 
pointer over a cell 
displays the down-
arrow, which 
indicates that this 
cell contains a 
menu. 

Click the down-
arrow, to display the 
menu. Then click the 
option in the menu 
that you want. 

Hover over the path 
to display information 
about the speed, 
position, and the time 
in the scenario. 
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In Scenario Editor, you can change the model assigned to a behavior entity. In the behavior 
table, click in the cell for the model assigned to the entity to choose a different model of the 
same type (culture or behavior) and same DIS Kind and Domain from the drop-down menu. 
A change in the model does not change the marking (the entity/instance name).  

This feature is useful if you copy/paste multiple copies of an entity to create groups, such as 
vehicular traffic or a crowd of people, as described later in this chapter. After creating 
multiples of a character or a vehicle entity, you can replace the models of many to vary the 
entities. Note that when you change the model assigned to an entity, the available options for 
that entity might change. For example, if you change a vehicle entity from a model that 
accepts characters to a vehicle model that does not, the characters seated in the vehicle will 
disappear.  

Note that the DIS enumeration of the entity does not change when you change the associated 
model. This means that you would not want to replace a ground vehicle with an aircraft or a 
character with any vehicle. Such a replacement would not work properly in VRSG as the 
replacement model with be associated with the original DIS enumeration associated with the 
entity. If you must edit the DIS enumeration, you can do so manually. Exit from Scenario 
Editor, open the scenario’s .behavior file in a text editor such as Notepad.  Search the entity 
by its marking. The DIS values are located within the xml entry “EntityType” for the entity.  

For example: 
<EntityType kind="1" domain="1" country="225" category="0" 
subCategory="0" specific="0" extra="214" /> 

The correct entity type will take effect the next time you open the scenario in Scenario Editor. 

To locate a particular entity in the 3D scene, click anywhere in its entry in the behaviors table. 

To identify the model used for an entity in the scene, click it once in the scene. The entity’s 
row (with the name of the model) in the behaviors table will appear highlighted, as shown in 
this next example: 
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Creating the path of travel for behavior entities 
You specify the movement of a behavior entity in the 3D scene along a path made up of 
connected waypoints. A waypoint is a navigational point in space, or in this case, on the 
terrain. During scenario playback, the entity travels along the waypoints that make up its path 
at the speed you set in the timeline, as described later. You create and edit the path of 
movement of the behavior entity by selecting the entity and then dragging the waypoint in 
front of the entity to extend it along the route you want the entity to travel. If the entity is 
situated on the ground, its path is ground-clamped by default to ensure the vehicle or 
character will hug the terrain as it traverses its route. 

Initial direction of travel 
The most efficient way to create a path of travel for a behavior entity (on the ground or 
airborne or on an elevated structure) is to grab the waypoint in front of the entity, zoom out, 
and extend the path to the final destination. Doing so provides a smoother path of travel for 
the entity. Then you can zoom in and refine the travel route by adding waypoints to provide 
deviations in the straight path, such as adjusting the path to adhere to the lane in the road, or 
to make turns. Working in this manner becomes especially useful for planning a complex 
route of a ground vehicle, or the route of an aircraft. 

Notice that the initial start of the entity’s path of movement with a waypoint is automatically 
attached to the front of a newly created entity. In the case of vehicles, the waypoint in front of 
the vehicle is its second waypoint; the first waypoint is actually under the vehicle, as shown 
in the example above. To have an entity to face a different direction after you drag it from the 

The color of the path ribbon indicates the general speed of 
an entity’s movement along the path. Arrowheads indicate 
the direction the entity is traversing. 

Waypoints along the path 
that the entity is traversing. 
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feature palette to the 3D scene, click/select the waypoint in front of the vehicle or character 
and rotate it to the direction you want the entity to face. 

The color of the path ribbon indicates the general speed of an entity’s movement along a 
section of its path. It remains a steady color while the entity moves at a steady speed. The 
path ribbon color changes from blue at the slowest speed (2.5mph or below), through green to 
yellow at the maximum speed. For human character entities, the path ribbon is yellow at 
speeds of 7m/s (15.5mph), and for vehicle entities at speeds of 20m/s (45mph) or faster. 

The black arrowheads displayed along the path ribbon show the direction of the path. The 
arrowheads are a useful visual aid when you edit a complex scenario, such as the scenarios 
that are delivered with VRSG, where the paths of several entities (a crowd of people on a city 
street, vehicular traffic, and so on) are close together and intersect or overlap over time, or an 
entity returns to a road it previously traveled, as shown in the previous example. A behavior 
entity is always oriented facing in the direction of travel, as shown by the black arrowheads 
(which are spaced in 1-second increments). 

Editing waypoints of behavior entities 
As described earlier, click and drag the waypoint in front of the entity to create its path of 
travel through the scenario. If you click on a waypoint and drag it, the waypoint will be 
repositioned. When you click and drag the path, a new waypoint is inserted. 

The most common actions for editing a waypoint are: 

• Click and drag on the path ribbon to insert a waypoint. Clicking and dragging on the
entity also inserts a waypoint.

• Click on a waypoint to select it.

Drag the waypoint in front of the entity to 
change its direction. 
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• Click on a waypoint and drag it to move it.

• Select a waypoint and right-click it to display the context menu, and then choose Delete
Waypoint. Alternatively, press the Delete key on the keyboard to remove the selected
waypoint; be sure that the waypoint is selected, otherwise, you might inadvertently delete
the entity.

If you are zoomed out to see a bird’s eye of a scene but need to edit the waypoints of an entity 
that might be hard to see or move, drag the Tool Scale slider at the top of the workspace to 
the right to increase the scale of the entity’s path and waypoints to improve the visibility.  

Tool Scale does not enlarge the entity itself or alter the waypoint position data. 

The following example shows the benefit of visually increasing the scale of the path of an 
aircraft in flight as an aid to refining the entity’s airborne waypoints: 
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Tool Scale is also useful while you are zoomed in and refining the placement of waypoints. 
Press the Page Down or Page Up keyboard keys to advance the scenario time index to the 
point in the scenario at which the entity will arrive at the waypoint. All other entities will be 
advanced in time as well, so inadvertent path collisions can be found and edited out.  Stepping 
through an entity’s movement waypoint-by-waypoint enables you to inspect and refine the 
waypoint details as the entity shift to any of the orientation settings described in this section. 

Right-click a waypoint to open a context menu from which you select options that control 
whether a path is ground clamped, uses sharp corners or smooth corners, or is a looped path. 
You can also group a set of waypoints in an entity’s path in order to move the entity and its 
path as one unit. 

From the context menu, you can also delete a waypoint or control whether it is ground-
clamped.  

Although the entity is barely visible, the 
waypoints on its flight path are enlarged 
enough to easily edit. 
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Creating a looped path 
By default, the path of a behavior entity is a linear path with two endpoints. A path can also 
be a closed loop in which a vehicle or character circle around an area or traverse in some 
other repetitive travel pattern.  

To create a looped path: 

1. Drag a model from the behavior palette to where the entity’s path should start.

2. Add a few waypoints around the area you want the path to loop, but do not attempt to
close the loop.

It can be helpful to zoom out to get a bird’s eye view of the area and increase the tool
scale of the path so you can get a full view of the waypoints, as described earlier and
shown in this looped path example.

4. Edit the newly extended section of the path to refine it if necessary.

3. Right-click on the path’s end waypoint and choose Toggle Loop. The end waypoint is
snapped to the position of the first waypoint, closing the loop..
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Moving an entity and its path to a new location 
To move an entity and its entire path to another location: 

1. Select the entity of interest.

2. Right-click on a waypoint, and from the context menu, choose Toggle Waypoints Group.
This option selects all waypoints in the path of the selected entity and treats the selection
as one unit.

3. Drag the selected grouping to the new location.

 Initial location of an entity and path.  New location of entity and path. 

Elevating behavior entities 
By default, the waypoints are ground clamped and the behavior entity is clamped and oriented 
along the ground surface. However, entities added to the terrain do not need to be positioned 
on the ground. You can turn off the default ground-clamping of entities to raise them above 
the ground. Elevating behavior entities are useful for creating a flight path for an aircraft 
entity in flight. 

To add aviation behavior entities to your scenario, you unlock the ground-clamp of the first 
waypoint you want to be positioned above the terrain and drag it to the destination endpoint. 
This way, subsequent waypoints you add to build the path of travel will not be ground-
clamped, as shown in the following example of an aircraft in flight:  
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To turn off ground clamping: 

1. Right-click on the first waypoint from which you want to remove the ground clamp to
display its context menu, choose Height: Altitude, and then set the height of the waypoint
by dragging the vertical blue arrow, as described earlier for cultural entities.

2. Right-click on the second waypoint and then from its context menu, choose Height:
Altitude.

Until you explicitly reinstate the ground clamp to another waypoint in the path, subsequent 
waypoints in the path will retain the Height: Altitude state of the previous waypoint, as shown 
in the following example:  

Elevated 
waypoints along 
the path that the 
aircraft entity is 
flying. (Note that 
the waypoints are 
enlarged here with 
Tool Scale as 
described earlier.) 

Drag the vertical 
blue arrow to 
raise the 
elevation of an 
entity. 
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A quick way to simply place an aircraft or other project in space in mid-air is to use the Sky 
Placement slider above the 3D scene. This method is less precise than the method of initiating 
the airborne path of aviation behavior entities by placing the entity on the ground and raising 
the elevation, but it is a quick way to place an entity above the terrain.  

The value on the Sky Placement slider represents the percentage of distance away from your 
eyepoint. Values 0-40% will situate an airborne entity fairly close to your eyepoint. 

To place an aircraft or other behavior entity in a general location in mid-air: 

1. Move the Sky Placement slider to some low percentage value (0-40% work best.)

2. Click a spot in the 3D scene (above the terrain) where you want the entity to be
positioned.

3. Drag a model of interest from the behavior palette to the scene. Scenario Editor will place
the model as a new entity at the mid-air location you last clicked.

You can control the orientation of an airborne entity in multiple ways to: 

• Match the angle of the direction of the path of travel.

• Roll.

• Change yaw or pitch.

These methods of manipulating an aircraft above the terrain can also be used in other cases 
for which you need to place entities above the terrain. 

To match the angle of the direction of the path of travel (instead of maintaining an orientation 
clamped to the ground): 

1. Right-click on a selected aircraft’s initial waypoint from which you want it to lift off the
ground and select the Height: Altitude and Orient: Front follows path options from the
context menu. The Altitude option unlocks the ground-clamp and the latter option

Percentage of 
distance from 
eyepoint, low 
percentage sets the 
mid-air drag/drop 
closer to you. 

Click this checkbox to quickly bring Sky Placement 
eyepoint to 100% ground clamped. 
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ensures that the aircraft’s orientation will match the upward direction of the lift-off, and 
flight path, and descent. 

2. Turn off the ground clamping of the waypoint and then drag the blue vertical arrow in the
center of the waypoint upward and away to raise the waypoint upward off the ground to
create the flight path for the aircraft.

3. Repeat steps 1 and 2 for the next waypoint in the air.

(The example above also shows the aircraft’s power plant (engine) appearance bit turned on 
automatically, as it is velocity based. Appearances are discussed in the chapter “Creating 
Scenario Projects.”) 

You can also simulate the vertical lift-off of a rotary-wing aircraft, to ensure its orientation 
remains upright. 

1. Right-click on a selected helicopter’s initial waypoint from which it will lift in the air and
select Height: Altitude from the context menu. Also select Orient: Upright.

2. Do the same as step 1 for the second waypoint you will lift in the air.

3. Drag the waypoint’s blue arrow upward to give the helicopter a vertical lift-off.

You can change the orientation of a behavior on its path so that you can control its roll, yaw, 
and pitch. Unlike changing the orientation of a cultural entity, these orientation tools pertain 
to a single waypoint, as shown in the following aircraft example of roll orientation:  
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To set a behavior entity to roll: 

1. Select and right-click on the first (or sole) waypoint at which you want the entity to roll.

2. When the magenta hoop roll tool appears, drag the orange marker to the angle at which
you want the entity to roll.

3. Repeat steps 1 and 2 for each waypoint at which you want the roll orientation to continue.

The ability to set roll orientation is turned on by default. As shown, the aircraft rolls to the 
angle you drag the orientation tool, and during travel, the roll angle is interpolated such that 
the entity’s orientation is straightened out to resume following the path by the time it reaches 
the next waypoint. If you want the roll angle to stop at a specific waypoint, right-click on that 
waypoint and choose Orient: Front Follows Path. 

The next example shows similar usage for an entity traveling on the ground. As shown in the 
next example for a motorcycle entity set to Orient: Roll as it approaches the waypoint. 
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To change the yaw, pitch, and roll of a behavior entity: 

1. Select the waypoint at which to start the yaw or pitch change and right-click. You can
also change the roll axis with this tool.

2. From the context menu, choose Orientation: Free. An orientation tool appears (similar to
the one that appears for culture).

3. Drag the orientation tool (hoop) appropriate for the axis you want to change as needed,
as shown in the next example:

Edit each waypoint at which you want the entity’s orientation to change. Press the Page Down 
and Page Up keyboard keys to move the selected entity forward and backward one waypoint 
at a time and inspect the angles and timing of the orientation changes.  

Selected 
waypoint and 
the options 
available in 
the waypoint’s 
right-click or 
context menu. 
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By default, the paths of character entities will have sharp corners and the paths for vehicle 
entities will use smooth corner paths. These defaults yield natural-looking behavior for a 
walking character and a vehicle making a turn on the road.  

In addition to the default walking or running movement (controlled by the velocity of the 
character), characters can perform several common animations, such as crouching, kneeling, 
lying prone, driving a vehicle, and firing a weapon. When you drag a weapon from the feature 
palette and drop it on a character in the scene, the character will assume a deployed position 
to hold the weapon. (You can have the character fire a weapon using an appropriate firing 
animation for the weapon type, as described in the chapter “Creating and Editing Scenarios.”) 

In the timeline, click the Play button on the playback controls to observe your entity traverse 
the path you created or edited. Pause the scenario playback to edit a waypoint or add 
additional ones. In the timeline, you can assign an animation (to characters), control the speed 
of the vehicle or character, or assign an entity’s appearance, as described in the chapter 
“Creating and Editing Scenarios.” 

Duplicating entities 
You can create multiple instances of a cultural or behavior entity (or a selection of multiple 
cultural entities) quickly by duplicating the entity. Creating multiple copies of the same entity 
can be done in three ways: 

• Copying and pasting – This method works well when you have made edits to an entity in
the 3D scene and you want to make multiple copies of the entity with those same edits, or
a selection of multiple cultural entities. In addition to using this to create multiple copies
of culture, this method works well for creating multiple copies of a behavior entity (such
as a vehicle or a character) with its path of travel.

Click the Play 
button to watch 
the character 
walk its path. 
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• Using the Duplicate mode – This method works at the time you drag a model from the
feature palette and drop it at a location of interest on the terrain, or for a selection of
multiple cultural entities to build up an area of dense culture quickly.

• Editing a cultural feature file (vrsg.clt) for the terrain or scenario in Notepad –To add
multiple entries in the vrsg.clt file for the cultural entities (with locations offset slightly
for each). Once the vrsg.clt is loaded with the terrain in Scenario Editor, you can refine
the placement by editing the location and orientation of the entities as needed.

Once you have duplicated an entity, you can change the model associated with the entity in 
the Model column of the behavior or cultural entity table. 

Copying and pasting entities 
Copying and pasting might give you a little more control than Duplicate mode, depending on 
what you are working with.  

To copy and paste multiple instances of either a behavior or cultural entity that is already 
positioned on the 3D terrain: 

1. Select an entity of interest on the terrain and choose Edit > Copy or press the Ctrl-C
keyboard command.

2. Position the pointer where you want to place the copy on the terrain and then choose
Edit > Paste or press Ctrl-V.

3. Repeat choosing Edit > Paste (or press Ctrl-V) to create duplicate entities or selection of
cultural entities until you have populated the terrain with as many copies as needed.

Select the Random or Retained Orientation to control how the pasted entities are oriented. 

You can select, copy, and paste one behavior entity at a time, or copy/paste a selection of 
multiple cultural entities.  

Original selection, copied. Pasted selection at a new location. 

You can manipulate the copy by rotating the hoop or dragging it to a new location. Once you 
unselect the copy, the selection no longer exists. 

To select more than one entity to copy/paste, hold down the Shift key to select adjacent 
entities, or hold down the Control key to select discontinuous entities, and copy / paste them. 
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For a behavior entity, this copy-paste method copies the path, appearance, speed, and timing. 
Be sure the timeline is set to zero before you copy/paste. The copy/paste method of 
duplicating a behavior entity is useful for quickly building up multiple vehicles traveling on a 
road (traffic or a convoy) or for building up multiple characters to create pedestrian or crowd 
activity.  

Once you have duplicated an entity, you can change the model associated with the entity in 
the Model column of the behavior or cultural entity table. 

If you copy a vehicle entity with driver or passenger characters attached to it, those characters 
will be copied with the vehicle. (Attaching characters to vehicles is described in the chapter 
“Creating Scenario Projects” in the section “Seating characters in a vehicle.”)   

Note: When you paste a ground vehicle behavior entity, paste directly on top of the copied 
entity, and then drag the initial waypoint of the copy backward. This way you will have 
created a separation between the two vehicles, but the turns in the copied path will still be at 
the appropriate locations. 

For culture, each copied entity preserves any edits you made to the original – such as its scale 
factor or damaged state.  

Consider the following example, which shows a group of soldiers created by copying and 
pasting one character entity, duplicating it, and then changing the model associated with some 
of the duplications.  

After duplicating a behavior entity this way you can edit the waypoints of the entity copies so 
they travel a bit more spaced apart and offset from each other. Then, edit the entry for some 
or each entity in the behavior table to change the model assigned to that entity (so that, in this 
case, all the entities are not using the same character model). 
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Note that when you change the model assigned to an entity, the available options for that 
entity might change. For example, if you change a vehicle entity from a model that accepts 
characters to a vehicle model that does not, the characters seated in the vehicle will disappear. 

Copy/paste works well for creating multiple aircraft entities flying in formation too. Copying 
and pasting an aircraft entity is easiest to do while the entity is sitting on the ground.  

After copying and pasting duplicates, you can select each entity and move its path to offset it 
as necessary by first grouping waypoints to select the entire path as one unit as described 
earlier. 

Using Duplicate mode 
Choose the Duplicate mode from the mode menu at the top of the workspace as shown in the 
example below. Drag the model of interest from the feature palette to the terrain, such as a 
tree model shown next. After you place the first entity (instance of the tree model) on the 
terrain, single click elsewhere in the scene to place each duplicate at the click location.  

Using Duplicate mode, you can rapidly place many instances of a culture model. With a few 
mouse clicks, you can populate an area with randomly-oriented vegetation or a set of barriers 
to form a barricade.  

The example below shows the tree model above dragged and dropped onto the scene in 
Duplicate mode, and then duplicated multiple times by clicking elsewhere in the scene to 
place the duplicates. 

Duplicate mode. 

Duplicate mode. 

Option to 
randomize the 
orientation in the 
duplicates. 
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The Random Orientation option is selected in the example. Random orientation is useful for 
placing trees, stones, debris, and other elements that typically exist in a random pattern; 
Retained orientation is best for placing elements like buildings, fences, or parked cars so that 
they all face in the same direction. 

Continue clicking until you have created all the duplicates you need. Then select Selection 
mode to turn off Duplicate mode. If the last duplicate is selected, press Esc to unselect it. 

You can also use Duplicate mode with a selection of multiple cultural entities. Doing so 
works particularly well for creating a grove, forest, or agricultural field quickly. 

Selection of multiple shrubs. Selection of shrubs, duplicated. 

Orientation options for 
entity duplication. 

Multiple instances 
of a tree, placed 
with mouse clicks 
with the Duplicate 
Tool turned on. 
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Troubleshooting missing entities 
Like VRSG, if Scenario Editor cannot find a model file for an entity in the search path, it 
displays in the 3D scene a rainbow-colored sphere or “beach ball” model in its place. The 
error text of the missing model will be displayed on the Status tab and in the error log. 
Missing models depicted as beach balls are typically due to the model file not being located in 
the Scenario Editor search path. To resolve the missing model, restart Scenario Editor and add 
the directory that contains the model to the Search Path tab so that Scenario Editor can find 
the model. 

You can copy text from the status area or the .log files and paste the text in other applications, 
such as email. Doing so is useful for troubleshooting, and for reporting an issue in an email to 
MVRsimulation support. When reporting such an issue, also attach the Scenario Editor .log 
files to your email message.   

Rainbow-colored 
sphere or “beach 
ball” model, which 
indicates a model 
that Scenario Editor 
cannot find for an 
entity in its search 
path. 
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C H A P T E R  5  

Creating and Editing Scenarios 

Before setting up a new scenario project in Scenario Editor, identify all your preliminary 
sources. Such sources include: 

• The terrain you want to use.  

• The location of the initial view Scenario Editor will use for loading the terrain in the 
project. The Create Project wizard will prompt for latitude/longitude and elevation 
coordinates of the initial view. The easiest way to obtain the coordinates is to left click on 
the globe at start up. 

• Optionally, any existing VRSG viewpoints, and cultural features with which you will 
want to populate the terrain. 

Fly the virtual terrain in VRSG. Identify the general areas you will want to build up in 
scenarios and add viewpoints for those areas. You will be able to import these viewpoints into 
Scenario Editor. 

Creating a project 
You can create a new scenario project in multiple ways: 

• Make a copy of an existing project to start with by opening the original project and 
choosing File > Save As. The benefit of this method is that you can use the built-up 
culture, and pre-set viewpoints and search paths as a basis for a new or modified 
scenario. 

• Double-clicking a terrain tile in the globe that is displayed when you start Scenario 
Editor. The benefit of this method is that it as a quick way to get started, by simply 
selecting a tile from the terrain you see.  

• Entering a set of coordinates in the Start At Location field at the top of the workspace 
when you start Scenario Editor. The benefit of this method is that it as a quick way to get 
started, by simply pasting or typing coordinates you already possess. 

• Using the new project wizard by choosing File > New. The benefit of this method is that 
it enables you to manually include culture files and viewpoint files from existing projects 
into your new project. 

An empty scenario is created automatically at the time you create a new project with any of 
the methods described in this section, and its name takes the name of the project, as illustrated 
in the example projects delivered with VRSG. 
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One-step project creation 
In Scenario Editor, you can create a new scenario project quickly in one step with one of 
these two methods:  

• Double-click a tile of interest on the globe depiction of the earth that appears when you 
start Scenario Editor. The globe contains a visual representation of the terrain tiles that 
Scenario Editor finds in its search path. If you do not see an area of terrain that you 
expected to see on the globe, you will need to add the directory containing the VRSG 
terrain tiles (MDS) to Scenario Editor. 

• Above the globe, type or paste a set of location coordinates for the terrain in your search 
paths that you want to use, specify the coordinate system, and click the Start At button. 
Lat/Lon coordinates can be input as degrees minutes seconds or in decimal format. You 
can omit entering elevation coordinates if they are unknown; in this case Scenario Editor 
will assign a default elevation of 6 meters above ground level (AGL). 

 

 

 

 
 

Terrain tiles that Scenario Editor has discovered in its search paths are drawn as colored 
triangles on the globe, bounded by a white square that you can locate while the globe is 
zoomed out.  

Note: If you have many search paths listed on the Search Paths tab, it will take a moment for 
Scenario Editor to “preload” the terrain in those search paths to depict them on the globe.  
 

Enter coordinates of the tile you 
want to load, select the coordinate 
system, and then click Start At, to 
start the new project at that location. 

Coordinate system of the 
coordinates you specified. 

Scenarios discovered 
in the currently listed 
search paths. 

Search paths that 
contain terrain, 
culture and 
scenarios that 
Scenario Editor can 
use as sources for 
your new project and 
scenario. 
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This depiction is similar to how terrain tile coverage is displayed in the MVRsimulation 
Model Viewer’s Show Tile Coverage on Earth feature. The tile color coding scheme 
represents the resolution of the tiles in meters-per-pixel. The legend that accompanies the 
globe describes what resolution each color represents, ranging from the lowest/coarsest 
resolution to the highest/finest resolution.  

Political regions on the globe that are covered or partially covered by the tiles are delineated 
with borders that show the complete region and are labeled the state/province that the tile(s) 
reside in. The tile located directly under the cursor is highlighted in aqua as the cursor hovers 
over it.  

With a mouse or a 6DOF controller, you can pan and zoom to move around the globe. Left-
click and drag to rotate the globe. Use the scroll wheel or right-click and drag to zoom into 
and away from the view. 

 

Tiles on the globe 
that are colored 
green indicate that 
the tiles have low 
resolution imagery. 

Tiles on the globe 
that are colored red 
indicate that the tiles 
have high resolution 
imagery. 

Visual indication 
of terrain tiles that 
Scenario Editor is 
finding in its 
search paths. 
Zoom in for a 
closer look. 
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In this view, tile colors range from green for low resolution tiles (15 mpp imagery or lower) 
to red for high-resolution tiles (50cm per pixel or better). The yellow tiles indicate imagery 
with 1.0 - 2.5 mpp resolution imagery, and the orange-brown areas indicate imagery 
resolution of less than 1 mpp. When the cursor hovers over a tile, the tile turns aqua in color. 
Clicking the tile once, populates the Location text field above the 3D scene with the 
coordinates of that tile. Double-clicking the tile starts a new project based on that tile. After 
you create a new project with either of these new methods, Scenario Editor will load the new 
project and assign it a temporary name auto.vrsgproject. Choose File > Save As to give this 
new project a meaningful name.  
 

 
 

If you choose a tile from the globe that is partially comprised of water or does not have a 
terrain tile in the search path, be aware that the default viewpoint that is used when Scenario 
Editor launches your brand new project might be a section of water. 

Advanced project creation 
The Create New Project wizard guides you through providing all the information Scenario 
Editor needs to create a new scenario project, based on what it finds in its search path. This 
process enables you to manually specify culture files and viewpoint files from other projects 
to use in your new project. 

At any time in the process you can add a directory to the search path so that the wizard can 
locate files you want to specify for your new project (such as a directory of custom models 
specific to your site or a pattern-of-life scenario already built that you want to include as part 
of a new scenario). The example below uses the built-in terrain path of Scenario Editor, 
which includes the Kismayo, Somalia, terrain that is delivered with VRSG.  

To create a scenario project using the New Project wizard:  

Double-click the 
selected tile to start a 
new project using the 
tile. 

Click once to 
populate the 
Location field with 
its coordinates.  
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1. Do one of the following:  
- Choose File > New. 
- Right-click an existing project listed on the left panel and then from the context menu  
  choose New Project. 

2. When the VRSG Project dialog box appears, browse for the directory path you intend to 
locate the project, enter a name for the new project, and click Save. 
 

  
 

The next screen verifies the project name and path, and gives you an opportunity to 
change it or to set up search paths for the terrain, viewpoints, culture or models outside 
the Scenario Editor or VRSG installation that you want to use. You will be able to 
specify those search paths in the next few New Project screens as well. 
 

 
 

3. Optionally set up any search paths by clicking the Search Paths button or just click Next 
to go to the next screen. You can also set up search paths after you create the project. 

4. When you are prompted to do so in the screens that follow, specify the 3D terrain that 
this project will be associated with, and optionally, any existing viewpoint files and 
cultural feature files you would like to associate with the project. Drag each available file 
listed on the left to the list on the right. Existing viewpoint and cultural feature files can 
be from another project, or from VRSG.  
 
If you are creating a scenario from terrain you used before in VRSG, this is an easy way 
to have the viewpoints *.viewpoint files) and cultural feature files (vrsg.clt files or legacy 
metadesic.clt files) available for this project.  
 

Enter a name for 
the scenario 
project. The 
scenario will 
have the same 
name. 
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5. If the viewpoint file for the terrain you plan to use has a viewpoint labeled “default” or 
“Initial Viewpoint” that viewpoint will become the default viewpoint for the new project. 
If the terrain does not have a viewpoint, you can create an initial viewpoint at this point, 
and you will need to provide the latitude/longitude and optionally elevation coordinates 
for it. Lat/Lon coordinates can be entered in decimal format. 
 

 
 
 

 
 

 
 

Default 
coordinates for 
the sample 
Kismayo, 
Somalia, terrain 
that is delivered 
with VRSG. 

Available culture 
(.clt) files for the 
sample Kismayo 
terrain that 
Scenario Editor 
finds in its 
search path. 
Drag to the right 
any you want to 
use in your new 
project.  

Available 
scenario files for 
the sample 
Kismayo terrain 
that Scenario 
Editor finds in its 
search path. 
Drag to the right 
any you want to 
use in your new 
project. 

Available 
viewpoint files 
for the sample 
Kismayo terrain 
that Scenario 
Editor finds in its 
search path. 
Drag to the right 
any you want to 
use in your new 
project. 
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6. Click Done. The new project is now available in Scenario Editor. 

Loading a project 
When you load a complex scenario project (one that has a lot of culture, many directories in 
its search paths, many behavior entities and activities) bear in mind it might take a few 
minutes for the project to fully load. Scenario Editor displays progress messages as it loads 
the 3D content and then displays a green circular load-progress icon in the upper-right corner 
of the 3D scene as it loads the terrain and the rest of the project files. The project is fully 
loaded into Scenario Editor when the icon disappears, at which time you can begin work on 
the scenario. 

Editing a project  
Initially for a new scenario project, you should identify areas of the terrain on which you want 
to build up culture and set up viewpoints for them. Determine whether to add culture to the 
base terrain (the project), which could be shared among other projects or scenarios that you or 
others might create at a later time. This strategy will save time and effort later.  

In Scenario Editor you can add viewpoints for, and cultural features to, the terrain that are not 
associated with any scenario, as well as scenario-specific viewpoints and culture. The non-
scenario viewpoints and culture will always load with the project. Again, thinking about what 
will be specific to a scenario as opposed to what might be shared across multiple projects (for 
example a larger project that would encompass your project) is worth planning in advance. 

If the models required for your scenario are located in various directories not delivered with 
VRSG, you must set up the model directories in the Scenario Editor search path so that the 
models will be available in the feature palettes. 

To open an existing VRSG project in Scenario Editor, do one of the following: 

• Launch the project directly from the Windows Start menu, where the most recent projects 
are listed with Scenario Editor. 

• Start Scenario Editor and then select the project of interest from the left panel of the 
workspace. 

• Start Scenario Editor and then choose File > Open and browse for the project of interest. 

As described earlier, scenario projects found in the search path are displayed in the projects 
list on left panel of the workspace when you launch Scenario Editor.  

When you first set up a project, set some initial viewpoints for areas that will be the focus of 
the scenario you will eventually create. Be sure to set viewpoints for areas where you plan to 
build up culture: you might examine sightlines, different angles, and set some preliminary 
character viewpoints. 

Add model directories to the search path for any cultural models to be shared among multiple 
scenarios as described earlier. Culture can be models that are delivered with VRSG, or 
models at your site that were converted from FBX or FLT formats to MVRsimulation’s 
model format using MVRsimulation’s model conversion utilities. 

To save edits to a project, choose File > Save. You can also choose File > Save As to save the 
project and its associated files under a new name. 
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Creating a scenario 
Before you begin building a scenario, consider creating a storyboard to figure out the flow of 
activity among the various behavior entities. Text2MindMap is one free online tool available 
for storyboarding a scenario with multiple activities taking place simultaneously. This tool 
can be obtained at www.text2mindmap.com. 

Next, locate the model assets you will use for culture and behavior entities. If you want to use 
models from sources other than MVRsimulation’s 3D content libraries that are delivered with 
VRSG and available on Scenario Editor’s feature palettes, be sure to set up their directories in 
the Search Paths dialog box prior to launching the scenario, so that Scenario Editor can find 
them and make them available on the feature palettes. 

Identify the location of your scenario by getting close to the ground in the terrain in VRSG or 
in Scenario Editor, and examine the location from several angles related to your ultimate 
purpose of the scenario: on the ground, from the air, from nearby hilltops, and so on. (It could 
be the location is related to the location of other scenarios taking place nearby.) 

Identify areas of activity, like a hospital or airfield, marketplace, motor pool, and areas of 
vegetation. Turning on the compass rose display (Options > Show Compass Rose) can help 
with orientation. 

In VRSG you can play one scenario at a time, which is also something to consider in planning 
a scenario.  

As mentioned earlier, an empty scenario is created automatically at the time you create a new 
project, and its name is based on the name of the project. This is the scenario you will work 
with, creating new content and activity.  

Using custom models 
As described in the chapter “Getting Started,” to add your own custom models (in 
MVRsimulation’s model format) to the feature palettes so you can use them in Scenario 
Editor, you must add the applicable model directory path(s) to the Scenario Editor search 
path. Scenario Editor fully supports a model’s attributes listed in its accompanying JSON 
metadata file. 

You can also supply thumbnail image files (in .jpg, static .gif, or .png format) associated with 
your own custom models or effects to be displayed in the feature palettes. Simply place a 
small square image of your model (for example a screen capture taken in MVRsimulation’s 
Model Viewer) in the same directory as your model or effect, with the same name as the 
model or effect. When Scenario Editor finds that image in the same directory as the model or 
effect, it will display the image in the feature palettes. 

You can also take a thumbnail screen capture of your HPX models in the Model Viewer and 
optionally embed the thumbnail image in the model. See the MVRsimulation VRSG User’s 
Guide for details. 

To use large models of urban areas created in Esri CityEngine, add them to the scenario via 
hand editing the appropriate vrsg.clt. Although CityEngine-generated models are useful to 
display on the terrain in Scenario Editor while you are adding other content, these models are 
too big to place on the terrain directly in Scenario Editor by a drag-drop action from the 
culture model palette. As CityEngine-generated models are tied to a specific footprint and 
elevation, there is no need to manipulate them directly in Scenario Editor. 
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Building up culture 
In the 3D scene, populate the basic culture framework first, such as walls and fences. Figure 
out the areas of activity, and areas of vegetation (trees, bushes).  

You can add culture to your scenario by: 

• Dragging and dropping models from the culture palette to the 3D scene and use tools 
such as multiple selection and duplicate to build up area of repeating elements efficiently. 

• Importing cultural feature files from other terrain projects or scenarios. 

• Copying entries from other cultural feature files and pasting them directly into your 
scenario. 

Scenario Editor has a different cultural feature file policy from VRSG. Where VRSG loads 
cultural feature files in its search path, Scenario Editor reads only the cultural feature file that 
is associated with a given project in its search path. To use cultural feature files (.clt) from 
other scenarios or generated directly from VRSG, you can either: 

• Import the cultural feature file(s) of interest at the time you create a scenario project. 

• Copy/paste entries from other cultural feature files of interest into the current project’s 
cultural feature file. 

Importing cultural feature files for use in current scenario 
The importing of cultural feature files from other scenarios or terrain projects takes place 
automatically when you create a new scenario by clicking a tile on the globe in the 3D 
workspace to start a new project using that tile. The vrsg.clt files near the location you clicked 
will automatically be added to the generated scenario. 

For a large project on which multiple users are collaborating on the culture for several 
scenarios based on the same terrain, you might first create small projects focused on culture 
placement of different areas or different categories of culture, all located in the same directory 
tree. And then when you create the final scenarios that use all this content, all the cultural 
feature files will be pulled in to create the scenario’s cultural feature file. 

Note: Examples of vrsg.clt files shared among multiple scenarios can be found in 
\MVRsimulation\VRSG\Terrain\Somalia\Kismayo\CLT, where culture is organized in 
subdirectories by category (buildings, trees, fences, and so on). 

Adding portions of other cultural feature files to current 
scenario 
You can use portions of other cultural feature files in your scenario, by opening a given 
vrsg.clt file in a text editor like Notepad, selecting and copying the entries of interest and then 
pasting (Ctrl-V) the text directly into the Scenario Editor 3D scene. The models in the source 
cultural feature file are in Scenario Editor’s search path. It also requires that both cultural 
feature files are using the same coordinate system, which means that you must capture the 
heading (with coordinate system information) from the source cultural feature file to the 
target file as well.  
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When you copy/paste portions of a vrsg.clt file into another one, note the following 
information must remain intact for the copied culture entries for successful positioning of the 
culture: 

• Coordinate system heading information (! UTM Meters in zone nn) from the top of the 
file. Note that Scenario Editor outputs culture in UTM coordinates, and 
MVRsimulation’s Terrain Tools outputs culture in Lat/Long coordinates. VRSG can 
render a vrsg.clt with mixed coordinate systems, but the coordinate system control 
comment must be explicitly included. 

• ! Agl=on/off ground-clamping control comment. 

• ! clt_version=0/1 internal clamping control comment. 

• ! Orient=On/Off orientation clamping control comment. 

Adding culture to a scenario by copying/pasting can be useful because you can copy a large 
detailed area of static culture for reuse quickly.  

The static entities from the cultural feature file that you intend to paste into the scenario 
cannot contain any directory paths, just the model name. If the entries in the cultural feature 
file you are working with have paths (absolute or relative) in front of the model names, delete 
the paths before you copy/paste the entries into Scenario Editor. 

You can print out the contents of the entire culture table. 

To print the scenario’s culture table: 

1. Right-click on any entity in the culture table and from the context menu, choose Print 
Table.  

2. When the Print dialog box appears, select the printer you want and click OK.  

The printed output contains all the cultural entities and their data. You can print out the 
contents of viewpoints and behavior entity tables the same way. 

Note: Scenario Editor does not assign ID numbers to culture entries in the vrsg.clt by default. 
You can retain the automatic assignment of ID numbers to cultural entities if you need them. 
A cultural entity needs an ID number in three cases:  

• When it is associated with a scripted viewpoint.  

• A cultural vehicle entity has an attached culture character. 

• When an ID is needed for a DIS PDU.  

You can manually set an ID number for a cultural entity in the culture table, or have Scenario 
Editor generate the IDs. If you copy and paste a cultural entity that has no ID number, the 
pasted entity will also have no ID number. If the copied culture has an ID, the pasted entity 
will be assigned a new unique ID. 

To turn on generating ID numbers to cultural entries in the vrsg.clt file: 

Choose Options > Generate IDs for Culture.  

Adding large areas of culture created in CityEngine 
To visualize a large urban model created in Esri CityEngine on 3D terrain in VRSG, you must 
add an entry for the model to the terrain’s vrsg.clt cultural feature file by hand. Although 
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CityEngine-generated models are useful to display as landmarks on the terrain in Scenario 
Editor while you are adding other content, these models are too big to place on the terrain 
directly in Scenario Editor by a drag-drop action. As CityEngine-generated models are tied to 
a specific footprint and elevation on the terrain, there is no need to manipulate them in 
Scenario Editor. 

Exporting cultural feature files (.clt) and viewpoints 
You can also export just a scenario’s cultural feature file (vrsg.clt) and viewpoint file to save 
them in a preferred location outside the project. This is useful for using Scenario Editor solely 
to build up culture on a terrain and do not have any dynamic activity (animations, effects or 
behavior entities), but merely want to build up a vrsg.clt and save it wherever you want, 
outside the project directory structure. 

To export a scenario’s vrsg.clt file: 

1. Choose File > Export > Export CLT File. 

2. When the Browse dialog box appears, locate the directory to which you want to export 
the vrsg.clt, and click OK. 

The vrsg.clt file is an ASCII file, which can be edited in Notepad or another text editor. 

Similarly, you can save the scenario’s viewpoints file separately from the project. Again, this 
can be useful if you simply need the viewpoints to move around to specific areas of the 
database. 

To export a scenario’s viewpoint file: 

1. Choose File > Export > Export Viewpoints File. 

2. When the Browse dialog box appears, locate the directory to which you want to export 
the scenario’s viewpoint file, and click OK. 

The file is exported as <project-name>.viewpoint. This file is an ASCII file, which can be 
edited in Notepad or another text editor.  

Troubleshooting z-fighting of culture placement 
Sometimes when two models or textures are aligned in the same plane on the terrain, 
flickering results in the VRSG rendered scene. This flickering is caused by z-fighting, which 
is a slight mathematical error in depth resolution, or the z-buffer, managed by the graphics 
card, occurs during rendering. When two models or textures are in perfect alignment (decals 
on a vehicle, windows on a building), the graphics card tries to decide which item is on top. 
This decision happens for every frame. Flickering occurs when one item is rendered on top of 
the other, followed by rendering them in the reverse order in the next frame. 

To remedy the flickering in Scenario Editor, move the flickering item slightly upward or 
downward. (In VRSG, you would adjust the field of view (FOV) or reduce the near and far 
clip.) Below are two typical cases in which items need to be adjusted due to z-fighting. 
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Adding behavior entities and their activities to the 
timeline 

In the 3D scene, you should determine in advance where the primary behavior entities should 
start, where you want them to travel to, the route of travel, and the kinds of activities they will 
perform. For a vehicle traversing roads on the terrain, you might plan its route by placing a 
large placeholder cultural entity (something you can see from a zoomed-out bird’s eye view 
of the terrain) on the roads of interest to temporarily demark the starting location, turns, and 
destination of the vehicle.  

The 3D scene provides three visual cues that are useful when you add a lot of behavior 
activity to areas of your scenario:  

• The color of the path ribbon indicates the general speed of an entity’s movement along a 
section of its path. The path ribbon changes from blue at the slowest speed (2.5 mph or 
below), through green to yellow at the maximum speed. A solid color indicates the 
duration of maintaining a constant speed. 

• The black arrowheads displayed along the path ribbon show the direction of the path, 
which is useful when editing in a complex scenario where the path of several entities are 
close together and intersect over time (such as with a crowd of people on a city street, 
vehicular traffic on a road, and so on).  

• The tooltip that appears when you hover the cursor over a section of the behavior’s path 
of travel. This tooltip provides information about travel speed, the time at which the 
entity reaches that location in the scenario, and the location coordinates. 
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You can slow down the playback, pause, restart, or fast forward the playback as needed. If 
you play back the scenario in full screen mode, press the spacebar to toggle starting and 
pausing the playback. You can also move forward and backward one waypoint at a time using 
the Page Up and Page Down keys. Enlarge the path for a closer look by moving the Tool 
Scale slider to increase the scale of the path.  
 

 
 

  

A color change on 
the vehicle’s path 
denotes a change in 
speed.  

The tooltip that 
appears when you 
hover the cursor 
over an entity’s 
path.  
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By default, the paths of character entities have sharp corner turns automatically, and the paths 
for vehicle entities have smooth corner turns. These defaults typically look natural. However, 
you can change the sharp or smooth turn to the opposite turn type by changing the option on 
the waypoint’s context menu.  

Play back the movement of an entity along its path while you adjust the waypoints in front of 
it or behind it. Doing so enables you to see the entity from various angles (by spinning around 
it in orbit mode) and refine the path as necessary. It also enables you to see where entities 
cross paths or could potentially collide.  
 

 
 

In the example above, waypoint adjustments were made to ensure the two vehicles do not  
collide when they pass each other on the road. 

If you have made duplicates of entities to simulate traffic, crowds, or any kind of behavior 
grouping, you can then change the model of each pasted entity and vary the paths (line or 
looped paths) of each duplicated character or vehicle to offset them. In the example below, 
the two trucks started out as a single behavior entity, duplicated, with paths slightly offset and 
different models assigned to each: 
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Right-click on any behavior entity in the behavior table and choose Display All Entity 
Positions to display a table of all the behavior entities in the scenario, sorted by their DIS IDs, 
and listed with their positions at the current scenario time. 

 
This table is helpful if you are following a specification for your scenario and need to ensure 
the entities are located where they should be located.  

Another report on the behavior entities in the scenario is one you can print, of the entire 
behavior table.  

To print the scenario’s behavior table: 

1. Right-click on any entity in the behavior table and from the context menu, choose Print 
Table.  
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2. When the Print dialog box appears, select the printer you want and click OK.  

The printed output contains all the behavior entities and their data. You can print out the 
contents of viewpoints and culture tables the same way. 

Using animal entities to add pattern-of-life detail 
In addition to vehicles and human characters, you can use animal and bird characters to 
enhance a pattern-of-life scenario. 

  

Set up ground-based animals or airborne birds as you would any other behavior entity. 

 

Using the timeline 
The timeline is where you schedule time-based viewpoints and the activities of behavior 
entities and effects in a scenario. For a selected behavior entity, the timeline displays the 
entity’s activities and is comprised of rows of the following types:  

• Speed – the velocity of the entity performing some action for some duration of time.  

• BVH – animations performed by a character entity for some duration of time. For 
characters only (vehicles do not have skeletal animations). 

• Appearance – typical DIS appearance options flames, smoking, and destroyed as well as 
custom appearance options (such as headlights, hatches, rotors for vehicles). 

• Weapon Fire – firing effects discharged from a weapon. 
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Elapsed time is shown on the timeline from left to right in one second increments. (Recall that 
behavior entities perform time-based activities; cultural entities are static.) When you start 
Scenario Editor, the timeline is initially collapsed vertically, as shown in this collapsed 
version of the timeline shown above: 

 
 

  

Current elapsed time of the 
scenario playback (in seconds). 

Total duration of the 
scenario (in seconds). 

Double-click a cell 
in the timeline to 
display an editor 
that pertains to the 
row in which you 
clicked. 
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You can expand the timeline by dragging it vertically until it is fully expanded. Double-
clicking a cell in the timeline displays the editor for speed, animations, appearance, or firing a 
weapon. (The editor that appears depends on the row in which you double-clicked). Some 
table cells in the editors contain a drop-down list of available values. Hover the cursor over a 
cell to display the list. 

To display the timeline details for a given entity, select the behavior entity either in the 3D 
scene or on the behaviors table.  

When you drag a behavior entity from the feature palette to the 3D scene, its start time on the 
timeline defaults to 0 seconds if the scenario is not playing (that is, its movement or activity 
starts at the beginning of the scenario). If the scenario is playing, then the behavior will 
appear in the scenario at the time you dragged it to the scene. 

You can adjust the start time or end time of the activity for that entity in the timeline by 
dragging it; drag the middle of the activity or the left or right edge. The activities for that 
entity that fall before and after that event time will adjust in the timeline accordingly.  

Delete a segment in the timeline by selecting it and pressing the Delete key on the keyboard.  

Controlling the speed of behavior entities 
Behavior entities can carry out activities at different speeds during a scenario.  For example, a 
truck could start traveling slowly on a road, build up speed, slow down and stop and then start 
up again. A character might walk, then run, then stop, then crouch, and then run again. The 
speed of each activity is controlled by different speed segments in the timeline. 

To add a speed time segment to a behavior entity’s timeline: 

1. Select a cell in the Speed row in the timeline for the entity and double-click to display the 
Speed Editor.  

2. In the Speed Editor, click Add Row, and then in the new row add the seconds (full 
seconds or fractions) and the speed, in the form of “At second 10 of the scenario, the 
speed will be n meters per second.” 

3. Each speed segment requires entries for both the starting second and the ending second 
for each change in the speed. This means a given speed segment must be described in two 
rows in the Speed Editor: one for the start time and one for the end time. 

During a transition for increased or decreased speed, the entity’s speed changes incrementally 
to accelerate or decelerate. Use a pair of zeroes for start time and end time to have the entity 
stationary for that time period.  

Consider the following example of a truck traveling on a road: 
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In this example, the vehicle starts out traveling at a constant speed. You could change the 
truck’s speed pattern so that the vehicle slows down as it approaches a market, stops briefly, 
and then starts up again. Displaying the Speed Editor for the truck initially shows the constant 
speed at which the vehicle is traveling. Click Add Row to begin adding rows for the start and 
end of each speed change. 
 

 
For each speed change, you add a new row of time and speed information, until the vehicle’s 
path of travel and its timeline look like the following: 

• At second 43, the vehicle stops traveling at 4.48 
meters per second. 

• At second 44, the vehicle speeds up and travels 
to 10 meters per second until second 53. 

• At second 62, the vehicle stops and remains 
stationary for two seconds.  

• At second 70, the vehicle starts up again, 
traveling at 13 meters per second until second 
168. 

• At second 169, the vehicle speeds up traveling at 
the speed of 25 meters per second again until 
second 241…and so on. 
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To make an entity remain stationary for a period of time, set the speed to 0.0. 

Click the Play button to see the result. Once the speed segments are in the timeline, you can 
adjust the duration of the speed segments as necessary by dragging either end of the segment 
to increase or decrease the duration. 
 

 
 

The grey path 
segment before a 
waypoint means 
the waypoint has 
extended beyond 
the duration of 
the scenario.  
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A behavior entity’s path will turn gray if its length (the duration of travel) is longer than the 
duration of the scenario. To fix this conflict (if it’s important to your scenario), you can either 
increase the speed of the entity during certain time segments so that it will reach its 
destination before the end of the scenario, shorten the path of travel, or increase the duration 
of the scenario.   
 

 
 

Changing the appearance of entities 
An entity appearance is set with the standard DIS appearance bit mask. Flames, Smoking, and 
Destroyed are typical appearance options for vehicles. Other appearance options (such as 
headlights, hatches, rotors) are custom appearances common for many MVRsimulation 
vehicle models; many also have doors that open and shut. The effect of custom appearance 
bits depends on that particular model.  

Standard DIS appearances for character models are the 3 velocity-based poses standing, 
walking, and running, and other poses like squatting, kneeling, crawling, and lying prone. 
Characters also have standard appearances for handling weapons or accessories (bags, tools, 
and so on). Some characters have custom appearances too. All characters have a life 
appearance of alive or dead.  

Appearances for a selected MVRsimulation vehicle model are available in the Appearance 
Editor. You create rows in the Appearance Editor much like in the Speed Editor, except you 
only need to add a row to enter the start time of each appearance change. 

Default velocity-
based animation 
is labeled as 
AUTOMATIC, 
which is walking.  



5−22    MVRsimulation Scenario Editor User’s Guide 

Scenario Editor supports 64-bit appearance masks, which enables advanced features of newer 
MVRsimulation models to be assigned to bits that are unused SISO/ DIS bits. 

The example below shows the multiple weapon store appearances for an MQ-1C Gray Eagle 
UAV, from the Kismayo Al Shabaab Charcoal scenario that is installed with VRSG. 
 

 
 

 

 

 

 
 

In this example, the weapon store appearances have been selected/turned on and remain 
turned on (storing the hellfire missiles) until 213 seconds into the scenario, when they are 
turned off and the missiles are discharged. As shown in the next image, just after 213 seconds 
the weapons stores are empty. 

Double-click a cell in the Appearance 
row in the timeline to display the 
Appearance Editor. 

The weapon store appearances have 
been selected/turned on until they are 
turned off 213 seconds into the scenario. 
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Note: In the full scenario, you can examine how the released AGM missiles have their own 
timed afterburner appearances and all these entity appearance changes are timed to precede 
explosions of the detonated missiles on the ground, on multiple targets. (Explosions and other 
events are described later in this chapter.) 

To change the appearance of a vehicle behavior entity for a set duration in the scenario: 

1. Double-click the entity of interest in the scene or in the behaviors table to select it. 
 

 
 

2. Double-click anywhere in the Appearance row in the timeline to display the Appearance 
Editor.  

Notice that after 
213 seconds, the 
weapon stores 
appearances have 
changed, no longer 
storing the Hellfire 
missiles. 



5−24    MVRsimulation Scenario Editor User’s Guide 

3. In the Appearance Editor, click the Add Row button. 

4. In the newly added row, click the checkbox next to the appearance option(s) you want to 
assign to the behavior entity and specify in the first column the Start Time (in seconds). 
The appearance you set will persist until the next scheduled appearance change. 
 

 
 

5. Play the scenario to inspect the appearance change for the entity. 
 

 
 

As shown in the example above, the appearance state of the Technical-033.DSHK.AF.white 
entity changes appearance from normal to burning, smoking, and destroyed, starting at 102 
seconds into the scenario. The appearance change is time to coincide with a timed explosion 
(depicted by the yellow dome next to the vehicle in the example).  

To refine the timing of the vehicle’s appearance, you can simply drag the appearance segment 
in the timeline to when you want the appearance change to start as shown in the example 
below. 

You can enhance the appearance settings for a vehicle to add dust trails, or contrails, or other 
effects, by adding ModelMap options to the entity’s entry in the behaviors table, as described 
later in the “Adding effects” section of this chapter.   

In the case of character models (very few have custom appearances), they are listed under 
various names in the Appearance Editor.  

Consider the following example of the character model human-afghan-016, with a removable 
backpack assigned to the Blinking appearance. 

Click Add Row 
to change the 
appearance at a 
specified time. 
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Select the Blinking 
appearance and 
click OK. The 
backpack 
immediately 
appears on the 
character, as 
shown on the 
right. 

Custom appearance 
for this model is the 
attachment of a 
backpack, assigned 
to the Blinking 
appearance bit. 

Click a cell in the 
Appearance row in 
the timeline to display 
the Appearance 
Editor. 
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The Hidden appearance option is useful when you want to set up specific times when certain 
entities appear and disappear. This option is used in a few segments of the sample scenarios 
that are delivered with VRSG. 

In the simple example below, a young girl is in the yard with chickens. To make way for 
some other activity happening in the yard later in the scenario, without the chickens, but then 
have them reappear later, you could hide them for a set duration. The Appearance Editor for 
the selected chicken is shown, with the Hidden checkbox selected starting at 50 seconds until 
the next entry at 100 seconds with the Hidden checkbox unselected. 
 

 
 

To set up a Hidden appearance state: 

1. Select the behavior entity you want hidden for a period of time. 

2. In the timeline, double-click a cell in the Appearance row to open the Appearance Editor. 

3. In the Appearance Editor, click Add Row.  
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4. In the Start Time column enter the time you want the entity to be hidden and select the 
Hidden checkbox. 

Add another row and enter the time you want the entity to become visible again and unselect 
the Hidden checkbox. A hidden entity is visible while you are editing the scenario. The 
absence of the entity is visible when the scenario is played. 

Once you know the set of appearances you want to sequence, you can schedule them in the 
Appearance Editor. You create rows in the Appearance Editor using one row to enter the start 
time of each appearance bit mask value in the Appearance column. 

Assigning animations to character entities 
Character behavior entities are animated in Scenario Editor in four ways: 

• The velocity-based DIS default animations for walking, running, or standing still, which 
are usually modeled as appearances and depend on the speed setting. The default 
appearance/animation, walking, is labeled in the timeline as AUTOMATIC and set to a 
default walking speed. Standing still and running appearances depend on the character’s 
speed setting. If a character is carrying a weapon or accessory, the AUTOMATIC setting 
assumes a deployed appearance carrying the weapon.  

• DIS life form appearances, such as kneeling, crawling, squatting, crouching, and so on. 
Also, a few characters have built-in custom appearances, for wearing goggles, or carrying 
a backpack. If a character is carrying a weapon, the pose for holding the weapon will be 
assumed in the appearance state (such as kneeling with a deployed or firing weapon). 

• VRSG-specific animations, which are BVH files that are delivered with VRSG and 
Scenario Editor. These include animations for characters holding non-standard 
accessories such as shovels, bags, binoculars, and tools.  

• The default animations for being seated in a vehicle as a driver, passenger, or gunner. 

Scenario Editor will play one animation at a time for a given character, in the following order 
of precedence:  

1. Seated in vehicle.  

2. BVH animation.  

3. Holding a weapon or an accessory. 

4. DIS life form or custom appearance. 

5. Velocity-based default appearance. 

Animations can be assigned to both cultural and behavior character entities. For a 
static/culture character, you specify the animation in the culture table entry for that character. 

In the culture table, click the drop down button on the right side of the Animation cell in the 
entity’s row and choose an animation from the available animations in the drop-down list. 
The static character carries out the animation for the duration of the scenario. 

In the following example, a static character entity is holding a shovel, using a shoveling 
animation that is selected in the culture table.  
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For a behavior character entity, typical poses are velocity-based appearances, like the walking 
example below. You could assign an animation or merely change the appearance (to run, 
crawl, kneel, or lie down prone). In both cases the timing of its occurrence in the timeline 
through the Appearance Editor, or Animation Editor in a manner similar to the Speed Editor. 
Shown earlier was an example of changing a character’s walking speed through the 
Appearance Editor. In this next example, it is changed via the Animation Editor. 
 

 
 

Indicates the 
character is 
performing the 
default (automatic) 
velocity-based 
animation or 
appearance – in 
this case walking.  

Select an animation for the 
selected cultural entity in the 
Animation column of the 
culture table.  

Click in any cell in the 
BVH row or 
Appearances row and 
then right click to 
display the 
Appearance or 
Animation Editor.  
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To assign one or more time-based animations or appearances to a behavior character entity: 

1. Select or add the behavior entity.  

2. Do one of the following: 
 
Select any cell in the Appearances row in the timeline for the entity and double-click to 
display the Appearance Editor.  
 

 
 

Alternately, select any cell in the BVH row in the timeline for the entity and double-click to 
display the Animation Editor.  
 

 
 

3. In either editor, click Add Row.  

4. In the Seconds column of the new row, specify the second at which the animation should 
start. Unlike the Speed Editor, the Appearance and Animation Editors do not require a 
row for the end of each appearance or animation segment. In the Pose or Animation 
column, click the down-arrow to display a list of available animations you can assign to 
the behavior entity. 

5. Specify an animation and then click OK. 

6. Drag the beginning and/or end of the appearance or animation’s segment in the timeline 
to increase or decrease its duration. You can also drag the segment in the timeline to 

Click to add a new animation 
entry for this character, and the 
time at which the animation 
should start.  

Hover the cursor over the cell in 
this column and when the down-
arrow appears, click it to select 
an animation from the drop-
down list of animations.  

Click to add a new animation 
entry for this character, and the 
time at which the animation 
should start.  

Hover the cursor over the cell in 
this column and when the down-
arrow appears, click to select an 
animation from the drop-down 
list of animations.  
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move it to another time position. The animation will play in a loop until the next 
animation in the scenario. 

7. Repeat these steps to add more animations to the character. 

The next example shows when the Animation Editor must be used, as a specific BVH 
animation is required for the activity. The raking.bvh animation is added to the timeline and 
runs for the duration of the scenario. 

 
 

A quick way to find an animation (or appearance), if you know what you are looking for, is to 
type in the Animation cell the first few letters of the animation you want to find. Scenario 
Editor will display the animations that matches what you specified. 
 

  
Once you click OK after adding the animation to the scenario, the animation is added to the 
timeline and will play in a loop until Scenario Editor encounters the start time of the next 
animation. 

When the scenario transitions from an elapsed animation to the next animation, the 
character’s pose changes. VRSG will smoothly blend the character’s pose from the old 

Type the first few letters of the animation you 
want to find, like “ra” and Scenario Editor 
will display the animations that match what 
you specified. 

In addition to the rake 
accessory and the raking 
animation, notice the footprint 
tracks associated with this 
model. 
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animation to the new animation during the first few frames of the new animation, which 
means there is no visual popping during an animation transition.  
 

 
 

Scenario Editor is delivered with a set of VRSG character animations and an Animation.ini 
file which maps human appearance values to specific animations. You can also use your own 
custom character BVH animations in Scenario Editor, if the BVH file matches 
MVRsimulation’s standard VRSG skeleton rig. Be sure to set up the search path to the 
animation files in Scenario Editor, as described earlier, so that the animations will be 
available in Scenario Editor to select and perform in scenario playback. (See the 
MVRsimulation VRSG User’s Guide for information about creating BVH animations to use in 
VRSG.) 

Seating characters in a vehicle 
You can attach one or more characters to a ground vehicle such that they become seated in 
the vehicle as a driver or passenger. Many, but not all, vehicle entities are equipped to have 
one or more character entities attached in a seated position as driver or passenger, and for 
some military vehicles, in the gunner position.  

When you drag a character to the vehicle in the scene, the character automatically snaps to the 
first unoccupied seated position in the vehicle (driver, passenger1, passenger2, and so on). 
The character remains attached to the vehicle for the duration of the scenario. 

The animation 
segment appears in 
the timeline. 
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To add one or more characters to a vehicle, select the vehicle entity and do one of the 
following: 

• Drag and drop a character from either the behavior or culture palette to the vehicle.  
When you drop the first character onto a vehicle, the character will automatically assume 
the driver position (the first character position). The next character you drag to the 
vehicle will assume the front passenger position, as shown in this example. The number 
of characters a vehicle accepts depends on the vehicle. 

• Right-click on the selected vehicle, and from the context menu, choose Attached 
Characters. 

Optionally, you can hover the cursor over a cell in the Model column, and when the down-
arrow appears, select a different model to seat in the character position.  
 

 
 
 

  
 

Many vehicles can carry more than 1 passenger; some military and technical vehicles have a 
position for a gunner as well, as shown in this next example: 

Click in a cell in the Model column to 
assign a model to that character attachment 
position on the vehicle. 

Right-click on the vehicle, 
and then choose Attached 
Characters. 
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If a vehicle cannot accept a character attachment, or multiple character attachments when you 
attempt to drag a character model to it for attachment, the attachment will not occur, and the 
message “Cannot attach characters” will appear in the context menu. 

To explore which vehicle models can accept character attachments and the animations used, 
see the character attachment mapping file at \MVRsimulation\Scenario 
Editor\Animations\Mount.xml. 

Note: If you change the vehicle model assigned to a vehicle entity from a model that accepts 
characters to a vehicle that does not accept characters, the characters seated in the vehicle will 
disappear. 

Assigning weapons to characters  
To have a character entity carry a weapon or an accessory like a shovel, binoculars, bag, or 
cell phone, drag the weapon or other item from the feature palette (either culture or behavior) 
to the 3D scene, and then drop it on the character.  

The weapon snaps to the character. Initially after the drag-drop operation, the character will 
hold the weapon or accessory by its side until you start the playback for a few seconds, which 
then associates the weapon or accessory with the character in the default position.  

By default the character appearance is set to have the weapon deployed, but you can set it to 
stowed (to hide the weapon for a length of time), or to firing. When you set the character’s 
pose appearance to control whether it is walking (the default), kneeling, or prone, the weapon 
deployed appearance will adjust appropriately.  

Adding weapons or accessories to behavior characters 
An alternate way to add a weapon to a character is to add it to the behaviors table in the 
Weapon entry for the character.  
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In the Weapon cell, select the weapon of interest from the drop down menu. 
 

 
 

 

 

The default appearance for a character with a weapon is to walk with the weapon deployed. In 
the Appearance Editor, you can change the character’s appearance and schedule it in the 
timeline. 

Selected weapon or accessory 
automatically attaches to the 
character. 

Select a weapon or 
accessory for the 
character. It 
automatically 
attaches to the 
character in the 
scene. 
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The example below has the character walking, then running, then stopping and kneeling. In 
each case the weapon is held deployed (Automatic) until 29 seconds when the character’s 
appearance changes to firing the weapon.  
 

 
 

The resulting scene with the character looks like this: 
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The appearance of the character firing a weapon is set up separately from the attached 
weapon model emitting a particular muzzle effect, which is described next. 

In addition to weapons, other items or accessories in MVRsimulation’s model libraries that 
can be held by a character include shovels, binoculars, grenades, tools, and ROVER devices. 
Such accessories that can be held by a character are listed in the feature palette with a 
“weapon-” prefix. (This means you can enter that prefix in the feature palette search box to 
display only the items that are prefixed with “weapon-”.) 

Firing handheld weapons 
Having characters fire their weapons in a scenario is set up in the Weapon Fire Editor, which 
you access from the Weapon Fire row on the timeline. 

To have a character fire a weapon: 

1. Assign a weapon to a selected behavior character of interest as described above. 

2. In the timeline, double-click a cell in the Appearance row to open the Appearance Editor. 

3. In the Appearance Editor, click Add Row.  

4. In the Start Time column enter the time you want the firing to begin. 
 

 
 

5. In the Weapon column, select “firing” from the drop-down menu.  

6. Optionally, add another row, and enter the time you want the character to stop firing the 
weapon and choose AUTOMATIC in the Weapon column. (AUTOMATIC is the 
deployed state for a weapon.) 

7. Double-click in a cell in the Weapon Fire row of the timeline to display the Weapon Fire 
Editor. (You might need to expand the timeline vertically to see the Weapon Fire row in 
the timeline; it is located below the Appearance Editor.) 
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8. As in the other timeline editors, click Add Row to start a new entry. 
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9. Enter the Start Time of each firing, and choose a munitions effect from the drop-down 
list. (Muzzle Blast is typical.) 

10. Click OK. 

The entry is now on the timeline. For a character to fire multiple rounds, set several events in 
the Weapons Fire Editor with short time intervals, one row per round fired, as shown in this 
example: 
 

 
 

Note that for a character firing a weapon, the entries in the Appearance Editor and the 
Weapon Fire Editor will differ a little. You specify in the Appearance Editor the total time 
span of the character’s firing pose, but in the Weapons Fire Editor you schedule the start time 
for each shot that is fired. As in the other timeline editors, you can specify decimal portions of 
a second. 

Firing weapons mounted on a vehicle 
A character can also fire a weapon that is mounted on a vehicle. The military model library 
that is delivered with VRSG (and used in Scenario Editor) contains hundreds of military and 
technical vehicle models, some of which have mounted weaponry that can be used with firing 
effects. Again you make this association in the Weapon Fire Editor, in this case by 
associating the firing with the vehicle instead of the character. The following example shows 
Technical-033.DSHK.AF.white.hpy used in the Afghan Close Air Support scenario delivered 
with VRSG.  
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To have a character fire a weapon mounted on a vehicle: 

1. Select the vehicle entity and attach a character to it in the gunner position as described 
earlier. Note that the attached character will automatically assume the gunner position if 
the vehicle has a driver and full set of passengers, so you do not need to change its 
appearance. 

2. Double-click in a cell in the Weapon Fire row of the timeline to open the Weapon Fire 
Editor for the vehicle. 
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3. In the Weapons Fire Editor, click Add Row.  

4. In the Start Time column enter the time you want the firing to begin, and then optionally 
select the munitions effect. (Muzzle Blast is the typical effect.) 

5. For each firing, add a new row and enter the start time. 

6. Click OK. 

7. The entry is now on the timeline. 
 

 
 

Typically in a scenario multiple activities occur concurrently or in a rapid sequence of events. 
In the case of this particular scenario, there is an explosion next to the vehicle following the 
firing event. To specify the vehicle’s state (burning, smoking, destroyed) for the time of the 
explosion that follows, you would add an entry to the vehicle’s Appearance Editor. (Adding 
explosions and other effects is described later in this chapter.) 

Adding weapons or accessories to static characters 
Weapons or accessories can be held by static characters, as shown in this next example, 
which was shown earlier. In this case, you simply drag the shovel accessory from the culture 
palette to the character, and assign the digging-shovel-001 animation in the static character’s 
entry in the culture table. 

The shovel attaches to the character, by his side. In the entry for the character in the culture 
table, assign the character an animation from the drop-down list of available animations in the 
Animation File cell. 



Chapter 5    Creating and Editing Scenarios   5−41 

 
 

Start the scenario playback for the animation association take effect. 

Adding effects 
Smoke plumes, explosions, and other effects can be added to specific locations in the 3D 
scene to start at a particular time. Dust trails, exhaust plumes, contrails, and wakes, and track 
impressions from vehicles and characters can be added to behavior entities to augment their 
appearance settings. You can have multiple effects occur at once, as in combining explosion 
and smoke effects with a crater effect. 

You can duplicate an effect by using the Duplicate mode in the same manner as for entities; 
switch to Duplicate mode, drag the effect of interest from the palette to a terrain location in 
the 3D scene, and then click elsewhere on the terrain to place the duplicates. When you are 
finished duplicating the effect, select Selection mode. 

Adding explosions and other effects to a scenario 
To add an effect to the scenario: 

1. Move the current time slider in the timeline to when you want an effect appear in the 
scenario. 

2. Drag the effect of interest from the feature palette to the area of interest in the 3D scene.  

 

When an effect is  
not playing, it is 
displayed with a 
yellow dome. 

Select an animation for 
this static character 
from its cell in the 
Animation column. 
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Alternatively, you can set the start time of an effect in the Events table, which appears to the 
left of the scene when you drag an effect to the scene.  

Notice that when the scenario is not playing, the effect appears in the scene as a yellow dome. 
During scenario playback the dome is replaced with the actual effect. Adjust the location of 
the effect by dragging the effect dome. 
 

 
 

To schedule an effect in a scenario: 

1. Do one of the following: 
- Play the scenario and stop the playback at the exact moment that you want the effect to  
  take place, and then insert the effect by dragging it from the Effects feature palette. 
- With the scenario stopped, move the current time marker to the time on the timeline at  
  which you want the event to begin, and then insert the effect by dragging it from the  
  Effects feature palette. 
- Place the effect at the intended location, and edit the start time in the Events table. 

2. Play back the scenario. The effect is performed during playback as shown below. You 
can adjust the time the effect starts by editing the Seconds column in the Events table on 
the left panel of the workspace. 

Setting the start time 
of an effect. 
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Notice that for this example, the building’s appearance needs to be set to Destroyed as well. 
 

 
 

In the Appearance Editor for the building on which the blast effect goes off, the building’s 
appearance is set to Destroyed, 1 second after the blast occurs. 
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You can set the duration for many effects, though not all. Any effect that does not have its 
own built-in duration (like dustPuff.par, which only lasts for a few seconds) plays out for the 
duration of the scenario; the end time of the effect cannot be controlled. As a workaround, to 
control the duration of an effect, you could make a copy of the particle effects file (.par) 
located in the directory \MVRsimulation\Scenario Editor\Effects, rename it, and open the file 
in a text editor, and edit the system_lifetime parameter to the duration you want. After 
making this edit, add your new effects file to the ClientMap.ini file, which is also located in 
the \Effects directory. For more information about .par file parameters, see the 
MVRsimulation VRSG User’s Guide. 

As mentioned in the chapter “Getting Started,” you can copy and paste effects to duplicate 
them. Bear in mind that the copy/paste action duplicates the effect itself; the start time of the 
duplicated effect will assume the current start time. This way you quickly make a cluster of 
explosions that detonate at slightly different times for a more realistic look. You can manually 
edit the start time of the effect in the Effects table if you want to change it.  

The yellow dome of an inactive effect is a placeholder, not a bounding box; all effects have 
the same size dome placeholder when a scenario is not playing. If you have a cluster of 
effects and you want to see the exact placement of each effect without the labels and without 
the played effects obscuring the scene, you can click the Slow Motion playback button after 
you click the Play button, to slow down the playback speed. Each time you click the button 
the playback speed slows to 80% of current speed.  
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The following example illustrates a cluster of effects with the scenario stopped, with the 
scenario playing at normal speed, and finally with the scenario playing at a very slow speed. 
 

 
 

An automatic hidden appearance is assumed by an entity after the entity to which it is 
attached is destroyed. When the vehicle assumes a destroyed state, the characters become 
hidden automatically. The hidden entities are visible while you are editing the scenario. The 
absence of the entities is visible while the scenario is playing.  

Adding craters 
In Scenario Editor you can create craters, a kind of effect that deforms the terrain. You 
specify the crater’s location, the radius, depth scale, and start time. The crater tool’s hoop 
depicts the radius of the crater and is labeled with its distance (in meters) from the center of 
the crater. 

 

Inactive effects in 
a paused scenario. 

Effects in the scenario playing 
at normal speed. 

Effects appearing 
slowly during a 
very slow scenario 
playback. 

Slow Motion 
button (leftmost 
button). 
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To add a crater to an area in the scene: 

1. Drag the crater tool from the Effects palette to the intended area in the scene. 

2. When the effect appears, refine the center of the crater by zooming in to the center of the 
area, locate the effect’s yellow dome, and move it. 

3. Refine the crater radius by dragging the hoop to enlarge or shrink the crater area. 
 

 
 

  

Crater effect in 
the effects table. 
Change the 
creation time 
and depth scale 
of the crater in 
the table. 
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4. Optionally, in the Effects table, change the depth scale, which is a multiplier VRSG uses 
with the radius to carve out the crater hemisphere shape in the terrain at runtime. 
 

 
 

5. In the Effects table, set the start time at which the crater should form. 

To delete the effect, select the effect and press the Delete key.  

The crater effect changes the actual contour of the terrain as shown below, in textured and 
wireframe modes:  
 

  

 
The crater deformation lasts throughout the rest of the scenario, and does not reset to the 
original filled-in terrain until the end of the scenario has been played. This means if you stop 
the playback before the end of the scenario is reached and then restart the scenario, the crater 
deformation will not be reset. 

As with other effects, a crater can be combined with other effects, such as an explosion. 
Below is an example of combining the crater effect with a debris particle effect.  
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Crater and debris particle effects prior to playback.  Crater and debris particle effects during playback. 

Adding dust trails and other effects to behavior entities 
In Scenario Editor you can augment the appearance of a behavior entity with the kinds of 
effects that you might be familiar with from adding them to VRSG’s ModelMap.ini file.  

VRSG’s ModelMap.ini initialization file contains mapping information that controls which 
model is mapped to the appropriate DIS entity enumeration. It also maps a variety of 
appearance effects for a model that, in this case, extend the appearance options in Scenario 
Editor for contrails, wakes for 2D bodies of water, and specific particle effects for dust, 
exhaust, and tracks. The following VRSG scene shows use of vehicle exhaust and tracks from 
wheel impressions: 
 

 
 

The behaviors table contains a column where you can enter a ModelMap option for an entity. 
Most of these options are for effects. You must type the option syntax in the cell exactly as 

Dust trail and wheel track 
effects set as ModelMap 
options for convoy vehicles. 
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given. (The VRSG ModelMap initialization file is discussed in full in the MVRsimulation 
VRSG User’s Guide.) 

Some effects that require ModelMap.ini entries in Scenario Editor (tracks, exhaust effects, 
and wakes) are not visible during scenario playback in Scenario Editor. They are visible only 
when the scenario is played back in VRSG.  

Note: VRSG ignores the +wake command in simulating 3D oceans but you should use it with 
entities traversing rivers or ponds. And you might want to use it in an ocean-based scenario as 
well, in case your scenario is run in VRSG without 3D Oceans simulation turned on (to 
ensure wakes are displayed on the 2D textured water that VRSG renders when 3D Oceans are 
turned off). Other ModelMap commands for refining vessels on ocean surfaces are described 
later in the chapter. 

The example shown on the next page, taken from the Afghanistan Close Air Support  
scenario that is delivered with VRSG, shows a set of convoy vehicles using the –dustEffect,  
-exhaustEffect, and -tracks ModelMap options. 

To enable a track or wheel impression or a character’s footfall impression to appear behind 
entity while it is in motion, add the command -tracks to the model’s entry in 
ModelMap.ini. 

For most entities, VRSG can automatically determine at runtime the width and offset of the 
tracks by inspecting the assigned model's geometry, and will use a generic grey-colored 
texture for the impression unless you specify a texture to use by adding the command -
trackTexture= in the ModelMap column. Track textures for wheeled and tracked vehicles, 
and human and animal footprints, are delivered with VRSG and located in the 
\MVRsimulation\VRSG\Textures directory. 
 

 

ModelMap options used for 
convoy vehicles and other 
entities. 

This Dust option in the Appearance 
Editor must be selected to activate a 
dust trail ModelMap effect. 
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It can be hard to read multiple ModelMap Options set for an entity in the behavior table. For 
example, you cannot see that the Dust Option set for the selected entity in the ModelMap 
column above. You could widen the column to see all the options. But hovering the cursor 
over the ModelMap cell for the entity also displays all its options, as shown: 
 

 
 

Typically, for a given wheeled vehicle entity, you would simply enter in the ModelMap 
Options column of the behavior table: 
-tracks(0.000000,0.000000) -trackTexture=treadmark_wheeled.tex 

This next example uses the –tracks option to simulate the tread impressions of wheels created 
by a Caravan van. You can see the tread impressions in the scene as the van travels. 
 

 
 

Below is a detail of the tracks entry in the ModelMap Options column for the Caravan entity: 

 

Track effect ModelMap 
options and the resulting 
tread marks of this 
Caravan vehicle. 
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This entry specifies a texture to use for rendering the wheel impressions on the terrain. The 
numeric values in parentheses indicate to VRSG to use default wheel width for this entity. 
Next is the resulting entry for this Caravan entity in the ModelMap.ini file Scenario Editor 
generated for this scenario when it was exported to VRSG: 
 

 
 

If you encounter an issue with the width and offset that VRSG computes for the track or 
wheel impression, you can explicitly specify the outer and inner extent of the right front tire 
with -tracks(innerEdge,outerEdge). You can measure extents of the wheels or tracks 
of the model in MVRsimulation’s Model Viewer by positioning the pointer at the outer edge 
of the right front tire, noting the value and then positioning it at the inner edge of the tire. For 
more information about configuring track impressions, see the MVRsimulation VRSG User’s 
Guide.   

All the Afghanistan and most of the Kismayo scenarios that are delivered with VRSG contain 
track examples, not only from several kinds of vehicle entities, but made from footprints of 
human characters entities as well. You can examine the ModelMap.ini of this scenario, found 
at \MVRsimulation\VRSG\Terrain\Somalia\Kismayo\Scenarios. 

Again, the textures for track/wheel impressions and footprints for these entities are delivered 
with VRSG and are located in \MVRsimulation\VRSG\Textures. 

Refining sea vessel placement on VRSG 3D oceans 
Your scenario can take place on an ocean body and make use of VRSG’s 3D ocean 
simulation, featuring realistic wave motion, multiple Beaufort sea states, vessel surface 
motion, and 3D wakes. In Scenario Editor, you can use over 268 naval and civilian vessels 
from MVRsimulation’s model libraries for littoral or ocean scenarios. 

Settings for the 3D ocean are located on the Oceans panel of the Dashboard. 

Also available in Scenario Editor are Modelmap.ini and cultural feature file (vrsg.clt) 
commands for refining a sea vessel’s behavior on the ocean surface.  

The Kismayo Amphibious scenario that is delivered with VRSG depicts a number of vessels 
both docked and on the sea in the vicinity of the port. The Mischief Reef scenario also 
features the South China Sea surrounding the Reef. Below are scenes from both scenarios. 
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The 3D ocean-related ModelMap.ini commands for behavior entities are: 

-oceanClamp=on/off    Disables ocean-clamping on domain 3 entities, or enables it for non-
domain-3 entities. 

-oceanClampOffsetZ=Z.zz     Offsets the position of an ocean-clamped entity upward by the 
specified amount, in meters. 

-oceanDynamicsScale=S.ss   Scales the responsiveness of an oceanClamped entity's 
dynamics. 

-wakeAmplitudeScale=S.ss.   Scales the amplitude of wakes behind this entity in 3D oceans. 

3D ocean-related options for cultural entities: 

-oceanClamp enables ocean-clamping for static culture, such as a buoy or a docked sea 
vessel.  

-oceanDynamicsScale scales the responsiveness of the dynamics of an oceanClamped static 
sea vessel or other static culture in the sea (such as buoys).  

While simulating 3D oceans, VRSG ignores the +wake command that has long been used to 
simulate wakes on 2D legacy water. The +wake command is still valid for use with entities 
traveling on rivers or pond. And you might want to use it in an ocean-based scenario as well, 
as insurance in case the scenario is run VRSG without 3D oceans simulation turned on. 
+wake -oceanDynamicsScale=0.100000 
 

Summary of ModelMap commands 
The following ModelMap commands can be added to a behavior entity: 

 

Command Description 

-appearance=X Specifies additional appearance bits to be Or’ed with the 
model's provided appearance. 

+contrail  Adds a contrail (EntityType must be domain 2, air). 
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Command Description 

-appearance=X Specifies additional appearance bits to be Or’ed with the 
model's provided appearance. 

-contrailEffect= effect_filename Specifies a contrail effect to associate with an aircraft or 
missile model. 

-darkenRange= Darkens the color of air-to-air targets as a function of range, 
to make them more easily detectable against the sky 
background. The range given specifies the range at which the 
model will become completely black. Up to this range, the 
model is incrementally darkened using a non-linear function 
of range. 

-delayedLoad Directs VRSG to not pre-load the model at startup; only load 
the model if appears in the VRSG session. 

-dustEffect= effect_filename 
x,y,z 

Specifies a dust effect file to associate with a ground-based 
model and its x,y,z offset. 

-exhaustEffect= 
effect_filename 

Generates particle emissions when the entity's power-plant 
appearance bit is turned on. 

-flameEffect= effect_name Assigns a custom effect for a flaming vehicle. 

-groundClamp Ground clamps all instances of this model type. 

-groundPlaneZ=d Specifies the entities ground plane - for example aircraft 
might override the default to take into account landing gear. 

-lightPoint= f, f, f, f, f, f, x, x, f, 
f, 
                   position[0], 
position[1], position[2], 
                   actualSize, 
minPixelSize, maxDist, 
                   color, mask, period, 
timeOn 

Provides a light point on an entity. An entity can have 
multiple light points. 
 

-lod_scale=N Scales a model's LOD switch point ranges by the ratio given 
by N. 

-material=N Provides an explicit material code assignment to all polygons 
in a model; for physics-based IR simulation. 
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Command Description 

-appearance=X Specifies additional appearance bits to be Or’ed with the 
model's provided appearance. 

-nocolldet Makes models of this type invisible to collision detection. 
VRSG will not consider the model when testing collision 
segments against the scene. Useful to apply on bullets, 
tracers, or other types of entities that VRSG should not waste 
cycles determining collisions against. 

-normalMap Enables the use of a model’s normal map textures. Because 
normal maps use a great deal of video memory, you must 
explicitly turn on the use of them, on a per-model basis. 

-oceanClamp=on/off Disables ocean-clamping on domain 3 entities, or enables it 
for non-domain-3 entities 

-oceanClampOffsetZ=Z.zz Offsets the position of an ocean-clamped entity upward by 
the specified amount, in meters. Positive values cause a sea 
vessel to "ride high" as if it were lighter than usual; negative 
values cause it to "ride low" as if it were heavily loaded. 

-oceanDynamicsScale=S.ss Scale the responsiveness of an oceanClamped entity's 
dynamics. Values larger than 1.0 make the entity's dynamics 
more responsive; values smaller than 1.0 dampen the entity's 
dynamic response. Small vessels have larger values than 
large ones. 

-
rotorWashEffect=effect_filena
me 

Specifies a rotor wash effect to apply to a helicopter model. 

-roofClamp Elevation clamps a model to the highest point at a given 
location, which can include culture models. Useful for 
clamping human characters to rooftops. 

-rubble= Specifies an alternate model to use for a destroyed state. 
Useful for buildings as most do not have a destroyed state. 
They can specify a rubble model from the model library. The 
rubble model will be automatically scaled to have similar 
mass as the model it is replacing. 

-scale=N Scales the model by the ratio given by N. For example, a 
value of 2 will double the model's size. 
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Command Description 

-appearance=X Specifies additional appearance bits to be Or’ed with the 
model's provided appearance. 

-scaleFunction=r1,s1, 
 r2,s2 

Defines scale for a model as a function of range; parameter 
r1 is the range where the scale factor s1 is applied. For 
ranges below r1, the scale factor of s1 is used. r2 is the range 
where the scale factor s2 is applied. For ranges beyond r2, 
scale factor is limited to s2. For ranges between r1 and r2, 
the scale factor is linearly interpolated between s1 and s2 (r1 
must be less than r2). 

-setPartValue(partId, value) Sets the initial DOF rate for an articulated part of a model. 

-smokeEffect= effect_filename Assigns a custom effect for a smoking vehicle. 

-terrainModel  Marks a model to be considered for elevation lookup queries. 

-tracks(x,y) Creates a track, wheel, or footfall impression on the ground 
behind a moving entity; x,y are the impression’s inner and 
outer edge respectively. 

wakeAmplitudeScale=S.ss  
 

Scales the amplitude of wakes behind this entity in 3D 
oceans. S value of 2.0 makes waves twice as tall, and 0.75 
makes them 75% as tall. 

-trackTexture=t Used with –tracks, specifies a custom texture to use for a 
track, wheel, or footfall impression.  

-translate= x,y,z Moves a model's origin to a new location. 

-uvw= Assigns explicit thermal properties to a model. 

+wake Adds a wake to a sea vessel model on 2D water surfaces. 
(EntityType must be domain 3, surface, boats) 

For more information about ModelMap options, see the MVRsimulation VRSG User’s Guide. 

Adding damage effects to cultural entities 
Scenario Editor supports DIS damage appearance states in cultural entities. The DIS damage 
states slight, moderate, and destroyed appearances, are handled in Scenario Editor as effects.  

Included in the VRSG culture libraries are over 300 models that have the standard slight, 
moderate, and destroyed damage states. MVRsimulation is standardizing on building damage 
states into its cultural models. To depict destruction in scenarios, you can use these models or 
your own models that have damage appearances tagged with DIS appearance bits.  
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Normal state. Destroyed damage state.  

Examples of use of damaged or destroyed culture can be found in several scenarios that are 
delivered with VRSG. 

The general process for adding culture destruction to a scenario is: 

1. Identify the model(s) you want to destruct or destroy. 

2. Drag the damage effect tool to the terrain and set the affected radius for each damage 
intensity. 

3. Set the start time of the effect (and optionally a viewpoint in the timeline). 

4. Play back the damage effect and optionally refine the affected radius or intensity. 

 
Gradual levels of damage, with slight damage along the periphery and total destruction at the center. 

As mentioned, a subset of models in MVRsimulation’s culture libraries currently have built-
in damage appearances. The models are:  

• Afghan-building-3B-001 to Afghan-building-3B-154 
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• Kismayo-building-0008, Kismayo-building-0088, Kismayo-building-0107, Kismayo-
building-0115, Kismayo-building-0130, Kismayo-building-0445, Kismayo-building-
0466, Kismayo-building-0505, and Kismayo-building-0506  

• All building models with a name prefixed “Hajin-Building-” 

• Defoliated Tree-cassia-001, Tree-cassia-005, Tree-elm-002, Tree-elm-006, Tree-poplar-
004; these tree models also have a different appearance for each of the four seasons  

You can preview all MVRsimulation’s culture models that have damage states at: 
https://www.mvrsimulation.com/3DContent/Damage_State_Culture.shtml 

The tool for applying damage effects to multiple models with built-in damage appearances is 
available on the Effects palette. The damage tool applies three levels of destruction (slight, 
moderate, destroyed) progressively to an area (progressing from destroyed in the center to 
slight destruction at the outer edge of the radius).  

The damage tool displays the levels of destruction as concentric rings. Each ring depicts the 
radius of each level of damage. The red ring indicates the area of totally destroyed state, 
orange indicates moderate damage, and the peach colored ring indicates slight damage. Any 
culture is located inside the ring will be affected by damage (if the model has built-in damage 
appearances). 

 

 
 

 
 

To apply destruction to an area of the scene: 

1. Drag the damage tool from the Effects palette to the intended area of damage in the 
scene.  

2. Refine the radius of damage by dragging the appropriate ring (or each ring) to enlarge or 
shrink the affected area. 

Drag the tool to add progressive 
levels of destruction to one or 
more cultural entities in a given 
radius. 

Set the time at which 
you want the damage 
effect to occur. 

Drag a ring to increase or 
decrease the affected area. 
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3. Set the time at which the damage effect should take place in the Events table. The 
damage effect become visible during playback. 

To delete the effect, select the effect and press the Delete key.  

Each ring is labeled with its distance (in meters) from the center of the effect. To increase or 
decrease the radius of an affected area, drag the ring to adjust it. To make an area have mostly 
one level of damage, drag it to make it the largest area, and drag the other rings to make their 
areas small. 

  

Area marked for damage effect. Resulting damage. Everything within the marked radius is 
damaged. (Note the trees on the right mainly fall within 
the slight damage ring.) 

Like other effects, to move the center of the effect (the damage area), zoom in to the center of 
the area, and locate the effect’s yellow dome and move it. The dome might be inside a 
building, partially located underground, and mixed in with other effects. 

For testing simplicity, consider initially setting the start time for the damage effect to a low 
number of seconds, or even 0, and turn off Play Viewpoint Script, if it is turned on. Play the 
scenario to evaluate the damage effect. 

Damage effects are typically used in conjunction with other effects. Consider this example 
shown earlier: 
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In this example, damage is combined with multiple blasts, smoke, and crater effects to 
simulate a targeted bombing scene. 
 

 
 

When the smoke clears, the damage is revealed. 
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Adding viewpoints to the timeline 
Viewpoints that are added to the timeline become views of the scene that can be displayed for 
a specified period of time during the playback of a scenario. In this way, the scenario can 
switch from viewpoint to viewpoint at designated times, showing the viewer different aspects 
of the scenario activities, much like multiple camera views in a film. Viewpoints that are 
attached to an entity vary the camera angle of the scene. Thus, these time-based, or scripted, 
viewpoints are considered camera views in Scenario Editor.  

Before you add time-based viewpoints to the scenario’s timeline, make sure that the ultimate 
goal of the scenario will actually require such viewpoints. In some cases, such scripted 
viewpoints will interfere with the use of the scenario. For example a DIS based exercise will 
often present each student station with just the first person view, therefore scripted viewpoints 
are not needed.  

Note: The static viewpoints you set in a scenario do not change the view automatically when 
the scenario is played; you place viewpoints on the timeline for them to become dynamic 
time-based views. Static viewpoints will not interfere with a DIS exercise.  

Consider the subset of viewpoints in the timeline of the Al Shabaab Charcoal scenario that is 
delivered with VRSG (installed in \MVRsimulation\VRSG\Terrain\Somalia\ 
Kismayo\Scenarios) shown in the next example. As you watch the scenario, you can see that 
when the current time indicator passes the start point of a viewpoint in the timeline, the scene 
changes to a different viewpoint.  
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To add a static viewpoint, navigate to the location of interest in the 3D scene, position the 
eyepoint to where you want to set the viewpoint, and then press the S key on the keyboard.  

The new viewpoint is added to the scenario’s viewpoints table and given an automatically 
generated name of “Viewpoint n” where “n” reflects the sequential number of the new 
viewpoint. The workspace immediately displays the viewpoints table so you can rename the 
viewpoint to something meaningful right away. 

To add a viewpoint to the timeline: 

1. Click drag the viewpoint from the viewpoints table to the area you clicked in the timeline.  

2. Double-click the timeline to display the Viewpoint Editor. 
 

 
 

3. When the Viewpoint Editor appears, click Add Viewpoint to add a new row. 

4. Set the Start Time. 

  

Info about the 
viewpoint. 

The scenario’s 
viewpoints added 
to the timeline. 

Duration of the scenario 
(editable field). 

Toggle for turning on and 
off playing the scenario’s 
scripted viewpoints. 
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5. Select the viewpoint from the Viewpoint list. 

6. Click OK to save this new viewpoint in the timeline. 
 

 
 

Again, not all static viewpoints in your scenario need to be added to the timeline, only the 
ones you want viewers to see when they play your scenario. (Static viewpoints are handy for 
other purposes, such as to display an area of culture you are working on.)  

Delete a viewpoint segment in the timeline by selecting it and pressing the Delete key on the 
keyboard.   

Once you have added time-based, or scripted, viewpoints to the timeline, click the Play button 
to play the scenario.  

Note: Editing a scenario while scripted viewpoints are playing can be inconvenient since the 
camera (eyepoint) will keep shifting as the viewpoints switch. To disable the scripted 
viewpoints from controlling the current eyepoint of the 3D scene during playback, unselect 
the “Play Viewpoint Script” checkbox above the timeline (in the upper right). 
 

 
 

You can specify many attributes for viewpoints in a scenario, such as FOV, simulated sensor 
modes (and notional sensor effects), UAV camera tracking, attachment modes, and fog 
settings. These settings are the same as their corresponding settings in VRSG. 
 

While you are editing a scenario, unselect the Play 
Viewpoint Script checkbox to prevent the 
viewpoints script from controlling what is 
currently displayed in the 3D scene. 

Click the down-arrow to see a list of all 
the viewpoints in the scenario. Select 
the one you want to add to the timeline. 



Chapter 5    Creating and Editing Scenarios   5−63 

 
 

Click the Sensor Effects column to display the Sensor Effects dialog box (as shown above). 
These settings can optionally be exported with the PDU log of the scenario.  
 

 
 

Some attachment modes have their own specific attributes. For example, the UAV attachment 
mode enables a UAV HUD type to be set, as shown in this next example.  
 

 
 

The HUD options match the HUD options available in VRSG. The actual HUD you choose 
will not display when you play the scenario in Scenario Editor; a generic HUD will display 
instead. But the actual HUD type will be exported in the PDU log within your scenario and 
display properly in VRSG.  

Click in the Sensor Effects 
cell to display the Sensor 
Effects dialog box. These 
sensor effects, which are 
saved with the scenario’s 
PDU log, are the same as 
the effects in VRSG. 

Same attachment 
modes as in 
VRSG. 

UAV attachment 
mode and its 
optional setting for 
HUD type. 
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The Orbit attachment mode has an optional Orbit Rate setting for rotational speed, in radians-
per-second, as shown: 

 
 

Adding environment settings 
Environment settings in the Dashboard mainly pertain to the current Scenario Editor session, 
but you can export the currently set environmental properties like fog color, cloud coverage, 
ocean settings, and so on, with the PDU log of a scenario.  

Note that during VRSG playback, such settings can be overwritten by settings in Battlespace 
Simulations’ MACE, or a CIGI application. 

To save the environment settings with the scenario: 

1. Locate the DIS panel on the Scenario Editor Dashboard. 

2. Click the checkbox “Export Environment Settings with Scenario.” 
 

 
 

  

Orbit attachment 
mode and its 
optional setting for 
rotational speed. 

Select this 
checkbox to have 
the environmental 
settings in the 
Dashboard saved 
in the PDU log of 
the scenario. 
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The exported settings, which will be included within the scenario’s PDU log are from the: 

• Atmosphere panel 

• Oceans panel 

• Sensor panel 

• Shadows panel 

• Time of Day panel 

When you next export the scenario, the settings will be included with the scenario’s PDU log. 

Adding 2D images  
In Scenario Editor you can insert still images into scenarios that display at specified times. 
Such images can be used for annotations, textual instructions, title screens, or photographs, 
and are called overlays. As the name implies, an overlay can be transparent (as in an 
annotation) or opaque, as in a title screen or a photograph. An overlay image can be in .jpg, 
.png, or .tex image format, in any dimensions that make sense for the resolution of the display 
on which the scenario will ultimately be played. 

Images to be used as overlays must be stored in \MVRsimulation\Scenario 
Editor\Textures\Overlays.  
Once an image has been stored in that directory, Scenario Editor will detect it upon the next 
start-up and make it available to select in a scenario. Once you have created a viewpoint with 
the attachment mode set to Overlay and the Overlay field set to the image file you want to 
use, you can play the overlay by scheduling the viewpoint in the viewpoint timeline.  

 

 

 

 
To add 2D images to a scenario: 

1. Put any images (.jpg, .png, or .tex) you want to use in the directory 
\MVRsimulation\Scenario Editor\Textures\Overlays. 

2. Start Scenario Editor and load the scenario to which you want to add the 2D overlay. 

3. Set a new viewpoint, and assign its Overlay attachment mode. 

Images available to use as an overlay, 
which appears in the scenario associated 
with a viewpoint on the timeline. 

The viewpoint’s attachment mode must be 
set to Overlay. 
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4. In the timeline, open the Viewpoint Editor, and add rows for when the viewpoint should 
start and end.  

5. Save your changes and play back the scenario.  
 

 
 

Overlay examples like this one can be found in each scenario delivered with VRSG. The 
scenarios are located in:  

\MVRsimulation\VRSG\Terrain\*\Scenarios  

Saving a scenario 
To save a scenario, choose File > Save. 

This saves all edits you have made in the timeline, as well as all edits to behavior and cultural 
entities, and viewpoints. 

To save the scenario under a different name, choose File > Save As and provide the new 
scenario name. 

Like many other Windows applications, Scenario Editor automatically saves changes during a 
session to a backup file (bkup_ <project-name>); it auto-saves changes once a minute during 
active editing. The backup file is deleted once you save the project and exit from Scenario 
Editor. The backup file becomes useful in the event you experience some sort of system or 
application failure. In such a situation, you can recover most of your recent work by opening 
the bckup_<project-name> project and then save the project under a different name, using 
File > Save As.  

To save a scenario for use in VRSG, use one of the File > Export options as described in the 
next chapter.   

The viewpoint’s 
Overlay 
attachment 
mode. 

The image to associate 
with the viewpoint mode.  

The overlay viewpoint 
in the timeline. 
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Creating a desktop shortcut to launch a specific 
scenario in Scenario Editor 

From a desktop shortcut, you can have Scenario Editor immediately open a scenario or 
project upon startup. 

The syntax for the shortcut is: 
-startPrefs=<filepath>  
 
-projectPrefs=<filepath> 

For example: 
"C:\MVRsimulation\Scenario Editor\Bin\ScenarioEditor.exe"  
-startPrefs="C:\MVRsimulation\VRSG\Terrain\Somalia\Kismayo\Scenarios 
\MyKismayoTutorial\MyKismayoTutorial.vrsgproject” 
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C H A P T E R  6

Playing Scenarios in VRSG 

In a standalone or networked VRSG environment, you can run the scenarios you create with 
Scenario Editor using one of these methods: 

• In VRSG, render the terrain on which you have built up culture content in Scenario
Editor and play the scenario’s PDU log in VRSG.

• Broadcast the scenario’s PDU log using MVRsimulation’s Playback utility. In this case,
only the scripted entities will be sent over DIS. Culture entities will be loaded by VRSG
if the scenario’s cultural feature file (vrsg.clt) is added to VRSG’s search path.

This chapter describes how to export a scenario for playback in VRSG, configure network 
settings for playing a scenario in VRSG a networked setting, and finally, the various ways to 
play a scenario in both single- and multi-channel VRSG environments. 

Exporting a scenario for play back in VRSG 
To play back a scenario in VRSG, you must first export it from Scenario Editor. This action 
exports the PDU log, cultural feature file(s), behavior and model map files, and viewpoints. 
You can optionally save environment settings to be included in the PDU log. 

To export a scenario from Scenario Editor: 

1. Choose File > Export PDU Logs to VRSG.

2. When the Browse Directory dialog appears, specify where you want to export the
scenario to. You must export to a directory called \Scenarios. (The default directory is
\MVRsimulation \Scenario Editor\Scenarios.)

3. Click OK.

Note: If you are exporting your scenario to somewhere other than the default directory, ensure 
the parent directory under which the \Scenarios export directory resides has a 
VRSGTerrainSearchPath.txt file with a pointer to the \Scenarios subdirectory, as described 
later in this section. 

Progress messages appear during the export operation. The process might take a while if the 
scenario contains lot of culture. 

You can also export just a scenario’s cultural feature file (vrsg.clt) and viewpoint file to save 
them in a preferred location outside the project. Doing so can be useful in cases where you are 
using Scenario Editor solely to build up culture on a terrain and do not have any dynamic 
activity (animations, effects or behavior entities).  

See the chapter “Creating and Editing Scenarios” for more information. 
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As described earlier, Scenario Editor stores a project in a .vrsgproject file. This file is stored 
by default in \MVRsimulation\Scenario Editor\Scenarios. Several scenario-related files (for 
the scenario itself, cultural features, behavior activity, and viewpoints) are stored in scenario-
specific subdirectories. 

During the export operation, Scenario Editor packages components needed for making a 
scenario for VRSG playback. Exporting a scenario combines all the PDU logs of the behavior 
entities into one composite vrsg.pdulog. This file can optionally include the environment 
settings from the Dashboard (described below). The export operation also saves the 
viewpoints and the scenario’s vrsg.clt all to one directory from which VRSG can playback the 
scenario.  

The default directory in which Scenario Editor saves an exported scenario is: 
\MVRsimulation\Scenario Editor\Scenarios, though you can save scenarios anywhere, such as 
with the terrain with which the scenario is associated. Scenarios must reside in a subdirectory 
named \Scenarios (VRSG requires this subdirectory). For playing back the scenarios in 
VRSG, you must export your scenarios to either the default directory or another \Scenarios 
directory.  

Exporting environmental settings 
If you want to save environment settings to load in VRSG with the scenario, on the 
Dashboard’s DIS panel select the Export Environment Settings with Scenario checkbox.  
 

 
 

  

Click this 
checkbox to 
export 
environment 
settings with 
the scenario. 
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Exporting shapefiles 
The export operation can optionally output the footprints of buildings and other culture 
entities as shapefiles for use in other applications, such as MVRsimulation’s Terrain Tools or 
Battlespace Simulations’ MACE. (You can also use the exported vrsg.clt in MACE for 
transformation into DIS entities.)  

If you need shapefiles of a scenario, you must enable shapefile export explicitly before you 
export a scenario to VRSG. 

To export shapefiles of a scenario: 

Choose Options > Generate Shapefiles on Export to VRSG. 

For each culture entity in the scenario, Scenario Editor exports a set of shapefiles (.shp, .dbf 
and .shx files) in the standard shapefile format with in geocentric coordinates of the position 
and orientation of each culture entity. The export operation exports the actual terrain 
footprints of the culture entities. 

For each culture model, the following are generated in the shapefile:  

• Wall polygons, the set of closed polygons per building wall.  

• Polylines, a set of open lines.  

• DBF file, which lists the model ID (if there one), model name, and any damage flags. 

About the exported files and settings 
The exported vrsg.pdulog file has the scenario’s ModelMap.ini information encoded within it; 
therefore, the ModelMap.ini.txt that appears after an export operation is merely a backup of 
ModelMap.ini information. Several network settings are also exported; they too are captured 
in the vrsg.pdulog file generated by the Export operation.  

If the option Generate Shapefiles option was selected before the export operation, shapefiles 
will be generated in the scenario target directory. At the parent level will be bounding box 
shapefiles for the overall scenario, and under the \metadata subdirectory will be shapefiles for 
each culture model used in the scenario. 

If the scenario contains any 2D overlay viewpoints, the referenced overlay image file will be 
copied to the export subdirectory \Overlays\.  

Again, for VRSG to locate the scenario, you must export your scenario to a subdirectory 
named \Scenarios. Then, add that \Scenarios directory VRSG’s search path, either on the 
Advanced Startup Parameters dialog box on the VRSG Dashboard or in a 
VRSGTerrainSearchPath.txt file.  

For example, if you had made a scenario built on the 3D terrain of Hajin, Syria, you would: 

1. Export your scenarios to a directory called: \Terrain\Syria\Hajin\Scenarios. 

2. Verify any 2D overlay images were exported to 
\MVRsimulation\VRSG\Textures\Overlays. 

3. Add the path \Terrain\Syria\Hajin\ to VRSG’s search path list on the Startup Parameters 
tab of its Dashboard.  
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You can play the scenario (the PDU log file) from the Scenario tab on the VRSG Dashboard, 
as described later in this chapter.  

About VRSGTerrainSearchPath.txt  
Because directories for 3D terrain and their scenarios can be complex (residing on multiple 
drives, using multiple cultural feature files, microtextures, and so on) you can list a high-level 
directory in VRSG’s Search Paths list, and then directly in that directory provide a list of the 
subdirectories you want Scenario Editor to search in a text file, called 
VRSGTerrainSearchPath.txt. This method of pointing VRSG to one directory and have other 
subdirectories added implicitly to the search path is useful in situations where:  

• The underlying directory structure can change. In such cases, you do not have to keep up 
with such changes within VRSG itself; you simply edit the VRSGTerrainSearchPath.txt 
file.  

• Large sets of terrain need to be loaded by VRSG. You point to a single directory, and that 
directory can use VRSGTerrainSearchPath.txt to expand a complex list of directories and 
subdirectories. 

An example of how VRSGTerrainSearchPath.txt is set up can be found in any of the 
\MVRsimulation\VRSG\Terrain\ subdirectories. For example:  
\MVRsimulation\VRSG\Terrain\Somalia\Kismayo\VRSGTerrainSearchPath.txt. 

This search path text file lists all the \Kismayo subdirectories that VRSG should search to 
render the Kismayo terrain tiles, models and scenarios that are delivered with VRSG.  
 

 
 

In this example, the only directory path that needed to be added to the Search paths list is 
\MVRsimulation\VRSG\Terrain\Somalia\Kismayo\. All subdirectories are listed in the 
VRSGTerrainSearchPath.txt  

The VRSGTerrainSearchPath.txt file can only store relative paths to directories; it cannot 
accept absolute paths. Each line must start with ".\". You can specify parallel subdirectories in 
the directory tree branching from another subdirectory, but be sure to include the initial ".\" 
before adding the backslash ("..\"). For example: 
”.\..\..\..\New Terrain Directory\MDS” 

In the case of shared network drives, you can use the VRSGTerrainSearchPath.txt file to point 
to one directory per network drive. If tiles are stored on multiple shared network drives, you 
could specify the path to each drive, and then add one or more VRSGTerrainSearchPath.txt 
files to each drive.  

  



Chapter 6    Playing Scenarios in VRSG   6−5 

You cannot delete a directory from the search list in Scenario Editor, if the directory is listed 
in a referenced VRSGSearchPath.txt file.  

See the MVRsimulation VRSG Use’s Guide for more information about search paths and the 
VRSGTerrainSearchPath.txt file. 

Playing a scenario in VRSG 
To play a scenario in VRSG, you play back the scenario’s exported vrsg.pdulog file in VRSG 
from Scenarios tab on the VRSG Dashboard. Once you have exported the scenario to VRSG, 
you must add the new exported directory to VRSG’s search path (either in the VRSG 
Dashboard’s Startup Parameters tab or in a VRSGTerrainSearchPath.txt file within a 
specified search path).  

For running the scenario in a VRSG multi-channel environment, in addition to the VRSG host 
machine, each VRSG client will also need the scenario’s vrsg.clt cultural feature file. Copy to 
each client machine, and add to each client’s VRSG search path, the directory of your 
exported scenario.  

Playing back a scenario’s PDU log 
You play back a scenario in VRSG, from the Dashboard’s Scenarios tab. 

Generally speaking, playing a scenario entails playing a scenario’s vrsg.pdulog file in VRSG 
on a set of terrain tiles, either locally or on a network. As described earlier, the vrsg.pdulog 
file contains all the individual PDU logs of the behavior entities in the given scenario. 

Before attempting to play a scenario in VRSG, be sure to add to VRSG’s search path the 
directory in which you exported the scenario, as described in the previous section. Working 
with VRSG search paths is described fully in the MVRsimulation VRSG User’s Guide. For a 
quick example of how VRSGTerrainSearchPath.txt files work for scenarios, see the terrain 
datasets installed with VRSG, such as 
\MVRsimulation\VRSG\Terrain\Somalia\Kismayo\VRSGTerrainSearchPath.txt. In addition 
to the typical entries for the directories of Kismayo terrain tiles, models, and cultural feature 
files, the file contains an entry for the \Scenarios subdirectory. This subdirectory contains the 
scenarios for the Kismayo terrain.   

To play the scenario in VRSG: 

1. Launch VRSG. 

2. On the Startup Parameters tab of the VRSG Dashboard, add to the Folders for Terrain, 
Models, Scenarios, and Other Content list the \Scenarios directory in which you exported 
the scenario. (The example above assumes the scenario is located in 
C:\MVRsimulation\VRSG\Terrain\Kismayo\Scenarios.) This list of directories is 
VRSG’s search path.  
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3. Click the More Options button to display the More Startup Parameters dialog box. 

4. In this dialog box, add the Site, Host, and Entity information.  

  
 

5. Click OK to close the dialog box.  

6. Click Start VRSG. 

7. Locate the scenario on the Scenarios tab of the VRSG Dashboard. (If the scenario is not 
listed, check the search path you specified in step 2.) Click the scenario of interest and 
then click Play. 
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The scenario will begin playing immediately, and will play through repeatedly, looping 
automatically. 

Note: You can have VRSG start playing a scenario immediately upon completion of loading 
terrain, without your having to physically select a scenario from the Scenarios tab. To do so, 
launch VRSG from the command-line and use VRSG’s “-scenario=” command line switch. 
The syntax is:  
Run C:\MVRsimulation\VRSG\Bin\Vrsg7.exe -
scenario="C:\MVRsimulation\VRSG\Terrain\terrain-name\Scenarios\scenario-
name" 

For example:  
C:\MVRsimulation\VRSG\Bin\Vrsg7.exe" -
settings="C:\MVRsimulation\VRSG\Terrain\Somalia\Kismayo\Scenarios\AlShaba
abCharcoal1\-scenario="AlShabaabCharcoal1" –autostart 

In this way, you could a run a pattern-of-life scenario comprised of background traffic and 
people on the street for your DIS exercise immediately upon launching VRSG. 

See the MVRsimulation VRSG User’s Guide for more information about command-line 
options for launching VRSG with some startup parameters that activate automatically. 

Setting up multiple VRSG clients to view the scenario 
To stream the scenario’s vrsg.pdulog to multiple VRSG clients, one VRSG machine must be 
the VRSG host machine running the scenario and controlling the views of the VRSG client 
machines.  

In this setup, you select the Multichannel Master checkbox on the VRSG Dashboard’s Startup 
Parameters tab, and then set up a view of each VRSG client machine as described in the steps 
below. 

1. On the VRSG host machine, click the Client Views tab, and set the Address to be the 
same as the Destination addresses on the VRSG client machines.  
 

Available 
scenarios in 
VRSG’s search 
path. Click the 
one you want to 
play and then 
click Play. 
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2. On the Client Views tab, Click Add View. Enter a View Name for the first VRSG client 
you want to add, and in the View Identification section, set the Site Host and Entity IDs 
of the VRSG client machine for which you are creating this view. Add the orientation, 
location, and FOV for this VRSG client depending on where the monitor is set up so that 
the screens align properly. 

3. Click Apply, when you have finished setting up the first VRSG client view. 

4. Click Add View and fill out the Client View information for each VRSG client. 

5. Click Ping Clients to test the connection between the VRSG host machine and the VRSG 
clients. A message should appear stating how many VRSG clients can be reached 
successfully. If there is a problem, an error message appears, stating that there is no 
response from one or more particular VRSG clients. (In the latter case, check the port, IP 
address, and site host and entity settings.) 

6. Click Start VRSG on the host machine. This action starts loading terrain in the VRSG 
visualization window on all the VRSG machines. 

7. Once the terrain is loaded in VRSG on all machines, start playing the scenario on the 
VRSG host machine. The scenario should appear on all the VRSG client machines.  

For more information about running VRSG in a multichannel environment, see the 
MVRsimulation VRSG User’s Guide. 

Note: A scenario’s PDU log can be individually loaded and broadcast using 
MVRsimulation’s PlayBack utility. This utility is installed in \MVRsimulation\Common\Util 
and is often used to record DIS traffic to a PDU log file and play it back. When you play an 
exported scenario’s vrsg.pdulog file with PlayBack, only the scripted entities will be sent over 
DIS. The exported vrsg.clt file will need to be added to VRSG’s search path. For more 
information about the PlayBack utility see the MVRsimulation VRSG User’s Guide. 



 

 

 

A P P E N D I X  A  

License and Warranty 

MVRsimulation Inc. Software License Agreement 

Version 45665 (10 February 2025) 

DO NOT INSTALL THIS SOFTWARE UNLESS YOU HAVE 
READ, UNDERSTOOD AND AGREE TO THESE TERMS 

MVRsimulation Inc. (“MVR”), a Massachusetts corporation, is supplying a copy of its 
VRSG®, Scenario Editor or Terrain Tools software to You (as that term is defined below) on 
the terms set forth herein and in the Purchase Order (as defined below). This License 
Agreement is entered into as of the date first written above between MVRsimulation and the 
undersigned licensee (“you”), with an address indicated below your signature line. Now, 
therefore, you and MVRsimulation agree as follows: 

Article 1 DEFINITIONS: As used herein: 

“Additional Materials” means software not constituting Software (as defined below), Data 
Files not specified in a Purchase Order or created as part of the License Authentication 
process, and libraries (including Model libraries) not specified in a Purchase Order. 

“Authentication Files” means the files in .C2V, .V2C or .A2C format that are exchanged in 
the course of a License Authentication or the reinstallation of the Software onto another 
computer. 

“Data Files” means data files supplied by MVR under a Purchase Order or as Additional 
Materials or created by you or MVR as part of the License Authentication process. 

“Demonstration Video” includes any visual display involving VRSG, Scenario Editor or 
Terrain Tools or the Data Files that can be viewed by a third party, whether hosted on a 
public server, circulated in a format that permits individual viewing, or demonstrated at your 
facility or that of a third party. 

“Documentation” means documentation published by MVR describing the functions and 
operation of the Software. 

“Dongle ID” means a unique digital identifier of a physical dongle transmitted as part of the 
authentication process described in Section 2.02. 

“Initial Maintenance Term” is a one year term beginning on the date on which you first 
receive a long-term License Authentication or, if different, the maintenance term is specified 
in the Purchase Order. 

“License Authentication” means the authentication described in section 2.02 below. 
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“Licensed Materials” means the Materials and Additional Materials. 

“License ID” means a unique digital identifier of a physical computer installation 
transmitted as part of the authentication process described in Section 2.02. 

“Maintenance Term” means the Initial Maintenance Term as it may be extended from time 
to time pursuant to Section 3.04. 

“Materials” means the Software, related Documentation, and any Data Files, Models or 
libraries supplied by MVR under a Purchase Order. 

“Models” means the three-dimensional representations of vehicles, weapons, characters, and 
cultural features such as buildings, foliage, signage and street elements made available by 
MVR. 

“Proprietary Files” means Models or Data Files provided in any proprietary file format of 
MVR, including without limitation files provided in the .VIR, .MDY, .MDX, .MDS, .HPZ, 
.HPY, .HPX, .TEX, .C2V, .V2C and/or .A2C format. 

“Purchase Order” means the purchase order, quotation or online order form, including the 
Standard Terms, pursuant to which you have agreed to purchase and MVR has agreed to sell 
licenses of Software. 

“Refresh”: A License Authentication may be “Refreshed” if you transfer your Software to 
a new computer or request the right to use additional Software features beyond those in your 
original Purchase Order. This refreshing may take the form of reprogramming of a dongle or 
the exchange of new Authentication Files. 

“Scenario Editor” means MVR’s VRSG Scenario Editor software product. 

“Software” means the MVR software (which may include VRSG) identified in the Purchase 
Order and any upgrades, updates, new releases, versions, corrections or revisions thereto 
which MVR makes or has previously made available to you. 

“Standard Terms” means MVR’s standard terms and conditions available at 
www.mvrsimulation.com/howtobuy/standard_terms_and_conditions.html or, if attached as 
an exhibit to the Purchase Order or this license agreement, in the form so attached. 

“Terrain Tools” means MVR’s Terrain Tools for Esri ArcGIS software product. 

“Updates” means updates, upgrades and new releases and subreleases of VRSG, Scenario 
Editor or Terrain Tools software product. 

“VRSG” means MVR’s Virtual Reality Scene Generator software product. 

“You” means the legal entity or governmental agency on behalf of which the user of this 
copy of VRSG, Scenario Editor or Terrain Tools is acting in installing and using this copy of 
VRSG, Scenario Editor or Terrain Tools. This definition applies even when “you” appears 
with a lower case ‘y’. 

Article 2 LICENSE 

Section 2.01 Grant. MVR grants you a non-exclusive license (i) to install the Licensed 
Materials onto a computer under your control, whether the computer is accessed directly or 
over a private network and when installed over a private network, and (ii) for you or your 
employee (and, if you are an accredited college or university, your students) to use the 
Licensed Materials and Software so installed for your own internal business, operational or 

http://www.mvrsimulation.com/howtobuy/standard_terms_and_conditions.html
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educational purposes, and, if you are acquiring this license in connection with a United 
States government contract identified in the Purchase Order, for the purpose of fulfilling 
your obligations under that contract, provided, however that the Licensed Materials may only 
be run or otherwise used on a computer that has been authenticated, as described in Section 
2.02. 

Section 2.02 Authentication. Authentication of a computer may occur either as a result 
of an exchange of Authentication Files or by your use of a dongle obtained from MVR. If 
your Purchase Order refers to authentication by means of Authentication Files, the exchange 
of Authentication Files will occur when you install the Software on a computer. As part of 
the installation process, the Software will collect and compile unique identity information of 
the physical computer either (i) into a .C2V file, or (ii) into a License ID output to the 
computer’s video display, to be transmitted via email to MVR. Upon receipt of the .C2V file 
or the License ID code, MVR will create and send by reply e-mail either a .V2C or .A2C 
Authentication File which you will be able to use to complete the authentication process. 
MVR’s transmission to you of the Authentication File will trigger the commencement of the 
Initial Maintenance Term for the copy of VRSG, Scenario Editor or Terrain Tools to which 
it is related. 

For users whose authentication is to be done by means of dongle(s), MVR will provide the 
number of dongles stated on the Purchase Order. An individual dongle may not be used by 
more than a single user or on more than a single computer simultaneously. As part of the 
installation process, you will be prompted to send the applicable Dongle ID(s) via email to 
MVR. Upon receipt of these Dongle ID(s), MVR will send by reply email an unlock code for 
each dongle for which a Dongle ID has been received. You will be able to use these unlock 
code(s) to complete the authentication process. MVR’s transmission to you of the unlock 
code for a dongle will trigger the commencement of the Initial Maintenance Term for the 
copy of VRSG, Scenario Editor or Terrain Tools to which it is related. 

Although MVR may provide you with temporary License Authentication (which may 
involve a temporary unlock code for a dongle or a .A2C or .V2C authentication file with a 
temporary duration), MVR shall have no obligation to extend any such temporary License 
Authentication, provide additional temporary License Authentication or provide you with a 
permanent License Authentication unless and until you have paid in full for the Software 
and any other services or materials identified in the Purchase Order. Accordingly, your use 
of the Software may be interrupted until such payment has actually been received and 
processed by MVR. 

Section 2.03 Restrictions. You may not do or permit any other party to do any of the 
following: 

a) Use the Licensed Materials other than as specifically permitted in this Agreement or 
permit any other person to do so; 

b) Make the Licensed Materials available to, persons other than those described in 
clause (ii) of Section 2.01 or more concurrent users than the number of licenses that 
you have purchased; 

c) Make the Licensed Materials available for use on a non-Authenticated computer; 

d) Permit simultaneous use of the Licensed Materials by more users than are authorized 
by the License Authentication, whether over a computer network, or on a virtual or 
emulated computer or otherwise; 
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e) Attempt to (a) alter, merge, modify, adapt, or translate any Licensed Materials 
(excluding only Data Files that are not Proprietary Files), (b) decompile, reverse 
engineer, disassemble, derive, or otherwise reduce the Software to a human- 
perceivable form, or (c) develop any software that would permit an end user to read 
or access any Proprietary Files. The parties understand that, as used herein, the term 
“reverse engineer” shall include, without limitation, any use of benchmarking 
information or incremental output from the Software to determine MVR source code, 
algorithms or data format, or for the purpose of recreating the Software (including 
without limitation any MVR Files) or creating software or files substantially similar 
thereto; 

f) Use any Licensed Materials for the purpose of training, developing or operating any 
form of artificial intelligence, whether artificial narrow intelligence (or “weak AI), 
artificial general intelligence (or “strong” AI), including without limitation using 
Licensed Materials to train large language models, without a specific, separate license 
from MVR authorizing such use; 

g) Bypass the copy protection code or any other technological measure that controls 
access to the Licensed Materials; 

h) Make copies of any of the Licensed Materials other than one copy for back-up or 
archival purposes or use a back-up copy other than as a replacement for the original 
copy. You must include on any back-up copy all copyright and other notices included 
on the Materials or Additional Materials; 

i) Export, re-export or use the Licensed Materials or any copy thereof in violation of 
the export control laws of the United States of America or any other country; 

j) Use any dongle or Authentication File supplied to you by MVR in connection with 
the license of the Software in any manner other than in connection with the use of the 
Materials as permitted hereunder; 

k) Use the Software to test or analyze the performance or user interface of the Software 
in order to develop or improve a product which competes with the Software; 

l) Publish or provide to third parties performance characteristics relating to the 
Licensed Materials without the express written consent of MVR; 

m) Demonstrate the Licensed Materials in public or private forums without using (i) a 
platform that provides the Software sufficient performance capacity to operate at 
peak capacity, and (ii) the most recent versions of any Software and Data Files; 

n) Use or circulate any Demonstration Video without first obtaining the approval of 
MVR, which approval MVR may withhold if it reasonably determines that the 
Demonstration Video will not correctly reflect the peak performance of the Software 
and Data Files; 

o) Publish or provide this document to third parties in electronic or printed form; 

p) Create or distribute derivative works based upon the Licensed Materials (including 
without limitation databases derived from files provided to you by MVR). 

Section 2.04 Updates to License Agreement. If you renew, revive or extend the 
Maintenance Term, Refresh your License Authentication, or request and receive any 
Updates or Additional Materials, you may be prompted to accept the then-current version of 
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this Agreement, which if accepted shall apply to all Licensed Material. You will not be able 
to use Updates or Additional Materials or extend or revive the Maintenance Term without 
accepting the then-current version of this Agreement unless MVR then expressly permits it 
(which it may refuse in its absolute discretion), but any extension of the Maintenance Term 
previously paid for will continue in effect under the existing Agreement until it expires. 

Section 2.05 Ownership and Copyright. Title and copyright to the Licensed Materials 
(including, without limitation, any databases, libraries, images, “applets”, photographs, 
animations, video, audio or music and text incorporated therein and any hardware keys 
provided in connection therewith) and all copies thereof remain with MVR and/or its 
licensors. The Licensed Materials are copyrighted and are protected by United States 
copyright laws and international treaty provisions. You may not remove the copyright and 
other proprietary rights notices from any the Licensed Materials. You agree to prevent any 
unauthorized copying of the Licensed Materials. Except as expressly provided herein, MVR 
does not grant any express or implied right to you in the Licensed Materials or under the 
patents, copyrights, trademarks, or trade secret information of MVR or its licensors. 

Article 3 MAINTENANCE AND SUPPORT 

Section 3.01 Initial Support. Except as you and MVR may otherwise have mutually 
agreed in writing, MVR will provide technical support and maintenance in connection with 
your use of the Materials during the Initial Maintenance Term. If MVR later provides you 
with any subsequent License Authentication (as may arise if the Software is transferred to a 
replacement computer, or MVR provides you with a replacement dongle or any new unlock 
code for a dongle), your subsequent License Authentication shall not restart or extend the 
Maintenance Term. If you have purchased multiple seats of the Software and have therefore 
received multiple License Authentications, the Materials accessed with each License 
Authentication will have a separate Maintenance Term, based on the date on which MVR first 
provides you with a long-term License Authentication for the applicable copy of the 
Software. Upon the expiration or termination of the Maintenance Term, MVR will have no 
obligation to provide maintenance or support for the Materials. MVR may temporarily 
suspend its support in the event of interruptions beyond its reasonable control, such as may 
arise in the event of flood, earthquake, terrorist attack, failure of third party communications 
systems and the like. 

Section 3.02 Nature of Support. All maintenance and support will be provided 
remotely during MVR’s normal business hours. The maintenance and support provided by 
MVR hereunder will consist of: 

(a) responding promptly via e-mail during the Maintenance Term to any questions 
regarding reports of errors or defects in the Software; 

(b) providing assistance via e-mail and telephonically during the Maintenance Term 
relating to the installation and use of the Software; 

(c) if you first received the Materials electronically, permitting you to re-install the 
Materials electronically on the same or a different computer until the end of the 
Maintenance Term or, if longer, until the fifth anniversary of the end of the Initial 
Maintenance Term. However, if you extend the Maintenance Term beyond six years, 
MVR reserves the right to provide you with a later version of the Materials than the 
version that was specified in your Purchase Order; and 

(d) providing access during the Maintenance Term to (1) any “Additional Materials” 
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generally released to MVR’s customers, (2) error corrections (i.e. patches) and 
updates intended to fix reported errors, and (3) all product updates, upgrades and 
enhancements to the Software that MVR generally releases to its customers during 
the Maintenance Term. If you request that MVR perform maintenance or support on 
site at your premises or outside normal business hours, you will be responsible for all 
reasonable expenses incurred by MVR in connection with performance thereof and 
MVR reserves the right to charge its then prevailing rates per hour of service 
provided, or to refuse to provide such service. 

Section 3.03 Exclusions and Limitations. MVR’s maintenance and support obligations 
do not include: custom programming, training, implementation, database changes or support, 
product upgrades for which MVR generally imposes a separate price or fee, any requests for 
content revisions or changes of any kind, or any other matters not specifically covered 
hereunder. In addition, the provision of maintenance or support hereunder is subject to 
commercial availability and technological compatibility and the absence of any actual or 
threatened litigation between you and MVR. MVR provides no guarantee that the Software 
or any upgrades or updates to the Software provided pursuant to this Maintenance 
Agreement will function or perform when used on equipment that does not conform to the 
specifications indicated in the documentation relating thereto. MVR shall have no 
obligation to provide maintenance or support if you use or attempt to use the Software 
with hardware that fails to meet the minimum requirements indicated in the Documentation 
or otherwise modify, revise or transfer the software other than as permitted herein or without 
MVR’s prior written permission. 

Section 3.04 Extension of Maintenance Term. At any time before the expiration of the 
Maintenance Term associated with a particular copy of the Software, you may extend such 
Maintenance Term for successive one (1) year terms, provided, however, that such 
extensions shall no longer be available or applicable if MVR has generally discontinued 
maintenance of the licensed version of the Software (in which case MVR shall refund any 
amounts that you have already paid for extensions that have not yet commenced). For each 
annual extension of the Maintenance Term associated with a copy of the Software, you shall 
pay MVR the applicable maintenance fee set forth in the Purchase Order for extension of the 
Maintenance Term or, if an applicable maintenance fee is not specified, the price then 
generally charged by MVR for the maintenance and support services described herein. All 
payments for extensions purchased hereunder must be received by MVR before the expiration 
of the then current Maintenance Term. 

Section 3.05 Termination of Maintenance Term. Except when the software is 
transferred to U.S. Government Customer, the Maintenance Term will terminate 
automatically in the event that you (a) materially breach any term of this Agreement 
(including without limitation any payment obligation contained herein), or (b) violate or 
infringe any of MVR’s intellectual property in any manner unless such proposed termination 
is governed by the Contract Disputes Act of 1978, in which case MVR may pursue its rights 
in the manner prescribed in that Act and the regulations promulgated thereunder. 

Section 3.06 Effect of Termination or Expiration. The Software and any updates, 
upgrades and enhancements thereto that are installed during the Maintenance Term will 
continue to be accessible after the expiration or termination of the Maintenance Term. 
However, even though you may be able to download and install product updates, upgrades 
and enhancements to the Software after the expiration or termination of the Maintenance 
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Term, these updates, upgrades and enhancements will not function on your computer unless 
and until you have revived and reinstated the Maintenance Term as described below. 

Section 3.07 Revival. In the event that you wish to receive maintenance and support 
after the expiration or termination of the Maintenance Term, you may request that the 
Maintenance Term be revived and reinstated for a new one (1) year term. MVR may, accept 
or refuse such a request in its sole and absolute discretion. Upon notice that MVR has 
agreed to revive the Maintenance Term, you shall pay to MVR a maintenance fee at its then-
applicable rates for (a) the one (1) year term commencing as of the date when MVR receives 
the payment and (b) any gap period (measured in months) between the end of the expired or 
terminated Maintenance Term and the commencement of the newly revived one-year term 
described in clause (a). 

Article 4 SAFEKEEPING OF DONGLES AND AUTHENTICATION FILES 

If you have been provided a dongle or an Authentication File format in connection with your 
license of Software, the safekeeping and preservation of the dongle or Authentication File is 
your responsibility. If you need a replacement dongle or Authentication File, MVR will 
provide one at its then-current rates for such replacement but only if MVR is satisfied that 
there has been no attempt to use it in a manner not permitted under this Agreement. For that 
reason, MVR strongly recommends that you back up your .A2C or .V2C files to a 
separate storage device and retain that backup file for archival purposes. To obtain a 
replacement dongle, you must physically return it (including the casing with identifiable 
labeling and all mechanical and electrical parts) to MVR so that MVR can troubleshoot any 
damage to it.If your Authentication File has become unusable, you will likewise have to return it to MVR 
and certify that you have not kept any copies of it. MVR may in its discretion provide you with a dongle 
or Authentication File that can only be used for a short period of time when it sends you the 
invoice for the replacement. Your ability to receive a permanent License Authentication is 
subject to MVR’s receipt of payment in full of the invoice; per Section 2.02, paragraph 3. If 
you wish to transfer Software to a new computer or change the operating system of your 
existing computer, see Section 7.02 for instructions as to that process. 

Article 5 LIMITED WARRANTIES; DISCLAIMERS; REMEDIES; 
INDEMNITY 

Section 5.01 Limited Warranties. MVR warrants that: 

(a) The Software will perform substantially in accordance with the technical 
functionality set forth in the Documentation during the Maintenance Term; and 

(b) Any physical media on which the Materials are delivered will be free from defects in 
material and workmanship that will prevent you from loading the Software on your 
computer for a period of sixty (60) days from the date of shipment to you. 

These warranties shall be null and void in the case of any defect caused by any of the 
following: (i) modification of the Materials by any party other than MVR; (ii) use of the 
Materials with hardware or software other than that supplied or recommended by MVR; (iii) 
other improper or unauthorized use of the Materials by you; (iv) failures or defects in third 
party software or hardware; or (v) external factors such as, but not limited to, power failures 
or electrical surges. 

Section 5.02 Remedies. If the Software fails to perform substantially in accordance with 
the Documentation, your sole remedy is to initiate a technical support ticket by contacting 
MVR at support@mvrsimulation.com; and MVR’s sole obligation will be to provide 



A−8    MVRsimulation VRSG User’s Guide 

reasonable commercial efforts to resolve the issue to your satisfaction in accordance with 
Section 3.02. Your sole and exclusive remedy with respect to any defective media shall be 
the right to return such media to MVR, and MVR’s sole liability to you shall be the 
replacement of any defective media. 

Section 5.03 DISCLAIMERS. EXCEPT AS SET FORTH ABOVE, THE 
MATERIALS ARE PROVIDED "AS IS" WITHOUT ANY EXPRESS OR IMPLIED 
WARRANTY OF ANY KIND INCLUDING WARRANTIES OF SATISFACTORY 
QUALITY, MERCHANTABILITY, NONINFRINGEMENT OF THIRD-PARTY 
INTELLECTUAL PROPERTY, OR FITNESS FOR ANY PARTICULAR PURPOSE. 
WITHOUT LIMITING THE GENERALITY OF THE FOREGOING, NO WARRANTY IS 
MADE THAT THE ENCLOSED SOFTWARE WILL GENERATE COMPUTER 
PROGRAMS WITH THE CHARACTERISTICS OR SPECIFICATIONS DESIRED BY 
YOU OR THAT THE MATERIALS WILL BE ERROR-FREE. THE WARRANTY 
PROVIDED HEREIN DOES NOT EXTEND TO ANY HARDWARE PURCHASED 
FROM MVR. ANY SUCH WARRANTY MUST BE PROVIDED IN A SEPARATE 
WRITING. THESE DISCLAIMERS OF WARRANTY CONSTITUTE AN ESSENTIAL 
PART OF THIS AGREEMENT. 

Without limiting the foregoing, MVR provides no guarantees that the Software or any 
upgrades or updates to the Software provided as part of the maintenance and support 
described below will function or perform when used on equipment that does not conform to 
the specifications indicated in the Documentation relating thereto. 

Because certain jurisdictions prohibit the waiver of certain warranties, the above disclaimer 
may not apply to you and you may have additional legal rights that vary by jurisdiction. 

Section 5.04 LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT 
PERMITTED BY LAW, IN NO EVENT SHALL MVR OR ANYONE ELSE WHO HAS 
BEEN INVOLVED IN THE CREATION OF THE MATERIALS BE LIABLE FOR ANY 
DAMAGES OR LOSSES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, 
DIRECT OR INDIRECT DAMAGES, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, LOSS 
OF INFORMATION AND/OR LOSS OF DATA), WHETHER ARISING IN TORT, 
CONTRACT OR OTHERWISE, ARISING OUT OF THE USE OF OR INABILITY TO 
USE THE MATERIALS, EVEN IF MVR HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES. IN ANY CASE, MVR’S ENTIRE LIABILITY HEREUNDER 
SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID FOR THE 
MATERIALS. 

Because some jurisdictions prohibit the exclusion or limitation of liability for damages, the 
above limitation may not apply to you and you may have other legal rights that vary by 
jurisdiction. 

Section 5.05 Indemnity. 

(a) MVR shall defend, indemnify, and hold harmless you and your permitted assignees 
(under Article 7), customers (collectively the “Indemnitees”) from and against any 
claims, damages, losses, costs, and expenses, including reasonable attorneys’ fees, 
arising out of any action by a third party that is based upon a claim that any work 
performed or Software provided infringes or otherwise violates the intellectual 
property rights of any person or entity. 



Appendix A   License and Warranty   A−9 

(b) If an Indemnitee’s use of the Software is held to constitute infringement or is 
enjoined, MVR shall at its option and expense (i) procure for Indemnitee the right to 
continue using the Software, or (ii) replace or modify the same with Software that is 
non-infringing and provides equivalent functionality acceptable to the Indemnitee. 

(c) MVR’s obligation to indemnify Indemnitees under this Article shall not apply if the 
alleged infringement is based upon you or any Indemnitee’s unauthorized 
modification of the Software or the use of the Software in combination with other 
Software or devices, where such combination caused the infringement and where 
infringement would not have occurred from your or an Indemnitee’s use of the 
Software alone. 

(d) Commercial Customers. If you are not an agency of the United States government, 
you agree to indemnify MVR and its affiliates against any loss, liability or expense 
(including reasonable legal fees) it incurs arising out of or in connection with any 
breach or violation of the terms of this Agreement by you or your use of the Materials. 

(e) Purchases By U.S. Government. If you are the United States government or an 
agency thereof, then you authorize and consent to all use and manufacture, in 
performing this license, of any invention described in and covered by a United States 
patent, 

(1) Embodied in the structure or composition of any article the delivery of which 
is accepted by the United States government under this contract; or, 

(2) Used in machinery, tools, or methods whose use necessarily results from 
compliance by MVR with (i) specifications or written provisions forming a part of this 
contract or (ii) specific written instructions given by the Contracting Officer directing 
the manner of performance. The entire liability to the Government for infringement of 
a United States patent shall be determined solely by the provisions of the indemnity 
clause, if any, included in this license, and you assume liability for all other 
infringement to the extent of the authorization and consent hereinabove granted. 

Article 6 CONFIDENTIALITY 

You agree that the Materials, the object and source code of the Software, the algorithms 
used by the Software, the performance characteristics of the Software, and the algorithms 
and functioning of any dongles or Authentication Files provided to you in connection 
therewith (collectively, the “Confidential Information”) are or contain the confidential and 
proprietary information and trade secrets of MVR and that MVR is providing the Materials to 
you in confidence. You shall not and you shall not permit others to reverse engineer the 
Software (including by analysis of benchmarking or output information) or to access the 
source code, algorithms or performance characteristics of the Software, the dongles or the 
Authentication Files. In addition, you agree (i) to preserve in strictest confidence all 
Confidential Information, (ii) not to disclose the Confidential Information to any third party 
except as expressly permitted herein, (iii) only to disclose the Confidential Information 
within your business organization to those employees (and, if you are an accredited college or 
university, your students) who have first agreed to be bound by the terms and conditions 
substantially similar to those contained herein, (iv) not to disclose any Confidential 
Information to any agents, contractors or consultants except if such disclosure is related to 
the authorized use of the Materials hereunder and after having received a commitment from 
such agents, contractors or consultants to be bound by substantially similar obligations with 
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respect to such information as you are hereunder, and (v) not to use the Confidential 
Information for any reason except in connection with the authorized use of the Materials. 
You shall be responsible and liable for any unauthorized disclosure, publication or 
dissemination by any of your employees, students, agents or contractors of any Confidential 
Information. Confidential Information shall not include any information which: (a) you 
possess prior to the receipt hereof without obligation of confidentiality; (b) you rightfully 
receive from a third party without any obligation of confidentiality to such third party, and 
which such third party received without any obligation of confidentiality, direct or indirect, 
to MVR; or (c) is or becomes publicly available lawfully and without breach of any 
obligation to MVR by you. You may disclose Confidential Information if such disclosure is 
required under the terms of any statute, regulation, order, subpoena or document discovery 
request, provided that prior written notice of such disclosure is furnished to MVR as soon as 
practicable in order to afford MVR an opportunity to seek a protective order or otherwise 
contest or restrict such required disclosure. The parties agree to cooperate fully to limit 
disclosure in the event of any apparent legal requirement that Confidential Information be 
disclosed. 

Article 7 TRANSFER AND ASSIGNMENT 

Section 7.01 Transfer or Assignment by Licensee. Except as otherwise permitted by 
law or expressly permitted herein, you may not transfer or assign this Agreement or the 
Licensed Materials to another person without the prior written permission of MVR, except: 

(i) if the Purchase Order identifies a U.S. Department of Defense (“DOD”) 
contract in furtherance of which you have ordered the Materials, this license 
may be transferred to any other DOD contractor who needs the Materials in 
furtherance of a DOD contract or to the United States government agency for 
which the contract is being performed, 

(ii) in connection with the sale of all or substantially all of your assets, this license 
may be transferred to the purchaser, and 

(iii) if you are acting as a systems integrator for an end user identified in the 
Purchase Order, this license may be transferred to the end user; 

provided, however, that (x) you are then in compliance with your payment obligations under 
any related Maintenance Agreement then in effect with respect to the Materials, and (y) the 
transferee provides MVR with: 

(A) an unqualified, written acceptance of the terms of this License and any related 
maintenance agreement fifteen (15) days after the transfer (and, for transfers 
pursuant to clause (i), identifying the DOD contract for which the Materials 
are required), and 

(B) the name, address, telephone number and e-mail address of an employee of 
the transferee authorized to communicate with MVR in connection with this 
License and any related maintenance agreement. 

In no case shall any of the Licensed Materials or any related dongle be knowingly or 
intentionally licensed, transferred or assigned to terrorist sponsored organizations or to 
organizations which primarily reside within terrorist countries as defined by the United 
States of America Department of State. 
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Any transfer made pursuant to this Section must include all of the Licensed Materials and any 
related dongle and Authentication Files. You shall be solely responsible for any transfer 
being in compliance with United States export laws and regulations. Upon a transfer in 
compliance with this Section, the transferee shall thereafter be solely responsible for 
compliance with the terms of this license agreement (except for any breach or violation 
which predates the transfer, for which you shall remain responsible) and you will have no 
further obligation to indemnify MVR hereunder except with respect to your use of the 
Licensed Materials prior to the transfer. If you are acting as a systems integrator for an end 
user, you may only use the Licensed Materials to develop, install and support the systems 
for the end user and not for any other purpose. 

Section 7.02 Transfer to Another Computer or Computer Operating System. If you 
wish to transfer the Licensed Materials from one of your computers to another or install a new 
operating system on your existing computer, the process of re-installing the Licensed 
Materials will depend upon your method of authentication. If you have a hardware dongle, 
you may install that dongle in the new computer (or on the existing computer with its new 
operating system) and install (or re-install) the Licensed Materials on it. If you authenticated 
by means of Authentication Files, you may (i) transfer the hard drive containing the Licensed 
Materials from your old computer to your new one, or (ii) reinstall the Software on a new hard 
drive by requesting permission to effectuate such a transfer in an e-mail to MVR, which may 
impose a fee for permitting such a transfer. If MVR permits such a transfer, it will instruct 
you as to how to generate a License ID or .C2V file that will de- install the Licensed Materials 
from the original computer. You must then send a License ID or .C2V cancellation receipt 
that will be generated as part of the de-installation process to MVR by e-mail, and MVR shall 
(upon your payment of any fee required as part of the transfer process) generate a new .A2C 
or .V2C Authentication File for your use in installing the Licensed Materials on the 
replacement computer or on the existing computer with the new operating system. If you do 
not have a backup copy of your Authentication File and are unable to generate a new 
License ID or .C2V file (which may happen if, for example, your original computer has 
become lost, stolen or inoperable) then you may need a replacement Authentication File. 
See Article 4 for terms applicable for obtaining one. 

Section 7.03 Transfer by MVR. MVR may not assign its rights and delegate its duties 
hereunder without your prior consent, which you may not unreasonably withhold, condition 
or delay, except that MVR may freely assign its rights and delegate its duties hereunder to a 
purchase of substantially all of its assets or to a merger partner in a merger in which MVR is 
not the surviving entity. After such an event, MVR shall have no further obligation to you 
hereunder except to provide you, or to cause its successor to provide you, with notice of the 
transaction within 30 days of its occurrence. 

Article 8 SUPPLEMENTAL LICENSE TERMS 

Section 8.01 Additional Materials. In certain cases MVR may from time to time 
provide Additional Materials at no extra charge to customers with whom MVR has an active 
maintenance relationship. The license of the Additional Materials granted herein is limited 
to integration with systems that use the Software and is revocable by MVR without cause in 
its sole and absolute discretion. Upon request by MVR, you must, within five (5) days of 
receiving such request, return to MVR all of your physical copies of the Additional 
Materials, destroy all electronic copies of the Additional Materials in your possession or 
control, and take such additional actions as MVR may reasonably request to ensure that no 
copies of the Additional Materials remain in your possession and control. MVR makes no 
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representation or warranty regarding Additional Materials. You are responsible for 
compliance with any export laws and regulations applicable to any export or deemed export 
of them. 

Section 8.02 Third Party Materials. MVR may include among the Licensed Materials 
software, libraries or databases provided by third parties (“Third Party Materials”). 
Although MVR makes these Third Party Materials available for your convenience, in certain 
cases you will not be able to use or access specific Third Party Materials with, or as part of, 
the Software until you have first accepted specific terms and conditions provided by the 
owner of such Third Party Materials (e.g., by executing a clickwrap or license agreement). 
Your use of any Third Party Materials provided by MVR will be subject to both the terms of 
this Agreement and any terms and conditions provided by the owner of such Third Party 
Materials. 

Section 8.03 U.S. Government Restricted And Limited Rights. The Materials have 
been developed entirely at private expense and have been sold and offered for sale to non-
governmental customers. The Software is "commercial computer software" as defined in 
DFARS 252.227-7014 (Feb. 2012) and in FAR 2.101(a), and "restricted computer software" 
as defined in FAR 27-401 (Oct. 2014) (or any equivalent agency regulation or contract 
clause). The Materials comprising computer software are provided with the rights set forth 
in FAR 52.227-19 (November 2007). The Materials comprising technical data are pre-
existing technical data developed entirely at private expense and, are provided with the 
rights described in DFARS 252.227-7015(b) (Feb. 2014). The foregoing grants of Restricted 
and Limited Rights are only for the benefit of the United States government and its 
contractors and, in their hands, override any inconsistent restrictions set forth elsewhere in 
this License Agreement. The Materials may only be sold or transferred to an agency or 
instrumentality of the United States Government under prime contracts that effectively 
incorporate restrictions on government use, reproduction, or disclosure no less protective of 
MVR than the foregoing and any other attempted sale is null and void. Use, reproduction, or 
disclosure of the Materials by the government or its agents or contractors is subject to the 
restrictions set forth herein and/or therein, as applicable. Contractor and manufacturer are 
MVRsimulation Inc., 57 Union Avenue, Sudbury, MA 01776. Use of the Materials by the 
United States government constitutes acknowledgment of MVR's proprietary rights and of 
the limited data rights granted in them. 

Article 9 TERMINATION 

Upon any material violation of any of the provisions of this Agreement, your right to use the 
Licensed Materials shall automatically terminate without reimbursement and you shall be 
obligated, within thirty (30) days of receiving a notice of termination of this license from 
MVR, to return to MVR all of your copies of the Licensed Materials and any hardware keys 
provided to you in connection therewith, destroy all electronic copies of the Licensed 
Materials and Authentication Files in your possession or control, and take such additional 
actions as MVR may reasonably request to ensure that no copies of the Licensed Materials 
or Authentication Files remain in your possession and control. However, the foregoing shall 
not apply if the matter constitutes a dispute governed by the Contract Disputes Act of 1978, in 
which case MVR may pursue its rights in the manner prescribed in that Act and the 
regulations promulgated thereunder. 

Article 10 GENERAL 
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Section 10.01 Complete Agreement. This Agreement and the Purchase Order constitute 
the entire agreement between you and MVR and supersedes all representations, 
understandings and other agreements between the parties with respect to the subject matter 
described herein or therein. In the event of an express inconsistency between this Agreement 
and the Purchase Order, the inconsistency shall be resolved by giving precedence to the 
inconsistent terms as follows: 

(a) first, to any negotiated rider or addendum to a manually signed version of this 
Agreement (or any proper termination thereof), regardless of whether it is signed 
before or after the electronic acceptance of this Agreement (with such documents 
taking precedence with respect to each other in reverse chronological order of their 
effective dates); 

(b) second, to terms specifically added to the Purchase Order as a result of negotiations 
between the parties; 

(c) third, to the terms of this Agreement; and 

(d) fourth to preprinted or standard terms of the Purchase Order that were not modified or 
included as a result of negotiations between the parties. 

To establish that Purchase Order terms were negotiated, a party must produce e-mail or 
other written correspondence pre-dating the execution of the Purchase Order constituting or 
acknowledging such negotiations. If this agreement is presented in connection with your 
installation of an Update of VRSG, Scenario Editor or Terrain Tools, it shall supersede any 
prior electronic version of the license agreement that You accepted upon an earlier 
installation of this copy of VRSG, Scenario Editor or Terrain Tools or an Update to it but 
shall remain subject to the documents identified in clauses (a) and (b) above. 

Section 10.02 Amendment and Waiver. Failure of a party to enforce any provision of 
this Agreement does not constitute and should not be construed as a waiver of such 
provision or the right to enforce such provision. This Agreement may be amended only by a 
writing executed by both parties or by your electronic acceptance of a more recent version 
of this license agreement provided to you by MVR. 

Section 10.03 Trademarks. Nothing contained herein shall give you the right to use any 
of MVR’s trademarks or trade names and you agree not to remove or alter any trademark, 
trade name, copyright or other proprietary notices, legends, symbols or labels appearing on 
or in any copies of the Materials. 

Section 10.04 Governing Law; Venue. This Agreement is governed by the laws of the 
United States of America and the Commonwealth of Massachusetts, without giving effect to 
conflict of laws provisions thereof. Any action or proceeding brought by either party against 
the other arising out of or related to this Agreement shall be brought only (i) in a 
Massachusetts state court or federal district court for the District of Massachusetts, or, (ii) in 
the case of a proceeding brought by or against the United States government, the Federal 
Court of Claims or any successor thereto, and each of MVR and you hereby consent to the 
personal jurisdiction of such courts. The application of the United Nations Convention on 
Contracts for the International Sale of Goods is expressly excluded. If any provision of this 
Agreement is held to be unenforceable, such provision shall be reformed only to the extent 
necessary to make it enforceable. 

Section 10.05 Customer Suggestions. MVR considers developing product features 
requested by customers at no additional cost. MVR retains all rights to these features and 
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may incorporate them in its commercial off- the-shelf products. For further information 
about MVR’s practices in this regard, go to 
www.mvrsimulation.com/howtobuy/customerfeatures.html. 

Section 10.06 No Corrupt Practices. You warrant that, in the course of obtaining this 
license of the Materials, or of selling any products (the “Purchaser Products”) into which the 
Materials are to be integrated, (a) neither you nor your employees or agents have made, 
offered or promised to make or offer, any payment or any proffer of anything of value, 
including bribes, either directly or indirectly to any public official, regulatory authority or 
anyone else for the purpose of influencing, inducing or rewarding any act, omission or 
decision involving sales of the Materials or the Purchaser Products in order to gain an 
improper advantage, nor have you authorized or encouraged any other party to do so, and 
(b) you shall comply, and shall cause your employees and agents to comply, with all 
applicable anti-corruption and anti-bribery laws and regulations in the course of obtaining 
purchase orders, requisitions or other authorizations to purchase the Materials and the 
Purchaser Products. You shall notify MVR immediately upon becoming aware of any 
breach of your obligations under this Section. 

To initiate a support ticket, please contact MVR at support@mvrsimulation.com. 

MVRsimulation and the MVRsimulation logo and VRSG (Virtual Reality Scene Generator) 
are registered trademarks. "Globaldesic" and the phrase "geospecific simulation with game 
quality graphics" are trademarks of MVRsimulation Inc. 

MVRsimulation’s round-earth VRSG terrain architecture ("Globaldesic") is protected by 
U.S. Patent 7,425,952. 

All other brands and names are property of their respective owners. 

© 1996 - 2025 MVRsimulation Inc. All rights reserved. 

 

http://www.mvrsimulation.com/howtobuy/customerfeatures.html
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